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Preface
Beauty is character and expression. However, there is nothing in
Nature with more character than the human body. By its force or
its grace it evokes the most varied images. At times, it resembles
a flower—the flexion of the torso imitates the stem, the smile the
breasts, the head and the sheen of the hair represent the blooming
of the corolla… And at other times, the human body curved back
is like a spring, a beautiful bow on which Eros adjusts his invisible
arrows. And then there are times when it forms an urn. The human
body, is above all the mirror of the soul and that is where its greatest
beauty comes from.
—Auguste Rodin
This is an invitation to come exploring. If you’re interested in shooting
fine art nudes, whether you have shot some already or not, this book
is for you. However, it’s as much about art photography as it is about
nudes per se. At its heart, the book is about four questions: What
constitutes a fine art nude? How are different artists approaching the
genre? How does a photo work? And what’s involved in translating
artistic vision into a picture?
This is an encouragement to color outside the lines. It’s a demonstration of the vast range of approaches to the nude in fine art
photography. If you have already been shooting nudes and you’re
looking for inspiration, I hope that some of the examples in this book
give you fresh ideas. If you are looking for a conceptual foundation
for your work, and not just a look or a theme to explore, you may be
especially interested in Parts I and IV. I have also included resource
lists at the end of each chapter, which may put you in touch with
other sources of inspiration.
This book is about cross-pollination. We live in a culture that
often overemphasizes specialization. The “Renaissance” man or

woman is a rare breed, and if you look at most books on the topic of
nude photography, they’re narrowly focused. It’s easy to find books
that are only about lighting, or posing, or retouching, for example.
You can find books that focus purely on art theory, and you can find
monographs—the work of a single artist, often about a single project.
What’s harder to find is a book that attempts to integrate the various
ways of thinking about making nudes. Instead of focusing narrowly,
I wanted to trace the overall topography of the world of the fine art
nude in photography.
It’s also easy to stay anchored in the present, looking only at
contemporary work, and only at photography. There are many references to art history here, beyond the history of photography. I also
examine some of the technical aspects of a field that has always
been the product of a marriage between art and technology.
We’re in a culture that is obsessed with surface, and we are
inundated with disposable imagery. This is a call to create photos
that offer more in the second and subsequent viewings. In the United
States, we are also living in a post-Mapplethorpe, post- “wardrobe
malfunction” era, where nudity is “not safe for work” and censorship
has an economic motivation. If your ideas are provocative, chances
are you’ll meet with resistance in showing your work. While I didn’t
want to grant too much importance to that resistance, I also wanted
to acknowledge that it is there, and discuss some of its long history. In the end, it’s about you making the art that you are inspired to
make. I thought it was important to write a book that emphasizes the
choices you can make, rather than telling you what to think.
Thus, you are holding my humbly submitted attempt at an interdisciplinary approach to the field of the fine art nude photograph,
drawing from art, science, and history. I hope that you will find it
interesting, inspiring, and perhaps even liberating.
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Gallery
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above: Rock N Roll Lifestyle. Photo by Richard Rasner (Unique Nudes) of Nakayama Studios.

61
opposite page: Sienna by Louis Benjamin.
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opposite page top: © 2009 Harvey Stein.
opposite page bottom: Reproduced by
Â�permission of Barney Cokeliss.
TOP: La Coupe de Fruits 3. Reproduced by
permission of Pascal Renoux.
BOTTOM: Keonna, Lincoln Beach. Reproduced by
permission of Saddi Khali.
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opposite page: Da Plane. Gary Breckheimer/
www.GaryBreckheimer.com.
TOP: Water Study 5. Reproduced by permission of Steven
Billups.
BOTTOM: Reproduced by permission of Robert Gregory
Griffeth.

9

TOP: Reproduced by permission of
Nina Pak.
BOTTOM: Of Mice and Matadors.
Reproduced by permission of Tobias
Â�Slater-Hunt.
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Reproduced by
permission of Ned & Aya
Rosen.
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TOP: Jordan Swimming. Reproduced by permission
Â�
of Saelon
Renkes, www.saelon.com.
BOTTOM: Reproduced by permission of JD Yezierski.
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TOP LEFT: Reproduced by permission of Terry Donovan.
ABOVE: Male Butterfly. Reproduced by permission of Alfred Laij.
BOTTOM LEFT: Reproduced by permission of Jafar M. Pierre.

13

TOP: Self Portrait. Reproduced by permission of Mayumi
Yoshimaru.
BOTTOM: TV Woman. Reproduced by permission of Gaspar
Marquez.
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TOP: Now as Then 2. © 2009 Pet Silvia.
BOTTOM: My Turn. Reproduced by permission of Steve Cherrier.

15

C H 2 â•… U n d r e s s i n g F i n e A r t

C H A P T E R  T W O    |    U n d r e s s i n g F i n e A r t

Undressing Fine Art:
Approaches to the
Fine Art Nude in
Photography
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“There is nothing worse than a sharp image of a fuzzy
concept.”
—Ansel Adams

T

he proposition seems simple enough: ask someone to
take their clothes off, point a camera at them, and press
the shutter release. That is the essential gesture of making
a nude photograph, but we’re also talking about making fine
art, and that changes things a bit. Making photographic fine
art nudes is often a more sophisticated prospect than it seems
at first blush.

2
OPPOSITE PAGE: Reproduced by permission of Alfred Laij.

Reproduced by permission of Ned
& Aya Rosen.

Fine Art

Let’s first be clear about how the phrase “fine
art” is used in this book. These are works of art
based solely on the vision of the artist and created in a process that is concerned with the discipline of making art. You may have visited the
web sites of photographers who refer to their
fine art work as “personal.” We can distinguish
this from applied arts (commercial work) or
crafts, where the creative vision and the impetus for making the image might come largely
from a client, a market segment, or some utilitarian purpose.

18

Fine art only has to do with the expression of
an idea. The creative process is focused on the
art object itself, art for art’s sake. Even though
creating artwork can be deeply personal, with
the artists essentially making the work for
themselves, the work only becomes part of the
larger dialog of fine art when it is shared or made
public through communities such as the web,
the gallery system, or museums. At the same
time, showing the work is often a by-product of
a fine artist’s process, not the primary objective.
C H 2 â•… U n d r e s s i n g F i n e A r t

There is an inner game to fine art. The
strongest fine art work has to do with much
more than a look, a style, or the surface of the
work. These works often have to do with a
statement that the artist wants to make, or a
question that the artist wants to answer. Even
in the case of artists who are terrible with words
and only work visually, you can sense the clarity
of the ideas that drive their work. Artists often
work on long-term projects, or work inside a
theme, exploring ideas that relate their works
to each other. Working on a long-term project
also gives the artist time to develop and refine
the idea that might start out very vague.
Notice that nothing in our working definiÂ�
tion of fine art has anything to do with whether
the image is pretty, or even whether the image
is “good.” In fact, some observers think that the
current art market is interested in anti-beauty
and unflattering imagery as a reaction to longstanding conventions of aesthetics. Fine art
can be about pure beauty and conventional
aesthetics, but much contemporary work
is about pushing boundaries, subverting

C H A P T E R  T W O    |    N u d e

Reproduced by permission
of Alfred Laij.

norms,Â€ re-examining assumptions, and seeing
things with fresh eyes.
Nude

A fair amount has been written about the
difference between “naked” and “nude.” The
painter Lucien Freud does not refer to his
works as nudes, he refers to them as naked
portraits, and he further breaks from the tradition of portraiture by avoiding the temptation
to portray his sitters in a flattering way. Most
think of nudes as being more about the state of
undress in an abstract or conceptual way that
is also stripped of identity, where nakedness is
simply undressed, but the subject has a clear
identity. As an extreme example, a contorted,
faceless body is a nude, while a candid portrait
of someone skinny-dipping is a naked portrait.
It’s probably less important to decide which
designation applies to your work than it is to
decide which attitude applies. Are you more
interested in form, or in persona?
The word “nude” is a loaded term that can
be used to suggest how the viewer should think

about the work. It can be applied in a pretenÂ�
tiousÂ€way, and it is often used to claim legitimacy
for a work. Some think the phrase “artistic
nudes” represents a very specific and narrow
approach. It quickly becomes clear that these
terms don’t mean the same thing to everyone.
At some level, most images of the nude are
concerned with beauty, perfection, or propriety;
all matters that relate to ideals. Kenneth Clark
wrote in The Nude: A study in Ideal form, “Every
time we criticize a figure, saying that a neck is too
long, hips are too wide or breasts too small, we are
admitting, in quite concrete terms, the existence
of ideal beauty.” He argued that the nude is not
the subject of an artwork, but a form in its own
right—a genre of art—and the unclothed figure
functions in much the same way as the hero in
an epic. When we think of nudes as a genre, we
can identify many subgenres, including portraits,
figurative works, abstracts, narrative tableaux,
19
landscapes, and environmental studies.
Images of the nude convey something more
than what the body looks like, and the state
of nudity has symbolic power. It also carries

TOP: Precarious. Many nudes are concerned with the form of
theÂ€body, exaggerating or idealizing its characteristics. Gary
Â�Breckheimer/www.GaryBreckheimer.com.
BOTTOM: Abstract nudes are often created by moving
Â�
in close
and isolating parts of the body. Photo by Louis Benjamin.

a charge that can be problematic. Much of
that charge arises from the codified shame of
being naked that so many of us learn at an early
age (think Adam and Eve and the Fall From
Grace). Another source of that charge can be
seen in the way that fashion operates: if the
“clothes make the (wo)man,” then stripping her
clothes also strips away a significant part of her
social stature. Viewers often place themselves
in the scene being depicted, and expect that the
artist or the model would be embarrassed or
ashamed to make the image. From there, public
discourse often goes to whether the image
should be displayed, and whether the work is
art or pornography. This friction has been an
ongoing issue with the nude in art.
John Berger, who was writing about
European painting at the time, suggested that
the nude is always conventionalized to the
point of being a form of dress. That holds true
for the nude in contemporary photography,
and so does another of his observations: the
protagonist of these images is the spectator; a
stranger standing in front of the picture, who
is presumed to be male and fully clothed. We
refer to this as the male gaze.
R e a d i n g I m ag e s

20

In our highly visual culture, it’s rare to stop and
think specifically about how we take in photographs, but there is a form of literacy involved.
Think of the times you’ve looked at a photograph and remarked that something about the
image didn’t work: perhaps a hand was cut off
by the edge of the frame in an unpleasant way,
something in the background was distracting,
or some detail was blocked or blown out by
bad exposure. That’s the result of reading the
C H 2 â•… U n d r e s s i n g F i n e A r t
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image. We learn to read photographs—often
in multiple passes, and in a very complex way
that involves both the content and the context
of the image.
In magazines, newspapers, and often even
on television, pictures are generally expected
to have captions. But even in the fine art
world, the words surrounding the picture are
often just as impactful as the colors and tones
within the picture. Consider, for example,
howÂ€ often you’ve looked at a photograph
and been puzzled. You then read the title
or caption, and it either became completely
clear or got even murkier. How you title your
work, or leaving it “Untitled,” can be a very
important strategy in shaping how your image
is read. Painter René Magritte understood
this phenomenon and used it to create a
powerful effect. His titles are an integral part
of his work, and were designed to have the
effect of disorienting the viewer.
TOP: The “implied nude” is a popular
Â�
trope that can Â�either Â�conform to
Â�standards of modesty, or make a
Â�statement about them. Photo by
Louis Benjamin.
BOTTOM: Le Salon Rouge.
Â�Reproduced by permission of Pascal
Renoux.
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TOP: The carrot and the stick are commonly used motivators, but
so isÂ€sex. You probably didn’t need this caption to get that from the
image. Photo by Louis Benjamin.
BOTTOM: By Â�referencing the Abu-Ghraib scandal and the Pietà
Â�
of Michelangelo, this image calls attention to ideals, politics,
Â�
and
shame. Reproduced by permission of JDÂ€Â�Yezierski.

Visual literacy varies just as verbal literacy
does, and developing an awareness of visual
language and culture can give your work a
powerful resonance.
When viewers begin to read a photo for the
first time, they are often concerned with what is
being depicted in the image, what those depicÂ�
tions might symbolize, and whether some part
of the image alludes to something they already
know in their culture. A woman wearing a
pointy green crown with green face and body
makeup is likely to be read as the Statue of
Liberty. ShowingÂ€ Lady Liberty “in the buff ”
might be interesting, but placing her naked next

22
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The effect shown here was created
Â�
with a
projector, rather than digital
Â�
Â�manipulation.
Reproduced by permission of JD
Yezierski.

to something that looks like a bomb would spin
the image in a very different direction, upping its
ante as both a political and an artistic statement.
Viewers aren’t simply concerned with what
an image wants to say; they’re also interested
in what that image conveys about the moment
it was captured or how it was put together. In
our guts, we often sense very quickly whether
an image holds together, and its subtext can
be more powerful than the intended content.
If the artist is confused about what the photo
is about, the viewer will sense that confusion
in the reading. If the model doesn’t trust the
photographer, or is nervous for some reason,
that unease will usually show in an image. For
many photographers beginning to shoot nudes,
the first thing to contend with is giving yourself
permission to make the images you imagine
making. If you’re playing it safe, that will show
up in your work, as well.
With the widespread awareness of comÂ�
puter manipulation in photography, a question

that comes up with increasing frequency is
whether Photoshop was used to manipulate
or comÂ�posite an image together, particularly
when something in the image seems too perÂ�
fect or even slightly implausible. Intentionally
showing or hiding the “seams” in a constructed
image can be an important visual strategy.
Vision

You may have noticed that the discussion so far
has jumped straight from the artist’s concept to
how the viewer takes in the image, even though
the practice of photography is heavily involved
with what’s in between those points—working
with lighting, posing the subject, making the
capture, and producing the final image. This is
because in the most effective bodies of work, the
clarity and integrity of the artist’s vision is what
drives everything else and gives it resonance. 23
That doesn’t mean that the artist works in a linear fashion from cerebral concept to finished
product. The process of many extremely successful and effective artists can be very exploratory

The color Â�relationships
in this photo are as
Â�important as the framing
or the figure. The clouds
add an Â�allegorical quality.
Photo by Louis Benjamin.
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and improvisational, even accidental, where the
artist thinks of herself or himself as a conduit for
the work rather than the producer of the work.
A lot of photographers, if not most, make the
photos they’re compelled to make in the moment.
It’s very common for photographers to say that

they try not to think when they’re composing
a shot. It’s more about the feeling or gestalt of
what’s in the viewfinder. For artists that produce
work that way, the force of vision is applied in
the editing process, which could happen years
after the original exposure is made.

How We Got Here Photographs were not

Â�Stieglitz also championed the acquisition of

always considered an art form, and even as

photography by major art museums, which fur-

recently as the late 1970s, photography was

ther legitimized the medium. Other important

still not fully accepted as a fine art medium.

figures in the history of photography include

That view can be traced all the way back to

Paul Strand, Edward Weston, Man Ray, and

the beginnings of photography, when it was

many of the Surrealists, who all created nudes

referred to as “photogenic drawing.” The idea

as important parts of their bodies of work.

was that “nature herself” reached into the
camera and drew the scene. It was a view that
invalidated the photographer, and it would be
some time before the argument was advanced
that the photographer’s choices of where to
place the camera and when to trip the shutter
were important expressions of artistic intent.

Art is often about turning convention on its ear.
Such was the case when 21-year-old Irving Penn
shot the image known as Nude No 1, 1947. Penn
was already successful as a fashion photographer for Vogue, and for the body of work that
ensued two years later, he instinctively rejected
the facilities of Condé Nast and the skinny ide-

As photography gained acceptance as a fine

alized bodies of fashion models to create a

art medium, many of the works that helped

series of images in collaboration with fleshy art

it to gain legitimacy were nudes, perhaps

models who bore physical resemblance to the

because the form alludes to fine art paint-

Venus of Willendorf—a fertility icon thought to

ings and Greco-Roman statuary. During that

have been carved somewhere between 24,000

period, galleries dedicated to photography

and 22,000 BC. The images were not embraced

flourished because few photographers could

by everyone, but the process of making those

get their work shown in fine art galleries.

images energized and transformed his image

One of the artists who worked tirelessly to
legitimize fine art photography was Imogen

making and broadened the definition of the
modern photographic nude.

Cunningham, who was still working hard at

The case of Penn highlights another fac-

91Â€ years old in 1975. Some of her most cele-

tor in the legitimization of art photography:

brated images are nudes. Alfred Stieglitz was

an uncanny alliance between fashion editors

another standard-bearer for photographic

and artist photographers. Even though fash-

art. His nude photographs of his wife Geor-

ion photography is about selling clothes, the

gia O’Keefe, famous as an artist in her own

creation of fashion imagery is one of the few

right, are part of the canon of art photography.

(Continued)
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TOP: The figure in the foreground
Â�alludes to the painting in the
Â�background, which is reminiscent of the
work of Francis Bacon. Reproduced
by permission of Daniel Sikorskyi—Â�
chiaroscurist, www.sikorskyi.ca.
BOTTOM: A photograph that alludes to
the work ofÂ€Gustav Klimt. Photo by Louis
Benjamin.
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arenas of commercial art where editors have

him, and that depicted his women protago-

often turned over complete creative control

nists as powerful and independent. Bourdin is

to artists such as Penn, Stieglitz, and diCorcia.

noteworthy because his highly creative, visu-

That alliance is still strong today, and art col-

ally sophisticated images have had a strong

lectors and dealers are increasingly looking at

and lasting influence on the look of fashion

fashion photography as a legitimate art form.

and art photography right up to the present.

Two other photographers particularly notewor-

The implicit promotion of the artistic merit

thy for their use of the nude in fashion imagery

of the work of these photographers, and the

are Helmut Newton and Guy Bourdin. After his

work of other fashion photographers dating

first heart attack, Newton refused to take com-

all the way back to the 1920s, sent a strong

missions from clients who would not grant him

message to the public about the validity of

creative control. Newton’s genius was in chan-

photography as an artistic medium. Today,

neling the sensibilities of German aesthetics

museums and galleries present fashion imag-

and erotic fetishism into a kind of chic that was

ery as works of art, and the nude remains a

the antithesis of fashion photography before

staple of fashion imagery.

Inspired by Penn’s “Earthly Bodies” exhibition
Â�
at the Metropolitan
Museum of Art, New York. Photo by Louis Benjamin.

M o M A a n d S z a r kow s k i

The Museum of Modern Art in New York, also
known as MoMA, was an important front in
the ascendance of photography as a fine art
medium. Edward Steichen headed its photography department from 1947 to 1962 and
curated the exhibit “The Family of Man” in
1955. It was one of the most widely seen photographic exhibits ever, and a watershed for art
photography.
Steichen chose John Szarkowski to be his
successor. Under Mr. Szarkowski’s leadership 27
from 1962 to 1991, MoMA staked out the
territory of art photography in the early 1960s.
This was a time when other museums were just
coming to grips with whether or not to show

TOP and BOTTOM: Photos by Louis Benjamin.

photography at all, few galleries were showing
photography, and few collectors were buying it;
art photography was a new frontier.
While no one can lay claim to having singlehandedly defined the entire canon of photogÂ�
raphy, we know of artists such as Ansel Adams,
Diane Arbus, Eugene Atget, Walker Evans,
Garry Winogrand, and Cindy Sherman (to name
a few) largely through the efforts and influence
of John Szarkowski. Helping to bring the exemÂ�
plary works of those artists to public attention is
a major contribution to the art of photography,
but Szarkowski’s contributions in the area of
criticism have equal if not greater weight.
In 1966, he published The Photographer’s
Eye, wherein he set forth a framework of five
dimensions for looking at the artistic qualities
of a photograph in terms of characteristics and
problems that are specific to photography. In
the introduction to the book he wrote that
he hoped his framework “may contribute to
the formulation of a vocabulary and a critical
perspective more fully responsive to the unique
phenomena of photography.” Szarkowski
understood that being able to articulate what
works or doesn’t work about an image, beyond
whether or not you like it, is an important part
of developing an artistic vision. His five dimenÂ�
sions are the frame, the thing itself, vantage
point, the detail, and time. These dimensions
will be discussed in more detail shortly.
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To his credit, Szarkowski didn’t claim even
then that the five issues he outlined in The
Photographer’s Eye were the medium’s only issues.
Art and photography have continued to change
and expand since he held sway. Conceptualism
and performance, in particular, have become
much more important aspects of contemporary
photography than they were in his time, and
while they are not unique to photography, they
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are useful ways of thinking about the artistry of
a photo. You could argue that they fit within the
dimension of vantage point, but you could also
argue for them being something distinct from
that. Still, his critical approach to art photograÂ�
phy is well suited to exploring pertinent dimenÂ�
sions of the fine art nude.
Lo c at i n g N u d e s i n
S z a r kow s k i ’ s D i m e n s i o n s
The Frame

Szarkowski described framing as “the central act
of photography, the act of choosing and eliminating, [which] forces a concentration on the
picture edge—the line that separates in from
out—and on the shapes that are created by it.”
While framing is the way the photographer
positions the viewfinder around the scene just
before he or she trips the shutter, cropping is
re-interpreting what was shot by cutting down
the area that will be printed, after the fact.

Whether by cropping or framing in-camera,
the important details of a picture are defined
by means of the resulting frame. The body
can be enclosed in the frame, constrained or
truncated by it, or included in an expanse of
what graphic designers call negative space.
A small figure near the bottom of the frame
seems grounded. Placing the figure dead
center in the frame can create a kind of
ambiguity. Placing it near the top tends to
give the impression of floating upward, or of
an impending plunge.
Another graphic design concept is visual
tension or imbalance, which is created by
moving elements away from the center of the
frame. AÂ€ three-quarter portrait nude with
the same pose and expression will have very
different visual qualities depending on whether
The hands Â�bursting out of the frame dramatize the space. The
clipped fingers Â�emphasize the edge of the frame and the difference
Â�
between inside and out. Reproduced by permission of Saddi
Khali.

29

TOP: Shot with a Â�Hasselbad
XPan, the Â�cinematic 2.7:1
aspect ratio of this
panoramic image comes
from a 24mm x 65mm film
frame, nearly double the
width of a standard 35mm
frame. Reproduced by
Â�permission of Barney
Â�Cokeliss.
BOTTOM: Geisha III, from
the Iconival series. Shot with
a Rollei, Brighton studio
UK 2007. Kendo Â�equipment,
square framing, and elegant
light Â�create a striking portrait.
Reproduced by Â�permission
of Tobias Slater-Hunt.
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Cropped to 1:1 from the in-camera aspect
ratio of 2:3, the framing is an important
compositional foundation for this shot.
Photo by Louis Benjamin.

it is shot with the bridge of the nose on the
center line, with the right eye (camera left) on
the center line, or with the shoulder touching
the center.
The proportions (aspect ratio) of the frame
also matter. The aspect ratio of the 35mm
frame is 2:3, and that’s also what most 35mmformat DSLRs conform to. That aspect ratio is
thought to mimic the field of view of normal
human vision most closely. The square format
poses very specific compositional challenges,
while 4 × 5 is considered large format. Point
and shoot cameras often use a 4:3 frame
that matches the shape of conventional TV.
Panoramic cameras create images in a range of
proportions that are short and wide and have
a cinematic feeling. HD movies are typically
cut in 16:9, and 70mm theatrical films like
“Alien” are in 2.20:1. Still other theatrical films
are in 2.35:1. Each of these formats creates a

distinctive compositional space and can have a
subtle, yet important, impact upon the way an
image is read.
T h e T h i n g I t s e lf

In a famous series of paintings called “The
Treachery of Images,” the Surrealist René
Magritte inscribed “Ceci n’est pas une pipe” (This
is not a pipe) on the canvas beneath an illustration of a pipe, emphasizing that the illustration
is not the thing itself. Szarkowski asserted that
even though the viewer often fails to distinguish
between the picture and the thing(s) depicted,
the photographer has to be clear about this distinction and to think in terms of the photo.
The camera doesn’t see the way we do, enlarg- 31
ing the distinction between the way we see the
thing itself and the way its representation appears.
Artists often make use of the transformation
inherent in the photographic process. Simply

TOP: A depiction of a person imitating Â�representations of people.
© 2009 Â�Harvey Stein.
BOTTOM: Â�Vantage point, framing, and Â�high-key lighting combine
to Â�create a striking Â�image that borders on the abstract. Â�Reproduced
byÂ€permission of John Evans, JohnEvansPhotography.co.uk.
Â�
Â�

byÂ€being attuned to the physicality of the subject
and the play of light, the naked body can be
rendered in many ways through photography.
The same body in the same pose can produce
results that range from a documentary style
portrait to melodrama, to abstraction; and all
of these outcomes are the product of artistic
choices that the photographer makes.
32

Vantage Point

Alberto Korda’s famous 1960 portrait of Che
Guevara demonstrates how powerful the low
“heroic angle” can be in elevating the perception of the person portrayed. That shot is so
C H 2 â•… U n d r e s s i n g F i n e A r t

C H A P T E R  T W O    |    T h e T h i n g I t s e l f
TOP and BOTTOM: Focusing on small details can elevate their Â�
significance and transform the mundane. Photos by Louis
Â�Benjamin.

iconic that a great number of images imitate it.
The web is full of amateur cell phone nudes shot
“Hail Mary” style, with the camera positioned at
arm’s length, above the head, and tilted downward. Pornography has turned the “upskirt” into
a pop cliché. Each of these approaches emphasizes seeing the subject from a point of view
that we wouldn’t normally see unless we were
extraordinarily tall or short at the very least.
Szarkowski suggested that there is also a
more expansive interpretation of vantage point:
it can be seen as a particular attitude toward the
subject. For example, the body can be depicted
as an inert object, a symbol of sex, or even a non
sequitur. It can be photographed in a way that
suggests perfection, or emphasizes deficiency.
Pictures can be about nudity itself, about moralÂ�
ity, or simply a description of what someone
looksÂ€like.The artistic nude can be about embracÂ�
ing ideals of beauty or subverting them.
Nudity in a work of art carries a certain
symbolic power, and one possible vantage point
of the photographer making nudes can be that
of exploring the very nature of such power. By
formulating, articulating, and adopting a particular vantage point, the artistic photographer can
build a cohesive and effective body of work.
The Detail

In isolating fragments of the thing itself (by
means of placing the frame), a photographer
can elevate what seems trivial, imbuing it with
symbolic meaning. John Coplans made nude
self-portraits that famously isolated portions of
his aging body in surprising ways.
Time

Just as the edge of the camera frame slices
through space, the opening and closing of the
shutter slices through time. Photos are never
really instantaneous, even if they look that way.
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TOP: The Muybridge photos inspired Marcel Duchamp to paint
Nude Descending a Staircase, which Â�scandalized the 1913 Armory
Show in New York. This composite image was Â�inspired by the
Â�Duchamp painting, and used Edgerton’s contribution,
Â�
strobe
Â�lighting, to freeze motion. Photo by Louis Benjamin.
BOTTOM: Using available light and “dragging the shutter”
Â�
at
1.3Â€seconds causes the moving figure to blur, producing the ghostly
look that Francesca Woodman used so effectively. The camera was
mounted on a tripod. Photo by Louis Benjamin.

They can be made to emphasize the passage
of time as an impressionistic smear of motion
blur, or to isolate momentary events that we
can only appreciate because they were recorded
in less time than an eye blink.
In 1878, Eadweard Muybridge helped
railroad baron Leland Stanford (the university
gets its name from him) to settle a bet by
photographing a horse at full gallop. He
produced a succession of frames that froze
the action and showed without a doubt that a
horse actually lifts all four feet off the ground
simultaneously when it gallops.
The Muybridge images are often referred to
as being stroboscopic, but they are not. They
are available-light photos. It wasn’t until the
early 1930s—about 50 years later—that Harold
“Doc” Edgerton developed the electronic flash.
For his famous sequences, Muybridge rigged
an array of 12 stereoscopic cameras with an
elaborate trip-wire trigger system to capture
the frames at 1/1000 second.
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Using this technique, Muybridge went
on to document locomotion in animals and
humans extensively, producing a number of
sequences that feature male or female nudes.
The Muybridge photos catered to gender roles
of the time. His nude men were photographed
performing feats of strength, such as striking
a blow or wrestling. His nude women were
photographed doing things like descending
a staircase, turning around in surprise and
running away, receiving a bouquet from a child,
or pouring a bucket of water onto another
woman.
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From “Waterscape Nude Series.” In this photo, the dragged shutter
gives Â�flowing water an ethereal quality. The Â�perfectly still model is
rendered with sharp clarity. Reproduced by permission of Scott
Foltz.

In the late 1970s Francesca Woodman made
groundbreaking images, using her own body as
subject matter. In some of those images, she
would move parts of her body during long
exposures to produce nude self-portraits that
suggested blending into her surroundings or
evanescence.

The time frame is an essential component
of the classic Cartier-Bresson photograph.
Szarkowski noted that his idea of the decisive
moment has been misinterpreted. It’s all about
the photographer’s awareness and exploitation
of time in the context of composition and the
visual frame. The photographer waits to trip
the shutter at the moment when patterns and
lines emerge from the flux of movement and
coalesce within the frame to produce a visual
crescendo.
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The Body Itself:
A Survey of Modes

37

O

ne way to think about nudes is in terms of modes of
portrayal, or how the body is shown. Two additional
aspects to consider are how much of it is shown and
how clearly it is revealed. In the previous chapter, we looked at
how the photographic fine art nude can be thought of as its
own genre. This chapter will briefly outline some of the more
recognizable modes of portraying the fine art nude. We can
think of the various modes as subgenres of the nude. Just as
genres can be combined (e.g., docudrama), modes can be
combined.

As you explore nude photography, you will probably encounter
many images that don’t clearly fit any particular mode, and it is doubtful that a comprehensive listing of modes can ever be compiled. However, thinking in terms of modes can still be an informative way of
surveying the wide range of approaches.

3
OPPOSITE PAGE: Photo by Louis Benjamin.

TOP: Reproduced by permission
of Ned & Aya Rosen.
BOTTOM: Photo by Louis Benjamin.

Naked Portraits

The painter Lucien Freud refers to his works
as naked portraits and avoids the word “nude.”
His work resists some of the norms of the art
world, and Freud isn’t interested in making flattering portraits. Neither was Avedon. It is possible to portray naked people in ways that are
more about the person inhabiting the skin and
less about conforming to a stylistic norm such
as boudoir, cheesecake, or some other idealized
representation.

38

It is worth noting here that people really
do have at least one “good side,” or perhaps it’s
more accurate to say that people look better
from some angles than others. The Â�distinctions
can be amplified by your choice of lens and
lighting. It’s a good idea to be aware of that,
and maybe even do a few test shots to evaluate
first. Once you’ve found those stronger points
of view, use them, unless you’re out to do something subversive, in which case you might only
shoot the “bad” angles. Word to the wise: your
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TOP: Packing material makes an interesting alternative draping
material. Photo by Louis Benjamin.
BOTTOM: Self-portrait. Reproduced by permission of Mayumi
Yoshimaru.

sitter might object if they don’t understand
that you’re turning convention on its ear.
Self-portraits

A number of artists have found that putting
themselves in front of the lens, rather than
working with a model, is a more effective way to
get access to the ideas they are trying to express.
There are technical challenges to shooting selfportraits, but for these artists, the benefits are
worth the trouble.
If you read critiques of photography, you’re
likely to come across the notion that the photograph itself, and certainly any given photographer’s body of work, acts as a kind of self-portrait.
That makes a certain amount of sense, since the
work is defined by the unique vision of the photographer. The stronger the artist’s voice in their
work, the more this holds true.
The Body in Motion

Body movement in contemporary nude photography borrows heavily from dance. The
challenge is to find other kinds of activities to
source our ideas from. Moving the body emphasizes the dimension of time, and the reaction
of photography toward time is either to arrest
movement or to render the body as evanescent,
emphasizing how fleeting a moment can be and
how temporal we are.
Aaron Siskind’s 1956 series entitled
Pleasures and Terrors of Levitation shows
Â�swimming-trunk-clad divers isolated against a
blown-out white sky, freezing them in mid fall.
Because there is no indication of up or down, 39
the divers seem oddly suspended in time and
space, limbs projecting in different directions.
There is no blur. Siskind not only suspended
time, he also disavowed gravity, and in doing

TOP: © 2009 Harvey Stein.
BOTTOM: An “implied” nude. Steven Billups, photographer.

so, emphasized the movements and the form of
the body as it falls through space.
Covering the Body and
the “Implied” Nude

In some circles, covered-up nudes are referred to
as “implied” nudes. This relatively safe approach
to making nudes can be beautiful, but it is also
rife with cliché, and runs the risk of being read
as timidity on the part of the photographer,
the model, or both. The body can be draped in
cloth, lit in a way that throws shadows over it, or
posed in a way that obscures the genitals. They
can also be covered with a prop, referred to as
a cache-sexe. The hands can be used to cover the
breasts—a gesture that some call a “hand bra.”
In each of those approaches, the suggestion of
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nakedness beneath or behind the covering can
be veryÂ€strong.
A variation of this approach is photographs
where the sitter is actually wearing clothes of
some sort, but the use of a prop or angle and
framing obscures the view such that we see only
skin and imagine the sitter is naked. Sometimes,
models who want “nudes” in their portfolio, but
don’t want to be seen as too brazen, will insist
on shooting only implied nudes.
The phrase “tasteful nudes” is also commonly
used on networking web sites frequented by
models and photographers. In many ways this
term is a bit ambiguous, since tastes vary widely,
but clearly a tasteful nude is generally not very
sexual, aggressive, or confrontational in style.
In some of those same communities, people
use the phrase “artistic nude” in a way that suggests that they believe that artistic nudes are
always devoid of eroticism. However, anyone
familiar with the work of Nobuyoshi Araki
will be aware that his nudes are considered fine
art and that they are highly eroticized; clearly,
Â�artistic nudes are not constrained to being
chaste and formal images.
Araki coined his name as an allusion to
anarchy, and he openly acknowledges that he
intended to objectify women in his early work.
He was the first to show pubic hair in Japan,
challenging the laws and creating a bad-boy buzz
for himself. Araki’s work doesn’t go down easily,
and some consider it pornographic. There are
big differences aesthetically between an Araki
photograph and porn, but that doesn’t make his
work any less shocking. His work catalogs his
obsession with women, and especially their vulvas, but it also shows a fascination with and love 41
for life in Tokyo. His photographs of flowers are
very different from Mapplethorpe’s work, and
demonstrate how much the artist’s vision can
transform the presentation of a subject.

TOP and BOTTOM: Photos by Louis Benjamin.

Helmut Newton’s aesthetics were very different from those of Araki, but his fine art work
is certainly erotic, as well. His family referred to
him as “Dirty Helmy,” and in interviews his wife
June has said that he sometimes went too far
with his ideas. His pursuit of ideas near the edges
of acceptability, coupled with his obvious love of
women and the female form, produced work that
still has strength decades after it was produced.
Full-body

Shooting full-body has its specific challenges. It
places certain constraints on lighting, and often
requires the photographer to move back from
the subject. In terms of the language of images,
it also has a particular impact, putting emotional
distance between the viewer and the subject, and
it tends to make the image as much about the
space around the figure as it is about the subject.
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TOP: Shadows and framing emphasize the abstract Â�qualities of this
torso. Photo by Louis Benjamin.
BOTTOM: Photo by Louis Benjamin.

Intimacy

As you move in closer and the subject fills more
of the frame, the viewer often experiences a
stronger sense of intimacy with the subject.
Directing the subject’s gaze into the lens can
intensify this effect, which is usually read as
an acknowledgment of the viewer’s presence.
AtÂ€ the same time, it is quite possible to create a sense of intimacy without even showing
theÂ€face.
Slightly parting the lips is also read as a kind of
openness. Eye contact and glossy lips are played
out in the extreme in cheesecake photography,
where the model often appears to be seducing
the viewer with a “come hither” expression.
At the other end of the spectrum are fashion
nudes, where the model typically breaks eye contact and doesn’t acknowledge the viewer, often
seeming to look above, beyond, or through the
camera. John Berger observed that the effect of
the detached gaze is to trigger a kind of envy
in the viewer that in turn makes them want
whatever fashion is being depicted. Romantic
Â�longing with a touch of envy is a central theme
in the work of Bruce Weber, who routinely uses
nudes and pushes boundaries in his fashion photography. Advertising, especially in America, is
increasingly concerned with selling lifestyles and
attitudes, rather than product benefits. When
very few clothes or no clothes at all are depicted,
the message that comes across can be sharply
focused on attitude or lifestyle.
Abstract

Moving in close to isolate parts of the body also
tends to create a sense of abstraction. When the
face is not visible, the contents of the frame tend
to have more to do with lines, shapes, forms, or
textures, rather than breasts, buttocks, or genitals. Additional degrees of abstraction can come
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OPPOSITE PAGE: Reproduced by permission of Steve Cherrier.
TOP: © 2009 Harvey Stein.
BOTTOM: Reproduced by Â�permission of Terry Donovan.

from throwing the figure out of focus and using
high-contrast lighting.
Often, the abstraction results at least in
part from making the body less identifiable as
a body and relating it to something else, but
this is not always the case. Henry Horenstein’s
series, Humans, features isolated parts of models’ bodies that are clearly recognizable for what
they are, yet they are presented in a way that
transcends simple recognition. An image of an
eye becomes a meditation on form—it is rare
that we get that close and simply stop and stare.
A photograph gives us permission to stare and
to see something anew.
Sculptural

Sculptural nudes derive many of their qualities
from lighting, the physicality of the poses, and
the point of view of the camera. They can be
abstract, but that abstraction is more the result
of factors like foreshortening and shadow than
the result of the imposition of the frame.
Some of the earliest works of Kishin Shinoyama were concerned with the body as pure
form, where he posed curled naked bodies on
boulders to emphasize the similarities. Austrian Andreas Bitesnich has taken a very different approach to the figure, but his works also
trade on the sculptural qualities of the body.
Body vs. Nature

Shinoyama’s boulder nudes also suggest another
mode of the nude in fine art photography, which
is comparing the human form to nature or to
human-made things. Photos can suggest how
humans are an extension of nature, or contrary
to it. The body can blend in, or it can be made to
stand out starkly. Placing bodies against architectural elements often exhibits how the entire
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TOP: Reproduced by permission of Terry Slater.
BOTTOM: Reproduced by permission of Terry Donovan.

scale and proportion of architecture is based on
the human form.
Skin

Liquid latex, mud, flowers, honey, and other
substances with strong textures or colors of
their own can be applied to the skin. In most
cases they tend to call attention to the form of
the body by altering the appearance of its surface. Body paint can do that as well, particularly
if it is a single color (think of the Jill Masterson
character in “Goldfinger”), but it can also act as
a kind of camouflage that dominates the picture
and renders the body unrecognizable in ways
that most clothing cannot. A potential pitfall
of working with some styles of body painting
is that the photograph can become about the
painting or the painter, reducing the body to
just another canvas.
Another approach is writing on the body
and affixing signs. Text tends to dominate an
image, and the effect is usually more potent
than attaching a caption. If the text is not
Â�legible but is recognizable as text, it creates a
particular type of visual tension.
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As you move in closer, the characteristics of
the skin become increasingly prominent. Macro
lenses can be used to bring the viewer so close
that the skin itself is transformed into something
abstract. Lighting the skin from the side with a
directional light source such as a grid spot will
emphasize its texture. This can be a very powerful effect on the faces and bodies of older men,
but it might bring protests from anyone who
sees lines and bumps in the skin as flaws.
Gesture

A famous painting in the Louvre from the late
1500s has been riffed in photography many
times. It’s referred to as “Portrait presumed
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to be of Gabrielle d’Estrées and her sister the
Duchess of Villars.” In it, two apparently nude
women are standing inside a draped space facing partially toward each other and partially
toward the viewer. In a seemingly exhibitionistic gesture, the sister on the left side of the
canvas is reaching over to tweak the nipple of
the sister on the right, whose hand gestures
suggest that she is poised to respond in kind.
These gestures meant something very different in the time that the painting was made,
and understanding what the painting intends
to signify requires a knowledge of its codified
symbolism—for example, tweaking the right
nipple apparently meant that the woman in the
painting was pregnant.
Gestures can be powerful accents in an
image. They have much richer application across
the history of painting, especially in religious
works, than in photography. In such paintings,
gestures often have specific meanings, such as
the Holy Trinity, sovereignty, protection, and
more. Austrian Expressionist painter Egon
Schiele often used hand gestures to convey
emotion in powerful ways.
Although glamour photography makes use
of gestures more frequently than other modes,
many photographers overlook the hands, mainly
posing the body and possibly directing the
facial expression. In glamour shots, the hands
are often placed to bring attention to the face,
making use of the principle of leading lines.
Erotic

It has been said that particularly in the United
States, images of nudity are typically viewed in
one of only two ways: either as abstract, artistic
and asexual, or as erotic/pornographic. Aside
from academic medical imagery, exceptions to
those two views are hard to find.
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TOP: Reproduced by permission of
Alfred Laij.
BOTTOM: A playful and unusual take
on eroticism that demonstrates that
gestures can be done with more than
the hands. Reproduced by permission
of Jafar M. Pierre.

If you ask ten people what makes a photograph erotic, you’re likely to get a dozen answers.
If you want to make things more interesting,
ask them about the difference between erotica and porn. It’s easy to find examples where
the words erotica and pornography are used
interchangeably. In 1964, Justice Potter Stewart famously declined to give a specific definition for “hard-core” pornography, but declared
“I know it when I see it.” This is an important
distinction, since works deemed obscene are not
protected as free speech in the United States,
and various communities have dramatically different standards.
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Robert Mapplethorpe famously blurred the
line between art and erotica. While even his
photos of flowers could be read sexually, his
more explicit depictions of sexuality could be
read aesthetically. He was a master technician,
and his lighting was outstanding. Mapplethorpe was gay and some of his work depicted
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TOP: Pubic Display of Modesty? This image would have been
illegal in 1935. Photo by Louis Benjamin.
BOTTOM: Reproduced by permission of Saddi Khali.

gay life and sexuality in a very frank and
unflinching way. Despite the obvious artistic
and Â�technical merit of his work, some people
took offense with some of his subject matter,
and because an exhibition that included some
of his works had received funding from the
National Endowment for the Arts (the NEA),
he, along with photographer Andres Serrano,
became lightning rods in the political movement to limit public financing of works that are
controversial or portray certain content.
Whether you choose to enter into the art vs.
pornography vs. obscenity fray or not, we can
consider what might make an erotic image more
artful. To the extent that it helps inform your
artistic vision, it may be useful to come up with
a personal distinction, but beyondÂ€that, the old
adage applies: “one man’s meat is another man’s
poison.” If you choose to explore that kind of
subject matter, be prepared to meet resistance.
Biology

The naked body, especially the female body, is
often viewed as either a signifier of sex or the
site of sex. Theorists observe that in advertising,
even clothed females symbolize sex. If you doubt
that, visit the New York City subway and take
note of the graffiti applied to advertising posters
featuring women: breasts or pubic hair are drawn
so as to make them appear naked, penises are
drawn in proximity to their crotches or mouths,
and lewd captions are often added. These are not
rare occurrences. One way to read such graffiti is
that the scrawl is simply Â�expressing the subtext
that is already present in these images.
The act of removing our clothes is often 49
elevated to ritual as a precursor to sexual intercourse, one of the fundamental functions of
human biology. Beyond depicting copulation,
many biological functions of the body have

been exploited by pornographers, and thus a
pitfall for fine art photographers who explore
these themes is that they are likely to have
their work viewed by some as pornographic.
Terry Richardson has said that he likes putting
sexual images in mainstream magazines, not
porn magazines. His inner game is to push the
images as far as he can, and still get them run.
Pregnancy and motherhood are two of the
more obvious potential outcomes of sex, but it
is noteworthy that representations of sex and
sexuality are strongly segregated from imagery
of pregnancy, motherhood, and family. Nudes
of a pregnant Demi Moore, Cindy Crawford,
and Heidi Klum have all graced the covers of
major magazines. The poses of pregnant nudes
in these settings tend to be very stylized and
conventional.
Pregnant nudes in fine art are relatively
rare. One of the more controversial examples is
Daniel Edwards’ life-size statue of a crowning
Britney Spears on all fours caressing the head
of a bearskin rug while giving birth. It was presented in 2006 as a monument to the pro-life
movement. The event had a lot of Â�photographic
coverage, and it is worth noting that a high proportion of the published photos of the statue
were shot from angles that obscured the view
of the emerging baby’s head.
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As problematic as art involving Â�pregnant,
and especially birthing, women can be, the
depiction of naked children is even more
treacherous. Jock Sturges’ work with nudist
families is widely known, as well as the FBI
raid and the legal case surrounding it, in which
a San Francisco grand jury refused to indict on
any charges. Some of the photographs in Sally
Mann’s “Immediate Family” show her own preadolescent children in scenes that have been
described by some as sexualizing them.
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Artists who explore these areas have to
become adept at defending themselves. Ironically, the controversy surrounding such cases
can increase the cachet of the artist. Sturges
points out that artists in such situations also run
the risk of being defined by the scandal instead
of the art that they produce. Mapplethorpe had
said that he hadn’t intended to be a poster boy
for free speech. He just wanted to be written
about on the merits of his art.
The Male Nude

It is obvious that male nudes in fine art are far
more rare than female nudes. This may be due
in part to the dominance of the heterosexual
male gaze as a point of reference in art culture,
which may well have had as much of a shaping
influence on art production as the emergence of
single-point perspective in Florence during the
early fifteenth century.
Regardless of the tendencies of the mainstream, photographers such as Bruce Bellas,
better known as Bruce of LA, blazed the trail of
photographing the male nude. Beginning in the
1940s, he shot for “physique” Â�magazines, such as
those published by Joe Weider, at a time when
gay pornography was illegal. His campy style
and the slightly amateurish look of his early
work helped define the look of male Â�homoerotic
photography and strongly Â�influenced the work
of fashion photographers such as Herb Ritts
and Bruce Weber. Mr.Â€ Weber changed the
face of advertising when he Â�portrayed a man
as a sex object for the first time in the iconic
Calvin Klein underwear campaign. It was the
look that launched the designer underwear
business. Weber’s sometimes controversial
advertising work has continued to push the
envelope, and includes the catalog he did for
Abercrombie and Fitch, which featured athletic male nudes.

C H A P T E R  T HR E E    |    T h e M a l e N u d e

Photo by Richard Rasner (Unique Nudes) of Nakayama Studios.
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The Nude in Context

53

“Any photographer who says he’s not a voyeur is either stupid
or a liar.”
—Helmut Newton

T

wo broad approaches that can be taken with nudes have
to do with whether the image treats the body (which
happens to be naked) as a formal element, or whether
the very state of nakedness is the point of the photo. Formal
images tend to be more restrained, downplaying the erotic,
and lean toward the abstract. When nakedness itself is the
point, the intended effect can often be to shock or to appeal
to the libido, though more sophisticated approaches can be
humorous, camp, ironic, or dramatic. These are all questions
of context, and especially in more conceptual work, context is
key in establishing a contemporary work as art.

4
OPPOSITE PAGE: Randy’s Donuts. Gary Breckheimer/www.GaryBreckheimer.com.

In 2004, The Museum of Modern Art presented a show called “Fashioning Fiction in
Photography since 1990,” in which photography that was shot for fashion was re-cast in an
artistic context. In essence those pieces were
converted into art works, even though they were
originally created as commercial work according to a brief. This appears to be the beginning
of a shift. In the years to come, curators may
well view fashion photography primarily as art
and not commercial work.
It has already been acknowledged that
American visual culture is highly affected by
pornography. Although it is doubtful that
this isÂ€ an exclusively American phenomenon,

TOP: A formal nude that emphasizes curves and flirts with
Â�eroticism. Photo by Louis Benjamin.
BOTTOM: Linda (Plage). A formal nude set in a landscape.
Â�Reproduced by permission of Pascal Renoux.
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TOP: A dramatic fashion nude features an unusual
pose and point of view, lighting, and sophisticated
composition. Reproduced by permission of Ned &
AyaÂ€Rosen.
BOTTOM: The interaction between the model andÂ€the
mannequin leans toward the surreal. Reproduced by
Â�permission of Terry Donovan.

it points to a challenge for photographers,
Â�especially heterosexual males who photograph
naked women: the knee-jerk reaction is to shoot
and maintain such images in the context of the
male erotic gaze. To go beyond that default
context requires the conscious and active creation of a different context.
Many photographers create their work in
the framework of a long-term project. This
approach can help contextualize the image
before it is made. In some cases, the artist can
take years to construct a single image from very
specific visual symbols. Joel-Peter Witkin is
an example of an artist who works with nudes,
props, and even cadavers in a very methodical
way to construct his images over time. Witkin
has a clear-cut idea in mind, well in advance 55
of any shooting. Jeff Wall does not photograph
nudes, but his process is even more painstaking,
and he relates his work more to the tradition of
painting than photography.

Other photographers shoot at a particular
moment because something grabs them; they
work on gut instinct, and they aren’t trying to
think too much during the process. Photographer Tim Davis has lectured about the importance of shooting the image that gets your
attention and that you see in the moment, even
if you don’t know why it calls to you. It might be
years beforeÂ€you find that it fits into a collection
with other photos, and that is the moment that it
becomes art. Working in that way gives a gestaltdriven process that is related to the work of Dada
and Surrealism. For such artists, the context in
which the work is finally presented may not even
be conceived of when the image is shot, and the
Surrealists shunned context altogether.
The Surrealists are particularly interesting
for their use of the nude and for the way they
broke up notions about photography and the

LSD & The Mushroom (The
Sequel). Image by Cheirodon.
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photographic object. The techniques of Surrealist photography are probably the most artful of
all applications of photography. Surrealist photography redefined the boundaries of lighting,
of pose, and of what is now post-production.
While the bulk of the debate of photography as
an artistic medium centered around questions
of whether a photograph was anything more
than a copy of whatever was placed in front of
the camera, and whether the photograph was
truthful or not, the Surrealists were interested
in using the photographic trace as a starting
point for imagery rather than an end in itself.
As important as the techniques of Surrealist image production are, the philosophy
that gave rise to the Surrealists’ work is just as
important. André Breton, who wrote the 1924
Surrealist manifesto, and Salvador Dalí, one
of Surrealism’s best-known figures, were both
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TOP: Solarization was one of the signature Â�techniques of the
Â�Surrealists. This image was created by applying a blue toner to a
solarized black-and-white photo. Reproduced by permission of
Terry Slater.
BOTTOM: Reproduced by permission of Terry Donovan.

strongly influenced by the writings of Sigmund
Freud. The Surrealists, by their very name, were
after something that was above realism. They
were interested in the subconscious and the
Â�irrational. If anything, theirs was the antithesis
of the highly conceptual curatorial vision that is
at the forefront of contemporary art.
One of the nagging critiques leveled against
the Surrealists is the dominance of the heterosexual male gaze in the genre. Many argue that
Surrealism’s treatment of the nude objectifies
and reduces the female body to a fetish object.
The Surrealists argued that this objectification
is simply a reflection of the true state of the
(male) subconscious. We shouldn’t forget that,
much like the Algonquin Round Table, the
Surrealists were a male-dominated clique.
Photographer Lee Miller was the photo
assistant, lover, and model of Man Ray, the best
known of the Surrealist photographers. She is
the one who discovered and refined the technique of solarization, which is generally attributed to Man Ray. Part of the reason that Miller
does not receive much recognition is that she
was ultimately persona non grata among the
Surrealists when she left him.
Surrealistic imagery is just one mode of nude
photography that makes heavy use of the symbolic value of the body itself. When the symbolic nature of the body is exploited, the body
can become metaphoric. Such images may not
have a caption, but they illustrate the adage
that a picture is worth a thousand words and 57
leverageÂ€a strong connection to verbal language.
Photographs that demonstrate visual puns also
trade heavily on the crossover between the
visual and the linguistic.

TOP: The setting of this photo compels the viewer to create a
Â�narrative that explains it. Photo by Steven Billups.
BOTTOM: Chicken Gothic. Gary Breckheimer/
www.GaryBreckheimer.com.

The idea of narrative in photography is easy
to see in photographic sequences, where the
viewer creates the action by deducing what has
changed between each frame. Within the single
frame, narrative can arise from the relationship
between compositional elements, but it also
often arises out of the way in which the viewer
processes an image linguistically. This starts
with mentally naming the objects Â�perceived
within the picture plane.
Environmental portraiture is largely about
using the surroundings to tell a story about the
person depicted, and environmental nudes can
have a similar narrative quality. While a portrait
tends to be a story about an actual person, environmental nudes are more often about a character in a setting or an idea. Gary Â�Breckheimer
is a master of the form. He describes his work
as being focused upon the juxtaposition of the
female form against the environment with erotic
overtones. His clever work often bristles with
subtext. Breckheimer has spent 20 years refining his art, and cites Robert Farber’s “Moonscape” as an early inspiration that still calls to
him today. He considers himself a rule-breaker,
and he gets a rush from creating his daring and
beautifully crafted street nudes.
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Environmental nudes often place the Â�subject
in a setting where nakedness is not acceptable
or expected, emphasizing nakedness itself. In
other instances, the environmental nude is
more about the sculpture of the body in a space.
A popular trope is placing a naked woman in a
dilapidated space. The opposition of decadence
and the female form in images often dramatizes the quality of beauty itself.
Another form of environmental nude is an
extension of environmental portraiture, where
C H 4 â•… T h e N u d e i n C o n t e x t
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TOP: Photo by Louis Benjamin.
BOTTOM: Snakes andÂ€moons almost always conjure magical,
mystical, or religious Â�overtones. Though much of the tonality of this
image is dark, its mood is not ominous. Reproduced by Â�permission
of NinaÂ€Pak.

the subjects happen to be nude. Both Nan
Goldin and Elinor Carucci use photography
as a kind of personal journal, photographing
important people in their lives in an up close
and personal way. Their photographs represent
slices of their own lives and the environments
are pieces of their own worlds.
Props are another means of adding narrative
to an image. The subject often focuses attention
on the prop, or uses the prop to relate to other
characters in the scene or to the viewer. A lot 59
of props carry a symbolic charge; for example,
boas and beads carry a heavy association with
burlesque. Guns and knives are often cliché,
and so are crosses, but such props can still be
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OPPOSITE PAGE, TOP: From the Re-Imagined Heroes series.
Photo by Richard Rasner (Unique Nudes) of Nakayama Studios.
OPPOSITE PAGE, BOTTOM: Photo by Richard Rasner (Unique
Nudes) of Nakayama Studios.
TOP: Reproduced by permission of Gaspar Marquez.
BOTTOM: Gass. Gary Breckheimer/www.GaryBreckheimer.com.

used in ways that transcend. Certain props are
so loaded with meaning that the challenge in
shooting with them can be a matter of keeping
the prop from hijacking the image!
The notion of the bodyscape borrows heavily
from landscape photography that dates back to
the beginning of photographic art. In most cases,
framing, lighting, and surprising points of view
are often used to turn body parts into visual metaphors for mountains, dunes, and other geological phenomena. The bodyscape emphasizes the
body as abstraction, and the form almost requires
that the figure not have a face; after all, with the
exception of Mt. Rushmore, Georgia’s Stone
Mountain, and perhaps a few other sites around
the world, landscapes usually don’t have faces.
For some, the phrase “fine art nude” is
almost synonymous with a body in a landscape.
The framing is generally looser than the bodyscape, and the portion of the image taken up
by the body varies greatly. The portion of the
frame taken up by the body helps to define
the significance or insignificance of the body
relative to the rest of nature. Landscape nudes
offer an excellent form to explore questions of
whether humans are outside of nature or part
of it. Urban landscape nudes tend to emphasize
the footprint of humankind on nature.
There are also landscape photographs that
strongly suggest the human figure, mirroring
the effect of bodyscapes. An interesting twist
on the idea of the bodyscape is the hybrid that
comes about by dominating the foreground of a
landscape image with a bodyscape. The styles of
landscape and bodyscape merge, and the bodyscape returns to its roots.
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TOP: Reproduced by permission of Alfred Laij.
BOTTOM: Diagonal composition, camera tilt, and a sense of deep
space combine to create a compelling merger of bodyscape
and landscape. Photo by Richard Rasner (Unique Nudes) of
Nakayama Studios.

Reference, parody, and commentary are
three ways in which images have employed
the nude very effectively, and often controversially. Terry Donovan’s Model vs. Photographer series creates a kind of parody rarely
seen. In it, he has reprised shots he did with
models with himself as the subject. The project
was invented out of necessity: he had no one
to shoot with, and he wanted to keep shooting. While many photographers of nudes recommend that we get in front of the camera
ourselves to experience what it’s like, a male
photographer assuming the poses of a female
model is a proposition that ups the ante. In an
e-mail exchange about the series, Donovan
said this about his process:
“The early shots were done months, even
years after the original shot had been taken.
Most of the recent ones are taken at the same
time as I’m shooting the model.… The biggest
challenge is trying to match the pose when I’m
not using a mirror, and … I have to rely on my
memory of the model’s pose as my only guide.
As you can see, I miss more often than hit.”
Donovan eventually took the idea a step
further with “The Model’s Revenge,” a project
where he turned over creative control to the
model and allowed himself to be photographed
in whatever way the model asked, with no limits. The intention was to make himself as vulnerable as the models in his routine shoots.
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Renee Cox did a body of work that was
collectively known as “Flipping the Script,”
which reinterpreted European religious masterpieces including the Pietà, Adam and Eve,
and Michelangelo’s David, using contemporary
African-American figures.
C H 4 â•… T h e N u d e i n C o n t e x t
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The lightning rod of the series is a piece
called “Yo Mama’s Last Supper,” in which a nude
Renee Cox stands in for Jesus in a rendition of
the Leonardo da Vinci work that inspired it.
When the photo was exhibited at the Brooklyn
Museum in 2001, New York Mayor Rudolph
Giuliani labeled it “anti-catholic” and called for
the formation of a “decency standards” commission to keep such works from being shown
in any New York museum that received public
funds. Giuliani’s position echoed the attitude
of Senator Jesse Helms during the controversy
over funding the National Endowment for
theÂ€Arts.

TOP: “I find it amazing that people are so concerned
Â�
about
whether a complete stranger is fat, or thin, or tattooed,
or—whatever. As if it’s their business, somehow? Well, if it’s my
Â�business, I make sure my models are well-fed.” Model: Kaitlin. Photo
by Marcus J. Ranum/http://photography.ranum.com.
BOTTOM: Reproduced by permission of Terry Donovan.
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Cox says her work is about breaking down
stereotypes, and describes “Yo Mama’s Last
Supper” as a tongue-in-cheek piece dealing with
issues of race, gender, and stereotypes. Provocative, yes, but she says she wanted to have fun with
it. She also acknowledges that one of the inspirations for her work is that while Christianity
is big in the African-American Â�community, its
iconography does not include images of black
people. As a response, she took it upon herself
to re-envision those classic images. That is a
powerful, and controversial, context.

of modern painting. But it still raises the troubling question of voyeurism.”

We return to the role of context in validating a work of art. The painter Gustav Courbet
was probably courting controversy when he
painted “L’Origine du Monde” (The Origin of
the World) in 1866. It depicts a woman’s bushy,
spread-legged vulva from an up close and personal perspective. Her torso fills the frame,
with an undraped nipple kissing the top of the
canvas.

Though the Greeks idealized the nude form
and third century Hindus even carved erotic
statues into their temples, there is a long history
of societal suppression of imagery that shows
nudity, especially when it can be read sexually.
Painters such as Egon Schiele and Amedeo
Modigliani are celebrated artists today, but in

The interesting thing about this work is
that it is on open display at the museum, and
it is not treated as something dirty on the
museum’s web site. This suggests a difference
in attitude about exhibitions of art in European culture, and yet the museum’s curators
seem a little defensive. This disclaimer appears
on the site:
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“… The almost anatomical description of
female sex organs is not attenuated by any historical or literary device. Yet thanks to Courbet’s great virtuosity and the refinement of
his amber colour scheme, the painting escapes
pornographic status. This audacious, forthright
new language had nonetheless not severed all
links with tradition: the ample, sensual brushstrokes and the use of colour recall Venetian
painting and Courbet himself claimed descent
from Titian and Veronese, Correggio and the
tradition of carnal, lyrical painting.
“The Origin of the World, now openly displayed, has taken its proper place in the history
C H 4 â•… T h e N u d e i n C o n t e x t

In short, the curators are saying, “folks, this
is art, not smut, and here’s why, even if there is
that troubling little issue of the male gaze.”
Contemporary painting has inherited a certain immunity owing to the legacy of works like
Courbet’s, and so there is a split: a photograph
treating the same subject material in this way is
likely to have its artistic merit more vigorously
challenged, whether it has a clever title or not.

Sister’s Got a Habit. Photo by Gary Breckheimer/
www.GaryBreckheimer.com.
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TOP: Two Uses of a Word. Photo by Louis Benjamin.
BOTTOM: Reproduced by permission of Saddi Khali.

their time, some of their works were removed
or banned from shows, some had entire shows
shut down, and some had works destroyed.
Schiele was jailed for obscenity in 1912.
Photographer Paul Outerbridge is respected
for his artistic genius today, and was a pioneer of color photography, nudes, and fetish
Â�photography. In 1935, he sent a roll of film to
Kodak for processing. When it came back to
him, the “offending” areas in his images had
been scratched out. His frustration with what
he considered to be “infantile and ridiculous”
attempts to legislate morality caused him to
retire from photography sometime around
1945, saying that he felt he was being forced
into making clandestine a matter that should
be public.
Charis Weston, the model in some of his
most famous nudes, recalls that about a year
after Outerbridge had his Kodak moment,
Edward Weston was using a magnifying glass
to carefully inspect his print of “Nude, 1936”
to decide whether he could ship it through the
mail. If you look very closely at the image, you
can see a few pubic hairs.
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Light, Shadow, Color,
and the Qualities of
Lighting
69

I

t may seem to be stating the obvious to say that light and
lighting are what put the “photo” in photography, but a
quick survey of the offerings of professional and amateur
photographers alike suggests that many have an uneasy
relationship with light and lighting. That’s not meant as an
indictment; it’s an acknowledgment. Many photographers say
they only use natural light because they don’t like working
withÂ€flash, and many more admit that they don’t understand
how to light. Yet many of these same photographers do
recognize when the available light has a quality they like, and
use it to their advantage. This chapter is about seeing light
and describing some of the possibilities of using it. It is also
more theoretical and less specifically about nudes than the
preceding chapters have been.

When we start to think about light, it’s useful to differentiateÂ€among
qualities of light. Skiers don’t just see snow; they see hard pack, moguls,
powder, crud, crust, slush, corn snow, loose or wet granular snow, fresh
snow, spring snow, and ice. Seasoned skiers may have an even larger
vocabulary for snow, and each distinct type of snow can have a profound

5
OPPOSITE PAGE: Nu à la Fleur Rose. Reproduced by permission of Pascal Renoux.

Strong light from camera left
Â�illuminates the subject and
theÂ€smoke, which needs to be
Â�side-lit or backlit to register clearly.
Reproduced by Â�permission of
Jafar M. Pierre.

effect on the skiing experience. Developing a
similar sensitivity to various types of light and its
visual impact will give you a significant advantage
in making more effective photographs. To create
a particular look in location photography, some
shooters might exploit on-camera flash, while
others insist on natural lighting. In the studio,
photographers often choose from window
light, continuous light, strobes, or a mix of light
sources. These choices are based upon qualities
of light and have both technical and aesthetic
implications. They affect the process of shooting
and the look of the image, but they can also
impact the psychology of the interaction between
the artist and the subject.
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When applied artfully, light can profoundly
affect how we perceive the sculpture and spatial
qualities of a subject. It can also inject drama
and establish its emotional tone. Viewed in this
way, light is as much about visual language as it
is about registering an image.
Working with light is a bit like cooking. Even
after you learn how to use the basic utensils and
figure out a couple of recipes, there is a process

of experience to go through, and there are no
shortcuts. Grappling with light is not new. While
the technology of digital photography dates back
roughly three decades (longer than many of us
imagine), many common approaches to lighting
in use today were established seven centuries ago,
even before Columbus sailed the ocean blue.
Ha r d a n d S o f t L i g h t

One of the first aspects of light to contend with
has to do with how shadows are rendered. Hard
light creates hard-edged shadows, while soft
light creates shadows with a diffuse, feathered
edge. Of course, there is a continuum between
hard and soft light, and the art of working with
these qualities is figuring out when to use each,
and how they can be combined to best effect.
Hard light is sometimes called specular
light, because it tends to create bright, “hot”
highlights. The shadows produced under hard
lighting tend to be dense and show very little
detail, with a crisp, distinct edge. Shadow play in
front of a projector works because the light from
the projector lamp is focused into a hard beam.
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HardÂ€ light comes from relatively small light
sources. On a clear day, the midday sun is a highcontrast pinpoint light source that creates hard
shadows that can be very hard to deal with.
Soft light produces shadows that show a lot
more detail, and tends to make colors look less
saturated. If the edge is diffuse enough, these
shadows can be nearly undetectable. Light can
be softened by shining it through material that
diffuses it or by bouncing it off a large surface.
Multiple lighting instruments can be arranged
behind a large piece of diffusing material to
create an expansive soft light source. The larger
the surface of the light source, relative to the
subject, the softer the light.This means that even
with a soft light source, the light will gradually
get harder as you move the light away from the
subject, because its relative size decreases.
Windows, especially large ones, can be a
great source of soft light. The softness of the
light depends on the conditions outdoors and
the direction the window is facing. North light
is a favorite among sculptors and is extremely

TOP: The hard light of 2 PM
sunlight creates the dramatic finger
shadows in this image. Photo by
Louis Benjamin.
BOTTOM: Soft light can produce
subtle sculptural effects. Notice the
gentle tonal gradient on the thigh,
characteristic of soft light. The light
source was a window behind and
slightly above the subject. Photo by
Louis Benjamin.

71

Medium-soft window light Â�creates
a backlit image with luminous
Â�highlights that wrap around the
surface of the skin. The effect is
essentially a bodyscape. Photo by
Louis Benjamin.

consistent in intensity throughout the day,
while windows facing east or west are the most
variable. Windows facing south tend to have
hotter, harder light.
On overcast days, cloud cover can diffuse
the sun’s light to the point where shadows are
undetectable. This omnidirectional light can
be used to create great portraits, though it can
sometimes lack contrast and make colors look
washed out. When that happens, a bit of fill
flash, especially off axis, and kept to a minimum,
can add dimension and put a sparkle in the eyes.
The light on overcast days is also extremely
blue, and imparts a cool tone on everything if it
isn’t compensated for.
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Regardless of the cloud cover, open shade
can be a great lighting condition. Where do you
find open shade? Look for the shadow side of
a large building or under a canopy of trees. The
building obstructs the hard, direct sunlight and
even, filtered light reflects down from the sky.
This light can still have some direction to it, so
you may still get interesting shadows, and color
saturation is not a problem the way it is with
extremely diffuse light. As the color temperature
chart on page 91 shows, open shade has a high

color temperature and is very blue. North light
is essentially a variation on open shade.
A ring light or ringflash is a special lighting
instrument that is mainly used in the studio.
It was invented for medical photography and
has been widely adopted by fashion and art
photographers. It is fitted around the lens of
the camera and throws light in a pattern that
causes most of the shadows to be canceled.
Helmut Newton pioneered the distinctive look
of the light for fashion. When the subject is
near a wall, the light creates a halo-like shadow
that outlines the subject.
If you duck under a canopy of trees, you may
well get dappled light. This occurs when the
trees block most of the direct sunlight, but an
irregular pattern of highlights is projected onto
your sitter. This can be a beautiful and dramatic
effect, worth seeking out, or a complete nuisance.
Keep in mind that the highlights might be very
bright, and you may have to choose between
blowing out the highlights or blocking up the
shadows. The other thing to realize with the
shade of trees is that the leaves are likely to
create a strong green color cast in your image,
which your white balance generally will not
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TOP: Portrait of a Muse III 2009. Part of the most beautiful
Â�
Â�woman in town series, Shot in Justyna’s apartment 2008, Lit with ringflash.
Â�
Reproduced
by permission of Tobias Slater-Hunt.
BOTTOM: Dappled light is produced
Â�
whenever something blocks the light and casts a rhythmic pattern, whether it is tree leaves or something
man-made. Photo by Louis Benjamin.
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TOP: Shadows cast by Venetian blinds add to the visual interest
inÂ€this environmental portrait nude. Reproduced by permission of
Saddi Khali.
BOTTOM: Two lights graze the body at oblique angles to bring out
its sculptural qualities. One light is above and to the right, aiming
Â�
downward, and the other is to the left and slightly behind the
Â�subject, creating a wraparound light. Photo by Louis Benjamin.

compensate for. In Adobe Camera Raw, you
can compensate for the green by moving the
Tint slider toward magenta.
Many nudes with Venetian blind lighting
take their cue from Man Ray. Venetian blinds
create a distinctive dappling pattern that has
been used extensively in figurative photography.
Lace curtains can also create striking dappled
effects.
Direction

Where the light is coming from has as much
impact on your image as how hard or soft the
light is. Even with simple flash photography,
moving the light off-camera can substantially
improve the look of the image. We have an
expectation that natural light will come from
above for the most part, firelight being one
exception.
Because a hard light source throws distinct
shadows, there is a creative opportunity in
setting the lights so as to place those shadows
within the frame. Placing a light at an oblique
angle to the skin will bring out its texture and
sculptural form. The harder the light, the more
pronounced this effect will be.
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Soft light from the sides of and slightly
behind the subject can create the dramatic
effect known as rim lighting. When a hard
light source is positioned at an extreme angle
beneath the subject, the upward shadows can
be very unsettling. This is known as horror
lighting. Some lighting teachers declare that
you should never direct light upward at your
sitter, but there are exceptions. As one example,
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C H A P T E R  F I V E    |    D i r e c t i o n
TOP: Rim light effect produced by placing the model almost
Â�directly between two vertical strip lights. Moving her so that the
lights come more from behind would create an effect that is more
of a silhouette with a bright outline. Photo by Louis Benjamin.
BOTTOM: Catch lights in the eyes are often a telltale sign of the
lighting setup. Photo by Louis Benjamin.

angling a smaller lighting instrument slightly
upward and focusing a pool of light on just one
part of the body can produce a striking and
unusual visual counterpoint or accent that is
aesthetically pleasing.
You can often read the lighting arrangeÂ�
ment used to create a photograph, though
the clues can sometimes be obscured by postproduction. The two things to look at are the
catch lights in the subject’s eyes and where
shadows fall. The size and shape of the catch
lights can also be a clue as to the type of
lighting instruments used.
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TOP: Soft light from the left and slightly behind the subject
Â�emphasizes the curved surface and skin texture. The finger
Â�shadows give a clear indication of the location of the light source.
Photo by Louis Benjamin.
BOTTOM: A single large, soft light source produced this intriguing,
Â�
nearly abstract photo. High key lighting and smart framing make
this composition work. Reproduced by permission of Ned &
AyaÂ€Rosen.

S c u lp t u r al a n d T e x t u r al
Eff e c t s

Lighting that comes from a side angle causes
parts of the body to throw shadows, which
emphasizes the spatial and sculptural qualities of the body. The harder the light, the more
pronounced the texture. The feathered shadows
produced by softening the light can bring out
the sculpture while minimizing the texture.
One Light

Many well-known portrait photographers’ signature looks use only one light. It’s a simple,
unconfused way of lighting. One successful
strategy is to use a very large, soft light source
situated behind the photographer. A completely
different look can be achieved by placing a hard
source above and to the side of the model.
K e y a n d F i ll

When more than one light is used, there is
generally one dominant light, known as the
key light. The other lights are typically placed
for effect, to open the shadows, to separate the
subject from the background, or to create highlights. The strong key light may cast an overly
heavy shadow on some part of the body. In
that case, it can be useful to throw light into
the shadow areas. This can be done with a light
or with a simple reflector. This technique is
referred to as filling or opening the shadows.
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When working with fill, nuance is often the
essential difference between an everyday photo
and one that really stands out. The shadow areas
provide a sense of depth, which is lost as you
add more fill. The challenge is to find a balance
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TOP: The main light in this shot is a medium-hard light from above
and to the left (note the shadow of the clock on her chest). A soft
fill light from the right and slightly behind opens the detail in her
face. Photo by Louis Benjamin.
BOTTOM: A pool of light centered on the model’s face creates a
theatrical chiaroscuro effect. The light falls off quickly, suggesting
that either a grid or a snoot was attached to the lighting Â�instrument
to constrain the light. Reproduced by permission of Jafar M.
Pierre.

between showing detail in the shadows and
making the subject look too flat. The relative
intensities of the lights come into play here. If
you use a light meter to read the light, you will
quickly find that you need a difference of at
least one f-stop for the difference in brightness
to register clearly, while four or more stops
creates a high-contrast look. While you need a
difference of one or more stops between lights
to clearly register lighting contrast, opening or
closing the aperture on the camera by as little
as 1/3 stop can make a significant difference in
the overall exposure.
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TOP: The triangle under the eye that is the Â�signature of Rembrandt
lighting. Traditionally, the eye socket is not blacked out. This look is
highly dependent upon the shape of the face, and small shifts of
the head or the light can make dramatic changes in its appearance.
Photo by Louis Benjamin.
BOTTOM: The intersection of sex and death is a rich vein for
artistic exploration. Window light from the front and above right is
cast down in a restricted pool, lighting one side of the skull and the
model’s haunch brightly. The light falls off gracefully from there. The
fill in the shadow areas is from a second window. The image was
shot on slide film. Reproduced by permission of Terry Donovan.

Lighting Ratios
Lighting Ratio

Difference in F-stops

1:1

(Same intensity)

1:2

1 stop

1:4

2 stops

1:8

3 stops

1:16

4 stops

1:32

5 stops

1:64

6 stops

f-Numbers
0.5, 0.7, 1.0, 1.4, 2, 2.8, 4, 5.6, 8, 11, 16, 22, 32, 45, 64, 90, 128
The range of standard f-numbers. Most lenses do not support the entire range.

We’re talking about lighting ratios here.
These are often expressed numerically in terms
of power, such as 1:2, 1:8, etc., but that can be
problematic, since you have to first translate the
different ratios into the number of stops (e.g.,
1:8 is three stops) and then figure out what
f-number that refers to (e.g., if you want the
light to be three stops dimmer than f/8, your
meter should read f/2.8).
C o n t r a s t, C h i a r o s c u r o ,
and Noir
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The word “chiaroscuro” is Italian for light/dark,
and it is typically used to describe high-contrast,
sometimes low-key, images. Sixteenth century
Baroque and Mannerist painting made heavy
use of chiaroscuro, and Caravaggio is particularly well known for employing the look. It is a
useful technique for adding drama to a portrait
that has been widely adopted by photographers.
In nude photography, dense shadows are often
used to create a draping effect for the genitals.
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Shadow also creates a sense of mystery. Slightly
opening the shadows, so that we get just hints
of detail, can pique the viewer’s curiosity.
“Rembrandt” lighting is a specific applicaÂ�
tion of chiaroscuro. The light is placed roughly
45 degrees to the side, and at an elevation
of about 45 degrees, though this will vary,
depending upon the shape of the subject’s
face and the attitude of their head. The key
characteristic of this style of lighting is that
one side of the face is illuminated and the
other side is dark, except for a triangular area
beneath the eye. The triangle is produced by the
intersection of the shadow extending from the
nose and the shadow on the cheek. Ideally, it is
the same width as the eye. When the subject is
facing away from the camera, the shadow side
is closest to the camera.
The silhouette effect in this shot is modified by light wrapping
around the thigh in the background. A second, much weaker, light
at camera right gently fills the shadows and shows sculpting on her
arm and shoulder. Photo by Louis Benjamin.

Spot lights, snoots, and grids all focus the
light in ways that create restricted pools of
light. Some lights use a lens that can create a
very sharp-edged area of illumination. Grids
are generally rated between 10 and 40 degrees,
and the smaller the number, the narrower the
spread of the beam. Narrow grids also soak up
a lot of light, reducing the intensity of the light
dramatically.
Film noir (French for black film) is known for
its low-key, high-contrast, black-and-white look.
Often, scenes are backlit. Noir, however, has as
much to do with its subject matter and dramatic
treatment as it has to do with the look.
Rendering an image in black and white
and using moderate to high contrast tends to
emphasize the form and space of the figure.
A soft, feathered light that wraps around the
figure can have a subtle, sculptural effect, while
a harder light tends to emphasize edges and
make the figure more abstract.
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TOP: Shooting into the shadow of
a scene illuminated by a light cube.
The height of the cube causes diffuse light across her torso. Photo by
Louis Benjamin.
BOTTOM: An example of Avedon
lighting. Photo by Louis Benjamin.

Silhouettes

These are simple enough to shoot, but there are
ways to modulate the look. To make a strong
silhouette, it’s often necessary to actually light
the background. When you illuminate a lightcolored background, a fair amount of light
can bounce around the room. Sometimes that
bounced light can be strong enough to fill the
shadows in the foreground and diminish the
silhouette effect. You can use a “black bounce”
in front of the model and around the shooting
area to control the unwanted reflections. Black
bounce can be a matte black cloth material that
is taped or draped over walls and surfaces or large
sheets of foam core with a matte black surface.
Some studios even paint the ceiling black. Of
course, you can amplify the effect of the lighting
with post-production in Photoshop, but it takes
skill to make the result look convincing.
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Even with the black bounce, the light
bouncing off the background can be a problem
or a benefit, depending on the look you’re going
for. Pulling the figure away from the background
keeps light from spilling around the edges of the
figure. Conversely, placing the figure close to
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TOP: A diagram of Avedon light setup.
BOTTOM: An example of lens flare. Photo by Louis Benjamin.

the background can give the effect of the figure
merging with the brightly lit background.
The technique that photographer and
teacher Frank Franca calls “shooting into the
shadow” is an extension silhouetting. The
subject is placed between the photographer
and the lighting instrument so that some light
spills over onto the camera side of the shot. The
effect can be very moody, featuring large, dark
areas that can have a very abstract feel.
Av e d o n L i g h t i n g

Richard Avedon’s signature look was a subject
standing in front of a plain white background.
The evenness of that white background and
the fact that it registers as white in the photo
are two clues that the look is not as simple to
achieve as it appears.
If a seamless paper background simplifies the
image and directs attention to the sitter, then the
stark white background is the ultimate extension
of this look. The plain white gives us nothing
to work with, not even color or tone, and so we
look that much more closely at the subject.
One way to think of Avedon lighting is as an
illuminated silhouette. You start by throwing an
even illumination on the background. Umbrellas
are particularly useful for this purpose. What
you’re looking for is a brightness that is at least
two f-stops brighter than the light reading at the
model. For best results, you need some distance
between the sitter and the background, so that
you don’t have to contend with spill from the
background wrapping around the sitter. That
lighting will essentially produce a silhouette. From
there, you add the appropriate amount and type of
lighting for the model. Avedon himself typically
used a large soft box, but your variation on that
look could use any instrument you like—a grid
spot in the Rembrandt position, for example.
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Sp i ll , F la r e , a n d Halat i o n

When you place the sitter between a light
source and the camera, there is always the
potential for some light to travel from the
light source directly into the lens. If the light
is strong enough, you will get a colored flare
pattern in the image. If not, you will generally
get a soft, foggy, reduced-contrast look known
as halation.
The wider the focal length, and the more
wide open the aperture, the more you’ll have
to contend with flare and halation. You can
intentionally produce this effect and use it
artistically, but if you don’t want it, your first line
of defense is a lens hood. In more difficult cases,
the important thing to recognize is that these
effects come from light that is not illuminating
the scene and is spilling into the lens instead.
Then you can find the offending light and block
it from the lens, while still allowing the light to
fall on the model. This is known as “flagging.”
Often, it is easiest to put the flag close to the
lens, but sometimes it is sufficient to place the
flag on or near the light source.
If the lighting instrument you’re using
spreads light, there is always the potential for
spill, meaning light that is falling onto surfaces
that you didn’t intend to illuminate. Flare and
halation are two particular issues of spill, but
the problem can be as simple as too much light
falling onto the background. The trick is to
position the light, the camera, or both so as to
minimize unwanted spill.
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Bouncing light off walls is a way to soften
light that is essentially a creative use of spill; in
this case you’re intentionally causing it, instead
of trying to contain the spill. Cinematographers
often create soft lighting for large areas by
bouncing lights off a pebbled foam surface
called bead board. It’s important to consider the
TOP: A diagram of flagging.
BOTTOM: A diagram of feathering.
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color of the surface you are bouncing the light
off of. It can substantially change the color of
the illumination with some unpleasant results.
F e at h e r i n g

A related issue is feathering, which can be used
to make a subtle improvement in the look of
your lighting. If you were to illuminate a flat
wall with an umbrella and take a photo, you
would notice that the center of the illuminated
area is “hotter,” or brighter, than the edges. It
turns out that this edge light is a bit softer and
tends to have less specular highlights than the
light from the center of the umbrella. It also
has lower intensity. Many seasoned photographers only use the feathered portion of the light
from an umbrella. The lighting from a soft box
is more even than the light from an umbrella,
but you can also position it to take advantage
of feathering. Lighting your subject with the
feather has the additional benefit that it throws
less light onto the background.
Intensity

The brightness of the light source(s) has a few
important effects upon the shot. The most
obvious is that the overall intensity of the light
determines the combination of the ISO, f-stop
(aperture setting), and shutter speed that will
be necessary to register your image. Second, the
intensity of the light can effect how deep, and
potentially problematic, the shadows in your
image will be. Bright light can be challenging
to the eyes, making your sitter squint in the face
of a bright constant light or cringe in anticipation of the flash going off. The somewhat dazed

expression in some old Hollywood portraits was
a compensation for the intense illumination of
the lights that were used. As the light becomes
stronger, there is an increased risk of spill.
To use multiple lights effectively, you will
need to know how to control the relative
intensity of the light from each instrument.
In the digital age, many photographers simply
take a test shot and look at the histogram to
determine exposure. That approach can work
very effectively with a simple light setup, but
when there are multiple lights involved, getting
the intensities of the lights into the right
ballpark can go much faster with the aid of a
light meter.
Adjusting the intensity of the light can
be done in different ways, depending on the
lighting instrument, but you can adjust the
intensity of any light by simply moving the
instrument closer to or farther from the subject.
Even though most strobes allow you to vary the
intensity of the light over a range of three to
five f-stops, you may still find that it is easier to
move the light head, especially if you have two
heads connected to one power pack.
To increase or decrease the lighting intensity
by two f-stops, simply double the distance, orÂ€cut
it in half. Doubling the distance decreases the
intensity, and halving the distance increases it.
It’s slightly less obvious what to do to make
a one-stop change in intensity. To decrease
the intensity of a light by one f-stop, increase
theÂ€distance to the subject by 1/2. To increase
A diagram showing how to move a light source to change its
Â�intensity one to two stops.
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the intensity by one stop, decrease the distance
by 1/4. In other words, if the light was six feet
from the model and you want the light one
stop dimmer, move it to nine feet—an increase
of three feet. If your light was eight feet from
the subject and you want to make it one stop
brighter, move it two feet closer.
We end up with 1/4 and 1/2 for one stop
because the intensity of the light is related to the
square of the distance. Since the exact numbers
are not very memorable and we don’t need to
be that precise, the rule of thumb numbers are
rounded for the sake of simplicity.
Low - k e y, H i g h - k e y, M i d - k e y

Low-key images have an overall impression of
darkness, while high-key images seem bright.
There are no hard lines between these characterizations. This is not simply a matter of
underexposing or overexposing the scene, but
choosing a particular exposure in conjunction
with setting the lights a certain way.

TOP: A classic low-key image
withÂ€strong graphic qualities.
Â�Reproduced by permission of
Saddi Khali.
BOTTOM: This high-key image
creates mystery with a diffuse glow,
rather than dense shadows.
Reproduced by Â�permission of
Gaspar Marquez.
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Low-key images tend to have one or more
small pools of light that show good detail and
moderate tone. The lighting in such images is
often called “mood lighting.” You can create a
low-key image with a single lighting instrument.
Often, this is a hard light source with a lightshaping tool that limits the lighting to one area.
High-key images are bright and have less
contrast than low-key images. They tend to be
illuminated with more instruments. There is
often separate lighting for the background and
the model, and the model is often pulled away
from the background to avoid spill.
Most images are mid-key, and as you would
expect, mid-key falls in between low-key and
high-key.
O t h e r Way s o f L i g h t i n g

Anything that emits light can be a light source
for an art photograph. Light painting with a
flashlight is an interesting process that truly
makes one-of-a-kind images. You can also drape

TOP: A light-painted nude
Â�illuminated with a two-color LED
flashlight. Thirty-second exposure.
35mm lens at f/2.0. Photo by Louis
Benjamin.
BOTTOM: Small globe lights
turn the body into a light source.
Â�Ambient light brings out the details
of the figure. Reproduced by
Â�permission of Barney Cokeliss.
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TOP: Cthulhu’s Canvas. A black-light nude. The glow on the body
comes from fluorescent paint. Photo by Richard Rasner (Unique
Nudes) of Nakayama Studios.
BOTTOM: Camera RAW interface controls.

lights on the body. If the lights are Â�colored, you
need to carefully control the exposure to capture the color of the lights. Some of the light
will illuminate the body, but much more of it
will illuminate the room, so the body becomes a
light source. The body becomes even more of a
light source if you apply fluorescent paint to the
skin and light it with a black light. Some blacklight nudes aren’t even recognizable as bodies.
Ultraviolet light is damaging to the eyes, so
it’s important to take proper precautions if you
work with this technique.
Exposing to the Right

Sometimes the most compelling elements of a
photo are the details in the shadows, and shadow
detail is one of the weakest areas of digital photography. Many shooters who work with film
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TOP: This image is rich and layered. The colors of the ball
and Â�bedspread are complementary. Geometric primitives (the
Â�triangle and circle) are powerful compositional elements, and the
Â�lighting Â�reveals textures, translucency, and form. Reproduced by
Â�permission of Terry Donovan.
BOTTOM: The cool blue background enhances the sense of
warmth in the model’s skin. Rim lighting visually separates her dark
skin from the dark colored background. The lighting was produced
with two strip softboxes. Photo by Louis Benjamin.

were taught to “expose for the Â�shadows and
process for the highlights,” which is the basis of
the technique of “exposing to the right,” which
you can do if you shoot in RAW. It works
because you can recover the highlight detail in a
RAW image. Generally speaking, you can overexpose by nearly one full f-stop, and then use
the Recovery and Brightness sliders to restore
the highlight details. By doing this, you are giving more light to the shadow areas, allowing
you to register more detail.
Exposing for the shadows is an idea that
comes from the Zone System, which was
developed by Ansel Adams to allow film
photographers to pre-visualize the effect of
exposure choices on the amount of shadow and
highlight detail in the final image, as well as the
tonal balance of the print.
Co lo r

Light also gives us color, from the cool blue of
the sky to the warm yellow-orange of candlelight, and color can often convey emotional
overtones or symbolism. There is a sensory and
psychological dimension to color, which can
work entirely at the subconscious level. The
symbolic use of color is a subject dense enough
to merit its own book. Certain colors have very
different meanings in other cultures. One of
the better-known examples is white, which
symbolizes purity in many Western cultures,
but symbolizes death in a number of Asian
87
cultures. Limousines are often painted black
because of the way it conveys power.
Of particular interest to the photographer
working with nudes is the class of colors that are

referred to as memory colors—sky blue is one,
and healthy skin is another. When these colors
are off, it can send a strong signal about the
picture we are viewing. There is even a cultural
component to these memory colors: the color
that is preferred in print magazines to represent
healthy olive skin by Westerners is considered
dark and cadaverous in many Asian cultures.
Colors also interact, and surrounding one
color with another can change how we perceive
the first color. This phenomenon is known as
simultaneous color contrast. A practical result of
this is that surrounding your model’s warm skin
tones with a cool background (e.g., blue sky or
green foliage) will make his or her skin look even
warmer. It works the other way, too—your sitter’s
skin will look cooler when set against a warm
colored background (e.g., a bright red backdrop).
Co lo r a n d M o o d

Our perception of color arises in the nervous system as a response to stimuli. As such,
it makes sense that there would be a psychological aspect to color and that each person’s
response to color is unique. That’s one reason,
for example, that people have different favorite
colors. Black-and-white photographers tacitly
acknowledge the psychological impact of color
by embracing the practice of toning prints and
selecting photographic paper based on its warm
or cool tonality.
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contributions than for his scientific work)
published a theory of color. Goethe’s
observations about the emotional impact of
colors and optical effects still carry weight,
particularly in the art world, where perception
is of prime importance.
Master cinematographer Vittorio Storaro
(whose credits include “The Last Emperor,”
“Apocalypse Now,” “Reds,” and “Dick Tracy”)
bases his philosophy of color on Goethe’s work.
On his web site www.storarovittorio.com/
ingles/index.html, Storaro says, “I have always
thought that film was capable of registering the
emotions of the people who participated in the
making of a movie.… As cinematographers, we
write with light and motion, using shade and

A colored gel was applied to the light that is filling the shadow side
of this photo. Colored lights lose saturation and become washed
out as you increase their intensity, so they work best in low-key or
shadow-side applications. Photo by Louis Benjamin.

Anecdotal evidence of the emotional aspect
of color is easy to find. For example, we have
colorful phrases that describe states of mind,
such as “got the blues” and “green with envy.”
During Picasso’s famous “Blue Period,” he
painted in blues and blue-greens, colors that
are described as “austere.” One branch of
psychology studies the impact of certain colors
upon the emotions and is of particular value in
the treatment of psychosomatic illness.
In 1810, Johann Wolfgang von Goethe
(probably known more for his literary
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color to punctuate one important part of the
vocabulary of cinema.”
Storaro collaborated with manufacturer
Rosco to produce a set of colored lighting gels
called the Storaro Selection. Gels are thin filters
that can be placed over a lighting instrument
to color the light. Rosco’s literature describes
the Storaro gels this way: “These ten colors
represent key chromatic elements of the visible
spectrum, and are intended for dramatic effect
and strong emotional response.” His ten colors
are red, orange, yellow, green, cyan, azure, blue,
indigo, violet, and magenta; that’s the R-O-YG-B-I-V we learned in school, plus cyan, azure,
and magenta.
Projections are another alternative light
source that can function much like gels by

Reproduced by permission of JD Yezierski.

applying color to the body, but they can also
add layers of imagery. The colored elements
of the image being projected interact with
the skin pigments, often producing surprising
results. The three-dimensional form of the body
also distorts the projection, so that the body
interferes with the reading of the projection
and the projection interferes with the reading
of the body.
W h i t e B ala n c e a n d C o l o r
T e m p e r at u r e

In practical terms, all light has a color, and each
type of light source emits light in a characteristic range of colors. For example, daylight is bluish, while candlelight is yellowish orange. If you
stand outside a building around dusk, you are
likely to see bluish light coming from the sky
and yellowish light coming from the fixtures
inside the building. If you happen to have a
white handkerchief in your pocket, and look at
it in the outdoor light, it will look white. If you
go into the building, the indoor light quickly
ceases to look yellow, but the handkerchief will
still look white. This phenomenon is called color
constancy. Our eyes are constantly adjusting to
(neutralizing) the color of the ambient light,
and that is what the white balance controls in
your digital camera and Photoshop’s Camera
RAW, as well as the gray balance dropper in
Photoshop, are intended to do.
By shooting a frame with a spectrally neutral
gray card, you can have Camera RAW calculate
aÂ€ more accurate white balance than your
camera’s auto white balance feature can. Once
you have a white balance for your reference
frame, you can open groups of RAW files
together and synchronize their white balance
settings in Camera RAW.
Film-based photography has a simplified
version of white balance. There are only two
choices. In digital, we can be more specific about
the color of the light that we are compensating
for. Films for shooting indoors are said to
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TOP: A Whi-Bal reference card for getting accurate white balance.
Photo by Louis Benjamin.
BOTTOM: The color of this photo was manipulated through
the white balance controls of Camera RAW. Reproduced by
Â�permission of Saddi Khali.

be tungsten (incandescent light) balanced.
These films effectively have a blue filter built
into them, which makes the yellow light look
neutral. Daylight film “sees” blue light as if it
is white.
We can exploit the white balance setting
in the camera creatively. Film photographers
have often shot indoors with daylight film to
emphasize the golden color of incandescent
light, or shot with tungsten film outdoors,
rendering the entire image a cool blue. There’s
nothing to stop you from doing the same
thing in digital. You can use the preset color
temperatures (typically tungsten, flash, daylight,
and cloud), or dial in your own numbers.
If you learned about “warm” and “cool” colors
in art, there’s an obvious discrepancy inherent in
the way we talk about color temperature: high
color temperatures describe “cool” hues, and
low color temperatures describe “warm” hues.
This is not really a problem, because the white
balance system compensates for the color of
the light by reversing this relationship. In other
words, increasing the color temperature setting
in the camera (or in Photoshop’s Camera Raw)
gives the resultant capture a warmer tone, and
decreasing the color temperature setting gives
the resultant capture a cooler tone.
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If you’re going to use this technique
aesthetically, you want to pick a color
temperature that makes it clear that you are
intentionally pushing the color. If you select a
value that is only slightly off, it may be lost on
the viewer or be read as a mistake.
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More on Color Temperatureâ•‡ Color temÂ�

There are special fluorescent lights that were

perature is a simple way of assigning specific

developed for the film and digital still industry.

numerical values to each of the hues in the

These use bulbs and special electronics that

range between matchlight orange and deep sky

have been designed to emit light that is more

blue. It gets its name from a principle in Physics,

consistent with either daylight or tungsten

where heating an object called a “black body”

light sources.

to a particular temperature will cause it to glow
at a specific color. The Kelvin scale is one of the
main temperature scales used in Physics.

The fluorescent lights used in home and institutional settings are a bit problematic for
photography. These emit a kind of light that

The color temperature of “daylight” varies

is not full-spectrum, and does not fit well into

over a range of about 5000 Kelvin! (By the

the white-balance scheme. While you can

way, even though Kelvin is a unit of tempera-

ascertain a color temperature for these lights,

ture, we don’t say the word “degree.”)

the range is extremely broad, and goes from

Sunrise, sunset

3200 K

High noon

5000–5400 K

Open sky

5500–6500 K

Overcast sky

6000–7500 K

Open shade

7000–8000 K

Partly cloudy sky

8000–10,000 K

Blue sky

9000–12,000 K

3200Â€ K to 7500 K, so one setting does not
fit all.
In addition, fluorescent light from such fixtures tends to have a very strong green component, which white balance alone does not
compensate for. You will notice a green/
magenta tint slider in Adobe Camera Raw. It

Similarly, all incandescent light isn’t one color.

is there specifically to neutralize light that is

You may have noticed that a tungsten light on

either too green or too magenta. When you

a dimmer ranges between a warm amber color

use the color temperature preset for fluo-

at low intensity (and temperature) to a very

rescent light in Camera Raw, the tint slider

pale yellow at high intensity.

moves dramatically to the right. If you shoot

Match

1700–1800 K

Candle

1850–1930 K

Household bulbs

2500–2900 K

in indoor light or daylight with your white balance set to fluorescent, your images will have
a strong magenta cast.

Quartz/Halogen bulbs 2800–3400 K

91

C H 6 â•… C o m p o s i t i o n

C H A P T E R  S I X   |    C o m p o s i t i o n

Composition
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B

oth photography and painting have a notion of composition, and though they are related, they are actually
different processes. In painting, individual elements of
the composition are assembled in a layered process of construction, or addition. Often, there are revisions, and elements
of the painting are moved, added, or even removed. In photography, the composition is based upon an act of exclusion—
pointing the camera imposes the camera’s frame on the scene,
and subtracts everything that falls outside of the frame. From
there, the event being photographed can further be framed
in terms of selective focus and the duration of the exposure.
Each of these additional frames is a compositional choice.

In some cases, the photographer can direct some of the action and
move people or objects on a set to construct the scene in a way that
is more akin to what a painter does, but more often than not, it is the
photographer who stands on tiptoe, squats, climbs a ladder, or rolls
onto his or her belly to find a compelling view.

6
OPPOSITE PAGE: The elemental act of photographic composition is framing. Reproduced by permission of Alfred Laij.

Once the shutter falls, the process of composition is complete. Cropping after the fact
can further reduce the framing, but with the
exception of montage or some other joining of
images, no other revision of the latent image
is possible; there is only starting on a new
image.
There is a danger in thinking too rigidly
about composition. We explore principles
of composition as a way of philosophizing about what makes a picture work, but
these principles should be taken as suggestions, not immutable laws. With that caveat
in mind, we can look at ideas of composition
that are drawn from graphic design as well as
photography.
In Chapter 2, we mentioned that for any
given image, the shape of its frame (its aspect
ratio) could affect the way the image is perceived. In particular, the corners of the frame
and its dimensions create expectations in the
viewer about where important elements should
fall within the frame.
Students of basic graphic design are taught
about the “rule of thirds.” To apply this rule,
weÂ€can draw imaginary lines to divide the frame
into thirds, both vertically and horizontally.
Some cameras even have an option to display
grid lines in the viewfinder that illustrate the
rule of thirds. It is unfortunate that this principle is referred to as a rule, since it is no more
than a suggestion. While the principle generally works, calling it a rule gives it more weight
than it deserves.
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One successful way of working with the
rule of thirds is to use the image segments,
whether vertical or horizontal, as containers.
For Â�example, if your sitter is in an outdoor setting, you might frame the image so that the sky
occupies the top two-thirds of the frame and
the ground occupies the bottom third. Â�Looking
Â�horizontally, the sitter could be positioned so
C H 6 â•… C o m p o s i t i o n

that most of the body occupies the middle
third.
The points where the dividing lines meet
have additional weight. You could call them
pressure points. Placing an element of your
composition on one of these points will focus
attention upon it. One way to call attention to
your model’s breast is to place the nipple on
the pressure point at one of the intersecting
thirds.
The regimental evenness of 1/3 divisions
can make composing on the basis of the rule of
thirds a bit staid. Renaissance artists and architects, and even Leonardo da Vinci, often used

Dividing this image into three equal segments
Â�
from top to bottom
Â�
demonstrates an Â�application of the “rule” of thirds. Photo by Louis
Benjamin.
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the golden ratio as a reference for determining
proportions that are perceived as being beautiful. The golden section proportion is based on
the Greek ratio phi, or 1.618. Applied to the
rectangular frame of a photo, the golden ratio
lines hug the center more than do the rule of
thirds lines. The best way to learn to employ
this proportion is to develop a feel for where
the proportion lines fall. The extra effort will
often pay off.
The absolute center of a picture is often
referred to as “dead center,” and from a perceptual standpoint, placing something in the
center deadens it. As we move the point of
interest away from the center, visual tension
increases.
Related to visual tension is lead room. As
we read an image, we work out scenarios that
Rule of thirds (above), versus golden section (below).

explain what is happening. If a person is facing right, that is generally interpreted as the
direction the person is heading. Directing the
model’s gaze in the same direction strengthens the sense of intent. If we place the model’s
nose against the right edge of the frame, it
will seem as if she or he has run out of room,
but if we place her or him on the left side of
the frame, not only is there tension, there is
lead room. The viewer looks for open space in
the direction that the character is expected to
move.
If we think of a photograph as a kind of dialog between the photographer and the viewer,
composition can be seen as a mechanism for
telling the viewer where to look. One of the
constant questions in the mind of the viewer
is “what is this picture about?” One way of
answering that question is by isolating the subject. Techniques such as controlling depth of
field, selective focus, and placing the focal point
of the image on one of the pressure points
direct the viewer’s attention and tell the viewer
what the image is about. Selective focus works,
because the eye gravitates toward the sharpest
part of the image.
Cropping after the fact is a way of rethinking compositional decisions that you made
when you shot the image. Think of cropping
as recomposing your image. It’s really restating
the visual problem you’re setting out to solve.
Too often, it is done to eliminate a problematic
element from the frame. That is cropping for
the wrong reasons. Cropping done in this way
usually does not respect the proportions of the
image, and you end up with a composition that
lacks integrity.
If you must crop, it’s best to perform your
crop in Camera RAW, because the crop does 95
not throw away any of your original image data.
This is especially useful for JPEG and TIFF
files, which you can open in Camera RAW.

TOP: Visual tension was created by moving the subject to the right,
though the figure still connects with the center line. Directing her
gaze to the right suggests something outside the frame. If her body
were facing that way, she would appear to be out of lead room.
Reproduced by permission of Saddi Khali.
BOTTOM: Selective focus and a pool of light emphasize the knee
bandage over the figure. Photo by Louis Benjamin.
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TOP: Framing proportions can have a profound effect on
composition.
BOTTOM: Moving in close omits contextual cues. Often the viewer
has to read the image carefully to resolve what is being depicted.
The result is often a compelling abstraction. Photo by Louis
Benjamin.

AÂ€good approach is to crop in a way that maintains the proportions of the original image. If
you want to crop to a different shape, consider
using one of the standard proportions, such
as 1:1, 4:5, 5:7, or something cinematic, like
2.2:1. If you crop arbitrarily, you will probably
find that it is harder to get groups of photos
to go well together when you exhibit them. It
will certainly make mounting and framing your
prints more problematic.
Framing can have a profound effect on
how the viewer relates to the nude figure. The
body’s relationship to the space imposed by the
frame is often critical to how the overall image
works.
When the full body is shown, we often
relate to the image as a complete person, not
anÂ€ abstract body. If the face is visible, that
aspect is even stronger. It is challenging to create a sense of intimacy with a full-body view. In
most cases, that framing puts the viewer in the
position of the detached observer. If there is a
lot of space around the figure, the body can be
read symbolically, and the image often takes on
overtones about the relationship of humanity
to the larger environment.
Closeness can be read as either intimacy or
abstraction, depending on how close the framing is and whether the face appears or not.
IfÂ€the model’s face is not visible, the shot will
tend more toward the abstract or the erotic.
Posing, expression, and use of lighting further
help to establish the tenor that framing creates
97
a context for.
If you are interested in creating intimacy,
an eye-level angle or slightly below is a very
powerful way of inviting the viewer to relate

to the person in the photo and creating a
sense of involvement. Many classic intimate
portraits have been shot with the lens positioned somewhere between the eyes and the
solar plexus.
Cutting the top of the head with the frame
can accentuate the emotional dimension of an
image, especially if the sitter fills most of the
frame. It imposes a view that is akin to looking
the sitter in the eye. Viewers with more formal
sensibilities are likely to object, but having parts
of the sitter’s body extend beyond the boundaries of the box can also emphasize the imposition of the frame itself.
“Amputations” are a special case. Sometimes, a hand, foot, or some other part of the
body collides with the frame so that just a part
of the extremity is cut. Such framing usually
looks like a painful amputation and is distracting. The viewer’s attention is focused upon the
missing body part, instead of whatever else you
are Â�hoping to put across. Such unfortunate
framing can be avoided by intentionally running your eye around the edge of the viewfinder
before you trip the shutter.
When we view the subject from a high
angle, it often comes across as victimizing,
especially if the model is a woman in a prone
position. However, as you elevate the camera,
the viewer’s perspective becomes increasingly
detached. If you elevate the camera enough, the
shot becomes the omniscient bird’s-eye view of
cinema and graphic novels.
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as “portrait,” and when it is wider than it is tall
(horizontal), we refer to that as “landscape.”
Our natural perceptual field of view is landscape, and so it should be of little surprise that
cameras create landscape images in their normal orientation. You have to consciously rotate
the camera, often jutting your elbow into space,
to shoot in portrait, but the two orientations
tell different stories.
There are also practical aspects to shooting
in portrait versus landscape: if your work is to
be published in a magazine, the orientations of
the pages are typically vertical. Portrait images
are optimal for magazine pages, and landscape
pictures either have to be run in reduced size,
or run as a spread across the pages. When that
Â�happens, the “gutter” often cuts through the
middle of the picture and disrupts or obscures
valuable details. Both the Nikon D3 and Canon
1D series cameras have an integrated vertical
grip, which places a second set of controls on the
camera body so that you don’t have to stick your
elbow out and reach across the camera when
you shoot verticals. Many mid-range cameras
have an optional “battery grip” that attaches to
the bottom of the camera and provides similar functionality. This is more than just convenience. Keeping your elbow down gives you a
more stable shooting posture.

When you are shooting from a low angle,
the model moves by degrees from being heroic,
to menacing, to dominating. At some point, you
get a worm’s-eye view, which is again detached
and omniscient.

If your intent is about the person, rotating to
portrait and framing with the pressure points
in mind can create a powerful portrait that isolates the sitter from the environment and hints
about their “inner landscape.” If the subject is
standing, you can pull back to shoot the full
body in portrait. The body will fill much of the
frame, and even though the shot includes the
environment, the emphasis tends to stay with
the figure.

Finally, we come to the question of how the
rectangular frame is oriented. When the frame
is taller than it is wide (vertical), we refer to that

With landscape framing, there is the issue
of all that field of view to the left and the right.
Head and shoulders views can fill the frame
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Careful Â�asymmetrical framing,
Â�perspective lines, and dramatic tonal
contrast add to the mix with bird’s-eye
perspective to make an eye-catching
image. Reproduced by permission of
Daniel Sikorskyi—chiaroscurist,
www.sikorskyi.ca.

nicely, especially if you are willing to cut the
top of the head. However, landscape generally
compels us to either shoot head and shoulders,
pushing the subject to one side or another, or to
pull way back and place the figure in a tableau.
In landscape, the environment naturally dominates the full-body figure.
Particularly when framing in portrait, photographers often intentionally tilt the camera,

causing the subject to lean across the frame.
ThisÂ€ tilt can add a lot of visual energy to
the shot, but can also come across as a gimmick. Formalism often dictates that the horizonÂ€ should be perfectly horizontal across the
picture plane, but you do not have to slavishly
99
comply with this dictum. An interesting issue
of framing comes up when shooting with a
wide-angle lens, particularly if you are tilting

the lens upward or downward. In that case,
“verticals” in the shot will normally be tilting,
and the horizon may even look skewed. A great
way to deal with this circumstance is to find a
vertical at camera left and close to the model,
then align that so that it parallels the left side of
the frame. The other “verticals” are less critical.
If there is no such vertical in the shot, figure
out where the dominant vertical should be, and
make sure it’s vertical.
A Closer Look Inside the
Frame

The emphasis of the early part of this chapter
was from the perspective of imposing the photographic frame on the scene. The remainder of
the chapter will shift the emphasis and look at
additional ways to think about what happens
inside the frame.
In a word, simplify. That is an important,
and often challenging, mantra. Be clear about
what your image is about, and try to distill your
compositions down to the elements that express
that. Some models react negatively to a seamless background because of the way it functions.
It is a powerful simplification tool that creates
a quiet, relatively unobtrusive background and
focuses attention on the model.
Graphic designers often speak in terms of
negative space. This is a way of thinking about
the visual problem from the standpoint of shaping the space that surrounds the figure, rather
than the figure itself. Emphasizing the negative
space can create powerful sculptural effects, or
enhance the abstract qualities of an image.
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When the model places her hand on her
hip and pushes her elbow away from her body
to create a diamond-shaped space between her
torso and her arm, we are dealing with a specific
type of negative space, namely, trapped space.
Windows, doors, and mirrors in a shot can
all have the effect of creating a frame within the
frame. A framing element does not have to be a
C H 6 â•… C o m p o s i t i o n

literal frame. It can have as few as two sides and
consist of a striking color, texture, or shape. Portrait photographers often project a circular or
oval pool of light onto the background behind
the sitter to create a framing element. The frame
within a frame can be a powerful compositional
element, because it doubly focuses attention on
the subject. For fashion, portrait, and glamour
photos, models often create a framing effect by
surrounding their faces with their arms. The
mirror is especially interesting when used as a
frame, because it can show two perspectives on
the same scene, perspectives that can even seem
to disagree. When shot so that you cannot see
the mirror’s frame, mirrors can be particularly
disorienting.
Any pronounced line in a photo, such as the
edge of an object, will lead the eyes somewhere.
The trapped space in this image mimics the shape of the breasts.
Â�Multiple diagonals add energy to the composition. Photo by Louis
Benjamin.
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TOP: In this layered image, the concrete cylinder creates a frame
in frame effect for the figure. The earthen shapes beneath it and
to the right of the cylinder frame it in turn. Finally, the concrete
wall in the background reinforces the figure, and the Â�sloping roof
lines direct the eye to the framed body. Photo by Â�Richard Rasner
(Unique Nudes) of Nakayama Studios.
BOTTOM: The lines in this image add a sense of movement while
seeming to divide the frame into puzzle-like segments. Photo by
Louis Benjamin.

When used strategically in a composition, we
refer to them as leading lines. Leading lines
often direct the viewer’s attention to the sitter, but they can also help to describe the space
around the sitter. For example, a model sitting
on a road can be shot so that the sides of the
road act as leading lines that emphasize a vanishing point. Our eyes are particularly attuned
to finding lines, especially verticals, horizontals,
and diagonals. The key thing to watch out for is
101
that you don’t capture or emphasize lines that
lead the eye completely out of the frame.
Sloping, curved, and bent lines are particularly good for adding a sense of energy and

TOP: The limbs and extremities imply lines that can create visual
rhythms. The linear qualities of the limbs are emphasized here with
asymmetrical rim lighting. The shadows indicate thatÂ€the light on the
left is stronger
Â�
than the light on the right. Photo by Louis Benjamin.
BOTTOM: The composition here is based on a strong diagonal
that flirts with the frame’s built-in diagonal. The model’s head and
arms interact strongly with the edge and upper corner of the frame.
Photo by Louis Benjamin.

motion to an image. André Kertész produced
a dramatic series of distorted nudes, photographed with the aid of a funhouse mirror.
These images make lyrical use of curved lines.
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The nude offers many compositional opportunities to isolate and emphasize curved elements of the body. Gentle curves can have a
particularly sensual quality. S-curves, Z-curves,
and zigzag lines inject increasingly more energy
and edginess into your image.
The linea alba, which literally means “white
line,” is a visible structure that runs down the
center of the abdomen between the solar plexus
and the top of the pelvis. Art students use it as
C H 6 â•… C o m p o s i t i o n
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TOP: The folded figure creates a family of curved lines that gives a
swirling spiral effect. Photo by Louis Benjamin.
BOTTOM: The model’s hair suggests a gentle reverse-S curve,
which interacts with the curve of the yellow seat. Photo by Louis
Benjamin.

a key reference point in learning to draw, and it
can be a powerful focus in photographic compositions. Posing and lighting your model in a
way that emphasizes the linea alba can produce
lyrical and sculptural results.
Your compositions can also be made up of
implied lines, such as the line that connects
the pupils, the line that connects the nipples,
and the vertical from the forehead to the chin.
Objects inside the frame can function as anchor
points for imaginary lines that provide structure to the image and keep circulating the eye
inside the frame.
Triangles, diamonds, circles, and squares are
all primitive, flat shapes that our eyes are particularly attuned to find. Many Renaissance paintings were composed on the basis of triangles.
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TOP: Overlapping zigzag lines are the primary impression of this
strongly chiaroscuro image. Photo by Louis Benjamin.
BOTTOM: Hard light coming from the 2 PM sun casts a shadow that
suggest an angel’s wing and outlines the linea alba, running between
the model’s navel and solar plexus. Photo by Louis Benjamin.

These shapes do not have to literally appear in
the image, but can be implied. For example,
Weston’s famous Nude, 1936, strongly suggests
a triangle connecting the top of Charis’ head to
each of her feet. Part of what makes that triangle more interesting is that none of its sides
parallels any edge of the frame. The triangle is
also not equilateral.
Spatial dividers are lines that separate a
Â�picture into two parts. The division can be foreground/background, right/left, above/below,
orÂ€ anything else. A doorway is an obvious
example (inside/outside), but the water line of
a stream also functions as a spatial divider. A
shadow can work in this way, too.
In a photo, 3-D form is, of course, an illusion, but it can be an important pictorial element. Form is revealed by shadow, and the
deeper the shadow, the greater the depth of the
image. Flat, soft lighting reduces the sense of
form, while higher contrast, edge-wise lighting
brings out the sculptural form. Texture is really
a special case of form. It is three-dimensional,
and is brought out strongly by hard side lighting. Sculpture and texture are both powerful,
and often sensual, compositional elements.
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Patterns are about repetition, and work a bit
like texture. Lighting effects like louver slats
and dappled light are examples of patterns, but
artists such as Spencer Tunick are able to make
patterns out of whole bodies. Using shallow
depth of field, backgrounds can be reduced to
patterns of repeating soft forms.
Patterns are generally perceived on the basis
of similar shapes, but the shaped elements in
a pattern do not have to be the same size. For
example, a vanishing-point perspective shot of a
C H 6 â•… C o m p o s i t i o n
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TOP: Photo by Louis Benjamin.
BOTTOM: An image that relies heavily on shape and color. The
trapped spaces all approximate triangles. The model interacts with
the yellow sphere and the frame. The sphere and the background
are complementary colors. The soft lighting emphasizes the threedimensional form of the figure and the sphere. Photo by Louis
Benjamin.

stone path shows the pattern of stepping stones in
decreasing size. An interesting set of size relationships to be aware of is the Fibonacci (pronounced
fib-uh-nah-chee) sequence. It is a pattern that
can be seen in natural structures such as the
inside of a sunflower, the spiral of shells, and
theÂ€branching of trees, and it can be applied to
the graphic design of a photograph. This principle probably has greater application in manipulated images than in directly shot situations.
The first part of the Fibonacci sequence is 0,
1, 1, 2, 3, 5, 8, 13. You can find the next number in
the sequence by adding the previous two numbers together (e.g., 13 + 8 = 21, then 21 + 13 =
34, etc.). The sequence is employed throughout
architecture and manufacturing. For example,
the sizes of 3 × 5 and 5 × 8 index cards are an
expression of Fibonacci proportions.
Using Fibonacci in a composition could
involve scaling the proportions of shapes
according to the sequence, or dividing the space
into appropriately scaled sections. A simplistic
example of how this might work is to create a
composite, showing the body in different scales
within the frame. You could pick any dimensions as your reference scale, then distribute
figures that are twice, three times, five times,
and eight times that size around the frame.
An image can often benefit from balance,
which is perceived primarily along the horizontal axis and can be achieved in a number
of ways. Symmetrical balance is the easiest
to understand and the most straightforward. 105
With symmetry, the elements being balanced
are equally distributed on either side of the vertical centerline of the picture. It’s no muss, no
fuss, and too often it can be boring.

TOP: An office chair creates a diagonal spatial divider with curved
overtones. The perforated back spills dappled light onto the skin.
Photo by Louis Benjamin.
BOTTOM: Related elements in the frames create a pattern effect
reminiscent of cubism. Reproduced by permission of Gaspar
Marquez.

Earlier, we talked about creating tension in
an image by pulling the sitter off the centerline.
As you pull the sitter farther from the center, the
composition becomes increasingly asymmetrical, and yet many of the most effective of such
images will still be balanced. There are no hard
and fast rules to define how to achieve asymmetric balance, but balance works on the basis
of visual weight. The trick in creating this type
of balance is in learning how to read the relative weight of the elements you are framing.
A small object with a lot of visual weight
can balance a large object that is not as visually dense. Visual weight is often determined by
color or complexity. Mondrian was a master at
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TOP: The centerline is strongly indicated in this image that
Â�demonstrates asymmetrical balance. Reproduced by permission
of Saddi Khali.
BOTTOM: Photo by Louis Benjamin.

balancing images based on the relative weights
of the colors that he used in his compositions.
Another balancing strategy is to think in
terms of a lever. If you think of the centerline
of your image as the fulcrum, and you place the
sitter slightly left of center, a smaller object,
such as a pillow, placed to the extreme right
will balance the image. Asymmetric balance is
something that is done by feel, and once you
get it, you will find it relatively easy to do.
Color is one of the most powerful and confounding elements that you can work with in
your compositions. Color in photography is
relatively “new school” and was not taken seriously in art circles until the late 1970s, when
artists such as William Eggleston emerged.
We are speaking here of the creative uses of
color, which sometimes means manipulating
colors in ways that no photojournalist would.
Some photographers have completely avoided
color and work purely in black and white,
because color can easily overpower an image.
While we have indicated elsewhere that some
images really do work best in black and white,
there are a number of ways to make the color
of a straight “capture” work better, rather than
stripping it of its color.
Monochromatic doesn’t have to mean black
and white. Toning or split toning a black-andwhite image can add an emotional dimension
and richness to an image. Toning was a technique
that was popular among the Surrealists and the
Photo Secessionists. With split toning, generally
the highlights are given one color tone, and a 107
complementary tone is applied to the shadows.
In Camera RAW, you can use the HSL/Grayscale tab to convert to black and white, and then
use the Split Toning tab to create the effect.

TOP: An analogous color scheme, selective
Â�
desaturation,
and motion blur combine to create a dreamlike composition.
Â�Reproduced by permission of Terry Donovan.
BOTTOM: The Split Toning controls in Adobe Camera RAW allow
you to assign different hues to the highlights and shadows of
your image. You can also control the saturation of those hues and
where the crossover between shadow and highlight happens. The
example above assigns a warm tone to the shadows and a cool
tone to the skin. Photo by Louis Benjamin.

In comparing digital and analog photography, one observation that many photographers
have made is that digital color is often much
more saturated than film-based work. This may
be due in part to the nature of color capture
in digital in the first place, but the differences
are often unwittingly amplified further in postproduction. As one adjusts the Â�tonality of an
image with curves or levels in Â�Photoshop, the
saturation often increases. The hue/saturation
adjustment can help you to create a more
restrained color palette. Some photographers
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only decrease the saturation enough to compensate for any changes induced by tonal
adjustments, while others seek a more desaturated look, reminiscent of the work produced
by German photographers in recent years.
A different color strategy is to intentionally
induce a color cast. Many Photoshop students
are taught to remove color casts, but those casts
are generally accidental casts created either by
camera errors or lighting problems, and are
often aesthetically unpleasant. Inducing a color
cast is equivalent to what some painters do by
putting a colored glaze over a painting: it unifies the color palette. One way to do this is by
intentionally assigning a white balance in Camera RAW that drives the color toward either
amber or blue, as we’ve seen elsewhere. Other

techniques include either applying a photo filter
adjustment layer or using the colorize effect in a
hue/saturation adjustment layer.
Up to this point, we have talked in terms of
making pictures that use a limited color palette.
Other color strategies involve being aware of
opposing, or “complementary,” colors. Opposing
colors are the basis of color contrast, and opposing colors are set out for us on the color wheel.
However, there is a problem—there are several
color wheels, and they don’t match up. The different color wheels arise from different ways of
looking at color, whether it’s mixing light, mixing pigment, or working with perception. For
our purposes, the main concerns are the RGB
color wheel that we use in Photoshop and the
RYB color wheel that is taught in art classes.

The Two Color Wheels The RGB color

and developed theories on the psychology of

wheel is based on mixing prismatic light. It is

color. Chevreul was a French chemist who was

the cleanest, most mathematically consistent

interested in solving problems related to dye-

color model, and it is an additive color model.

ing fabric. In his research, he realized that when

You can mix R, G, and B to get any color, even if

colors are placed next to each other, they have

you can’t find a monitor capable of displaying

a reaction that has nothing to do with the pig-

it. The RYB color wheel, sometimes known as

ments interacting chemically. From that real-

the psychological color wheel, is based upon

ization, he set off to study the phenomena in a

mixing pigments, and is a subtractive color

scientific way. His observations in The Law of

model. An important practical implication of

Simultaneous Color Contrast, first published

mixing pigments is that the resultant color is

in 1839, influenced the Impressionists, Seurat,

always darker than the two colors it was mixed

and Delacroix.

from, which means that certain colors cannot
be achieved by mixing pigment colors.

The preceding information implies that for
practical purposes, much of our work needs

RYB has its origin in the work of JohannÂ€Wolf-

to be based in the RGB color wheel, but that

gang von Goethe and Michel-Â�Eugène Chevreul

for artistic purposes, learning to exploit the

(1786–1889). In Chapter 5, we touched upon

RYB color wheel will provide opportunities to

the work of Goethe, who made important

work more effectively within the psychologi-

observations about how people perceive color

cal dimensions of color.
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Opposing Colors on the RGB and RYB Color Wheels
	RGB Opposing Colors	RYB Opposing Colors
Red: Cyan
Red: Green
Green: Magenta
Yellow: Violet
Blue: Yellow
Blue: Orange

Your compositions can be based on color
contrasts and color harmonies, and there are
essentially three types of color contrast. The first
is a nonspecific warm/cool contrast. Warm colors are on the redder end of the spectrum, and
cool colors tend toward blue or blue-green.

A Â�sophisticated approach to saturation Â�contrast.
Reproduced by permission of Nina Pak.
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The second type of color contrast is a harmonic scheme based upon opposing hues on
the color wheel of your choice. Simple color
harmonies are based on opposing pairs of colors such as orange and blue, but color harmonies based on different triads of colors are also
possible.
A third type of color contrast opposes saturated and desaturated color. A near-cliché
example of this is the effect of showing a blackand-white figure holding a bright red apple.

C H A P T E R  S I X   |    A C l o s e r  L o o k I n s i d e t h e F r a m e

Color harmony is a very large territory to
explore. If this is of interest to you, there are
dozens of books that elaborate on approaches
to color harmony.

the hue a tiny bit, or change it altogether, and
you can increase or decrease the saturation. The
adjustment can be further constrained by using
the adjustment layer’s mask.

In some cases, you may encounter a photo
where most of the colors work, but one particular
color is a problem. It may be a pool of light that
has too much or too little color, or maybe there
is a red jacket that has a bit too much orange in
it. You can target these specific Â�colors in Photoshop and change them with a hue/saturation
adjustment. As the name suggests, you can shift

We come full circle to simplification. Just as
the visual layout of your image can benefit from
simplification, the color palette of your image
can be simplified. If you look critically at the
colors in your photo and see that one doesn’t fit
with the dominant colors, you can target that
color and shift it to a more harmonious hue or
reduce its saturation to make it less obvious.
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The Camera Is
Not an Eye
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“The camera is something of a nuisance in a way. It’s Â�recalcitrant.
It’s determined to do one thing, and you may want to do something else. You have to fuse what you want and what the camera wants.”
—Diane Arbus

T

he camera has often been viewed as a stand-in for the
human eye. It has also been held out as a validation of
single-point perspective. Neither view is really accurate,
but it’s instructive to think about these factoids, because it
opens the door to a more artistic relationship with the camera.
The camera’s dynamic range is more limited than that of the
eye, and unlike the eye, most lenses are sharp across the entire
image plane. Those are just some initial differences. A lot of
discussion about creative image production revolves around
Photoshop and post-production, but there is much that can
and probably should be done in-camera.

7
OPPOSITE PAGE: This layered image was produced in-camera with a projector. Reproduced by permission of
JD Yezierski.

A key element of many artistic photographs
is a sense of atmosphere and mood. While light
and color often has a lot to do with that, the
contrast, sharpness, or softness of the image can
be key factors, too. Those factors are all products
of the lens. The lens also affects the rendering of
space, essentially folding or bending space onto
the picture plane in different ways.
Shoot Like a Pictorialist

A big reason for the popularity of the 35mm
format, which ultimately gave rise to DSLRs,
was the development of extremely sharp lenses,
but for some artistic approaches, a concern with
sharpness is anathema.
Around the beginning of the twentieth century, the Photo-Secessionists took up the cause
of Pictorialism, which aimed to make photoÂ�
graphy emulate painting and etching, two dominant forms of art that had legitimacy at the
Reproduced by permission of Alfred Laij.
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time. Many of the techniques of Â�Pictorialism
involve darkroom work, but soft focus, effects
filters, and lens coatings were popular in-Â�camera
techniques.
Many effects approximating Pictorialist
work can be accomplished by placing an inexpensive UV or skylight filter over your lens and
applying clear nail polish to it. Once the nail
polish is hardened, you can scratch it to modify
the effect. To reuse the filter, be sure to take
it off your lens first, and clean with nail polish remover or acetone. Another technique is
to spray a fine mist of hairspray up into the air,
and wave a skylight filter under the mist until
you’ve built up the right thickness. The hairspray washes off with warm water.
You may have heard that cinematographers
smeared Vaseline over their lenses (skylight filters) to get a soft focus effect. Vaseline works,
but believe it or not, K-Y Jelly works better, and
it’s easier to remove. You can try applying it

C H A P T E R  S E V E N    |    S h o o t  L i k e a P i c t o r i a l i s t
TOP: Reproduced by permission of Alfred Laij.
BOTTOM: Genie. Photo by Richard Rasner (Unique Nudes) of
Nakayama Studios.

around the edge of the filter, leaving the center
clear, or you can spread it more evenly and then
smudge it with your thumb. Another way to
alter your camera’s vision is to attach a skylight
filter and stretch a translucent material such as
pantyhose or tulle over the lens. This is purely
improvisational, and anything goes.
Smoke creates a layered atmospheric effect
that can reveal the shape of light beams and
functions something like a variable filter. It is
heavily used in cinema, and also in fashion photography. It is almost invisible when lit from
the front, but shows up clearly when lit from
the side or behind. Beyond the more obvious
applications, it can be used in subtle ways.

Bokeh We refer to the quality of the part
of the image that is out of focus as the
bokeh, or boke (pronounced “boke-uh”),
an obscure term that apparently originated in Japan. Lenses render images by
creating thousands of tiny circles, and
these circles become more apparent in
the part of the image that is out of focus.
With bad bokeh, these circles have hard
edges, or worse, edges that are brighter
than the center. The look of bad bokeh
creates distracting highlights that can
undermine the image. With good bokeh,
the circles are soft-edged. This characteristic actually has to be designed into
the lenses, and certain lenses have a
reputation for either good or bad bokeh.
Interestingly, Nikon makes a range of
lenses with “defocus control,” designed
to let you vary the bokeh.
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TOP: Reproduced by permission of Alfred Laij.
BOTTOM: Shot with the Lensbaby Composer double-glass optic at
f/2 (wide open). Photo by Louis Benjamin.

Selective Focus

Selective focus is a variation of soft focus. One
type of selective focus can be achieved by creating a very shallow depth of field, using a fast
lens with the aperture opened wide (e.g., an
85mm lens at f/1, f/1.4, or f1.8). An example
of an image using this technique might be a
person holding their hands out, with the hands
in sharp focus while the body is blurry. In that
case the selective focus is based on foreground
vs. background.
Lensbabies

A different type of selective focus happens when
you have an island of sharp focus in the image,
and everything around it is defocused. That is
a bit more like the way we actually see, in that
we have foveal and peripheral vision. Foveal
vision is sharp, and peripheral vision is much
softer. The two work a bit like picture in picture,
and our attention can be focused on one or the
other, but most of the time we’re seeing both.
The Lensbaby Composer was introduced
in 2008, and it offers a complete, easy-to-use
selective focus system based on the idea of tilting the lens, a technique that has essentially
been available only through the use of expensive
precision bellows attachments. The manualÂ�focus Lensbaby is available in both Canon and
Nikon mount, and consists of a lens barrel that
holds interchangeable optics, fitted into a ball
and socket joint. The lens barrel has a knurled
focusing ring, and there is a locking dial for the
ball and socket joint.
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Each optic produces a central sweet spot
of sharp focus surrounded by a field of bokeh
that gradually gets softer as you move toward
the edge of the frame. You can move the sweet
spot around the frame by applying tilt. To do
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TOP: The Lensbaby plastic optic at f/8. Photo by Louis Benjamin.
BOTTOM: The plastic optic at f/2 produces a much more
Â�atmospheric effect. Photo by Louis Benjamin.

so, you loosen the locking dial on the ball joint
and push the barrel in any direction. The locking dial can also be set to a gentle friction that
holds the barrel where you put it, but allows you
to reposition it without having to constantly
lock and unlock the ball.
The interchangeable optics have a focal
length of 50mm and include double glass, single glass, plastic, and pinhole/zone plate. The
out-of-focus area of each of the optics has very
different characteristics, which impart very different moods or attitudes. The pinhole/zone
plate optic produces a very striking look, but it
is literally an open hole into the camera body,
and that raises some concern about introducing
dust into the camera.
The sharpness of the optics also increases as
you make the aperture smaller. You control the
aperture by placing little numbered rings into a
recess at the front of the optic, using a magnetic
wand. The rings are held in place by magnetic
levitation. The approach works and keeps the
engineering of the lens simple, but there is a
risk of losing aperture rings. You should probably plan on replacing them from time to time.
The lens requires you to practice your manual
focusing skills, but remember, only the sweet spot
gets completely sharp, and the nature of the lens
means that focusing is a bit more forgiving.
On some cameras, attaching the Composer
switches off the metering system altogether,
butÂ€on cameras such as the Nikon D200, D300,
and D700 the metering works, and switches
into a mode that indicates that only the shutter
speed is under your control.
The Lensbaby system has several conversion
lenses that screw onto the front of the basic
50mm optic. An available macro kit has +4
and +10 filters that can be used together, and
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a wide-angle/telephoto kit comes with a 0.6×
wide-angle lens and a 1.6× telephoto lens.
More on Lenses

In the 35mm film world, lenses with a focal
length around 50mm are called “normal” lenses,
because their spatial perspective best matches
“normal” vision. Lenses in the 28mm to 35mm
range are typically thought of as wide-angle
lenses, and wider lenses, such as 12mm, are
described as “fish-eye” lenses. As the lens gets
wider, you will notice that objects that appear
straight to the eye begin to appear curved in a
wide-angle photo, and the wider the lens, the
greater the curvature.
Foreshortening is also emphasized in wideangle images, meaning that objects in the
Â�foreground appear exceptionally large, and
objects in the background appear exceptionally
small. If you take a picture of someone’s face
with a wide-angle lens, their nose is likely to
dominate the frame, and their ears might look
minuscule. Tilting a wide-angle lens also exaggerates the proportions of people and things.

TOP: Captured with a 12–24mm
Â�wide-angle zoom at 13mm on a Nikon
D100. The focal length is equivalent to
a 19mm lens on a full-frame camera.
Photo by Louis Benjamin.
BOTTOM: Shot with a 28–105mm
zoom at 62mm Â�(equivalent to 92mm)
at f/4.3. Photo by Louis Benjamin.
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Lenses with focal lengths of 80mm and
above are considered telephoto lenses. These
lenses compress space, and the effect of foreshortening is minimized. Lenses in the range
of 85mm to 150mm are particularly popular for
portraiture, because they can bring you in close
to the face, without distorting it.
That brings us to the “speed” of the lens.
“Fast” lenses are lenses with a low-numbered
maximum aperture, such as f/1.4 or f/1.8.
Canon once marketed a 50mm f/1.0 lens, and
Stanley Kubrick had a 50mm f/0.7 lens fitted
to a movie camera for the making of “Barry
Lyndon.” In the case of “Lyndon,” the fast lens
allowed Kubrick to shoot scenes that were literally candle-lit. To make a lens fast requires
larger, heavier optics, and consequently, such
lenses can be much more expensive.

Dragging the shutter emphasizes the difference
Â�
between what is
moving and what is stationary. Photo by Louis Benjamin.

Lenses have a “sweet spot.” Even if we have
a lens that can open all the way to f/1.0, its performance may be slightly degraded when it is
“wide open,” and lenses often show degradation when they are “stopped down” all the way,
as well. The sweet spot is the range of apertures
between the extremes, where the optical performance of the lens is at its peak.
In normal and telephoto lenses, aperture
strongly affects depth of field, while with wideangle lenses, the effect is far less pronounced.
Depth of field describes the parts of the image
that are in focus, relative to the parts that are
out of focus. The longer (higher focal length)
the lens, the more pronounced the effect. With
a shallow depth of field, the sitter’s eyes could
be tack-sharp, while his or her ears are “soft.”
In the 1970s and 1980s, advances in lens
design made the zoom lens standard fare for
35mm cameras, and today, the “kit lenses” sold
with most cameras are zooms. While zoom
lenses are convenient, single focal length “prime”
lenses are much lighter and cheaper.
Sharpness is another reason to like prime
lenses. Even with the sharpest zoom lenses, a
quality prime lens at the same focal length will
be sharper and substantially cheaper. If that
hasn’t piqued your interest enough, prime lenses
can typically be made much faster than zooms
at a fraction of the weight. If you’re interested
in handheld low-light photography, switching
to a prime lens will allow you to make images
that are far sharper, with dramatically less camera shake. For example, a number of Nikon
prime lenses, including a 50mm f/1.4 and an
85mm f/1.8, can easily be purchased new for
under $500, while an 80–200 f/2.8 zoom costs
nearly twice as much.
It’s often still a good idea to have a zoom lens
in your arsenal. Something to be aware of is that
some zooms lose as much as two stops over the
range of the zoom. As the lens stops down, the
shutter speed has to decrease to compensate.
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Dragging the Shutter

Dragging the shutter is the term used for working with low shutter speeds, primarily to take
advantage of motion blur. You can place the
camera on a tripod and have the subject move,
you can have the subject sit still and move the
camera, or you can move both subject and camera. You can even do drag shutter work Â�outside
in strong sunlight. To make the sunlight dim,
place one or more neutral density filters over
the lens. Combining drag shutter effects
with selective focus has the potential to create some extremely compelling images. Many
early street photographs show what appear to
be empty streets. The sensitivity of early film
required such long exposures that only objects
that remained completely stationary registered
an image.
Often, high-contrast light will make drag
shutter results more interesting. If you mix
ambient light and flash, and have the subject
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move, the flash will freeze the subject and the
ambient light will record a ghost trail.
Light Painting

Light painting is an interesting application of
dragging the shutter. It works best if you black
out the windows, place the camera on a tripod,
and pre-focus the camera. Set the exposure
to 30 seconds, and when you trip the shutter,
begin to move the flashlight around to illuminate your subject from different directions.
Be careful about standing too long in one
place, or you may be recorded in the image. If
you let the light stay for a while in one place,
you’ll get a hot spot. Diffusion material and
colored gels can also be used to modify the
look and output of your flashlight. You can also
use cardboard or Cinefoil to make a snoot that
keeps the flashlight beam narrow. The light
Light painting can have the look of conventional
Â�
lighting, or the
light source can be made very obvious. Photo by Louis Benjamin.
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source can be shaded to prevent light trails from
showing up in the image, or you can intentionally allow the flashlight to register, and even
point it directly at the camera.
You can have your sitter hold still for part of
the time, then quickly change position and hold
again, to create images that look like step-wise
superimpositions. Alternately, you can have the
model move slowly and constantly for a different effect. Turning the light on and off during
the process can allow your subject to change
position without registering a motion trail.
The results of this technique are extremely
variable. To succeed with it requires a willingness
to give up control to some degree, and experiment. Even successful results are hard to duplicate, a process that is artistic at its very heart.

Reproduced by permission of JD Yezierski.

Projections

A projected image can be used to create layered
images in-camera. More than one projector can
be used, and the resulting image can be a challenging visual puzzle. The relatively dim light
of the projector opens the possibility of having
the subject move, adding a layer of movement.
Your Choice of Weapon

Depending on the kind of work you intend
to produce, your choice of camera can be very
important. The ease of use and responsiveness
of the camera affect the flow of the shoot and
even the images that you are able to produce.
Infrared film radically changes the way the
camera sees, and offers rich aesthetic opportunities. There are a few digital alternatives. Techniques in Photoshop, mainly centered around
emphasizing the red channel content over others, attempt to emulate the look of infrared,
but they are not the same thing. Fuji makes the
FinePix IS-1 (www.fujifilmusa.com), a ninemegapixel digital camera designed specifically
for IR photography. Its target market is law
enforcement, but it certainly has artistic applications. Other ways of doing digital IR involve
either adding filters that make the viewfinder
useless and require tediously long exposures, or
modifying your camera for dedicated use. (See
www.wrotniak.net/photo/infrared/.)
When your sitter is aware that you’re using
a special camera, they’re likely to relate to you
in a different way, and that will come across in
your photos. Timothy Greenfield-Sanders, who
did the book XXX: 30 Porn Star Portraits, uses
a vintage 8 × 10 Deardorf view camera. The
antique-looking plain wooden box with a lens
in the front and a bulb shutter release is a very
different animal from the present-day DSLR
that most sitters are used to.
Many photographers have said that they
chose large-format cameras because it forces
them to slow down their process. The nature
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and expense of operation of those cameras
demanded a careful, thoughtful approach. The
long exposures needed when the early photographs were made also affected the behavior of
the sitters: photographers would tell the sitters
not to smile, because it made them look like
corpses, and of course they had to sit very still.
Stephen Shore continues to apply the lessons
he learned over his years of shooting with an
8Â€× 10 camera to his work with a digital camera:
“I never bracket, and never take more than one
picture of the same thing,” he says (Image Makers/Image Takers, p. 51).
Employing an approach that is quite diffÂ�
erent from the likes of Shore, Leica shooter
Garry Winogrand typically shot three rolls of
Tri-X (at least 108 frames) every single day
(Modern Photography, 06/1988). It has been
widely reported that when he died in 1984, he
left 2500 rolls of undeveloped film, 6500 rolls of
processed film that he had not proofed, and 3000
rolls of contact sheets that he apparently had not
looked at. Part of the reason he could produce
so many images was the relatively economical
cost of 35mm film and the ease of operation of
the camera. It was also because his fundamental
process was about seeing in the edit, rather than
shooting with preconceived notions about the
images he wanted to make. He also knew the
workings of his camera extremely well.
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Luminous white skin and coal-black eyes were rendered with
Â�infrared film. © 2009 Harvey Stein.

and twin-lens reflex designs. Most think the
term SLR means a camera based on the 35mm
format, but it simply means single-lens reflex.

The advent of the Leica transformed photojournalism because its exceptionally sharp
optics, small size, and nearly silent operation made it fast and unobtrusive. The M4
rangefinder camera was the camera of choice of
a legion of photojournalistic photographers. It
remains to be seen whether Leica’s M8 digital
camera will enjoy anything close to the popularity and cult status of the M4.

There are really two distinct SLR formats in
the digital world. Cameras like the Hasselblad
H3D, the Mamiya ZD, and the Sinar Hy6 are
all medium-format digital SLR cameras. Phase
One and Leaf also make digital backs that fit
onto cameras that were originally designed to
shoot medium-format film, and in recent years,
they have entered into partnerships to build
new camera bodies.

The digital SLR is very popular in today’s
market, in part because the SLR format doesn’t
have the potential problems of parallax that are
inherent in rangefinder (e.g., Leica M series)

The excitement over medium-format digital has some technical merit as well as psychological weight, but it comes at a price: these
cameras can cost anywhere from $20,000
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to $44,000 with just one lens. These cameras
derive most of the technical benefits from their
larger sensors, which exhibit better shadow
detail because of larger pixels in the sensor. The
cameras also capture true 16-bit color, while
35mm-style DSLRs like the Canon 1D series
and the Nikon D3x have 14-bit color. The extra
two bits of color depth are marginal relative
to the jump between 8-bit and 14-bit, but the
psychological benefit cannot be understated.
When you’re using a special camera, that affects
your attitude, which in turn affects the sitter.
Digital cameras based on the 35mm format
have really split into two categories at this point.
Canon and Nikon both offer several models
with “full-frame” or “FX format” sensors. The
full-frame sensors are about the size of a full
35mm film frame, while earlier cameras are
based on sensors that are at least 1/3 smaller.
As we saw with the even larger sensors found
in the medium-format cameras, full-frame
sensors offer larger pixels with better shadow
detail than their smaller predecessors. They also
produce dramatically less digital noise at ISO
settings as high as 3200. This means that in low
light, they are capable of making noise-free
images at much higher shutter speeds. When
you consider that some of the low-end cameras
exhibit noise issues at ISO 800, that’s at least
three stops—which could mean the difference
between having to shoot at 1/15 second and
being able to shoot at 1/125.
The size of the sensor also has a cropping
effect on the image, which is where the focal
length multiplier comes from. On all Nikon
models, cameras with the smaller-format sensors are designated “DX” format, and the multiplier is 1.5. On Canons, the equivalent multiplier
is usually 1.6. On cameras equipped with an FX
sensor, there is no multiplier. That means that a
50mm lens on a DX camera is effectively 75mm,
and a 100mm lens is effectively 150mm.

The practical implication of this is that FX
cameras have complete optical parity with filmbased cameras, and can use any lens that was
designed for a film-based 35mm camera. There
are no special “digital” lenses for these cameras.
Lens manufacturers can design lenses for the
smaller DX sensor that project an image that
covers a smaller area on the film/sensor plane.
Such lenses can be made smaller, lighter, and
cheaper than the equivalent lenses designed for
use with an FX sensor or film. And since DX
lenses can’t cover the full area of an FX sensor, Nikon’s cameras automatically crop down
when you attach a DX lens to an FX camera. The issue is most acute with wide-angle
lenses, and most, if not all, DX-type lenses are
Â�wide-angle.
We’ve seen that for certain technical applications and ways of working, a specific type
of camera can make a huge difference, but for
the rest of us, the way you use the camera matters far more than what camera you use. While
high-end cameras will likely be of interest to
well-heeled hobbyists and photographers who
shoot both art and commercial campaigns, lots
of high-quality fine art work will continue to
be shot with cameras like the Canon Digital
Rebel XSi (450D) and the Nikon D60, which
both sell for well under $1000. Some artists are
even using cheaper, simpler, point-and-shoot
models very effectively.
One key to making better photos with
your camera is to learn the essential controls
so that it vanishes as much as possible. The
array of features can be overwhelming, so it’s
a good idea to prioritize the features of interest and learn how they work one at a time. If
you’ve always only used program mode, learn
to use manual mode. Play with over- and
underexposing images to understand how
the camera sees and how exposure relates to
expression.
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Working with Models
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Finding Models

F

inding a sitter is essentially a casting process. Even in
a Â�portrait, you’re telling a kind of story, and not everyone can express the qualities that you’re looking to show.
Thus, it helps to be clear about what you’re looking for, and
be selective. Some photographers prefer novices or amateurs,
because they haven’t developed ingrained habits and preconceived notions about how to model. Sometimes new models
can bring a little nervous energy to a shoot that can be good
for the images.

One of the simplest ways to find models is to join a networking
web site and build a profile with a portfolio of your images. Many
sites have a free membership option and make this easy to do. Sites
such as ModelMayhem.com, OneModelPlace.com, and Book.fr
are specific to modeling, while others such as deviantART.com are

8
OPPOSITE PAGE: “Working title: ‘After Rheims’ in honor of one of my favourite photographers.” Part of the “Most
Â�Beautiful Woman in Town” project, a collaboration with Justyna Neryng, 2007, UK. Reproduced by Â�permission of
Tobias Slater-Hunt.

broader, but still have an artistic focus. Sites
like Facebook and MySpace are broader still.
Finally, sites such as meetup.com have interest groups organized around activities like
photography or modeling. On Craigslist, you
can find listings by models who want to build
their portfolios, and you can place your own
listings. It is not uncommon for these listings
to include links to a portfolio page.
Whatever online presence you establish, you
will find that prospecting for people to work
with is not a passive process. No matter how
good your photos are, people are not likely to
just show up asking to be photographed, at least
not until you have a lot of friends and links to
lots of other profiles. It’s best to make a habit
of browsing the site from time to time to make
new contacts. Some sites allow you to search
for models within a certain number of miles,
and some allow you to search by criteria such as
models who pose for art nudes.
There is a certain etiquette to having an
online presence. If you see someone online that
you’re interested in working with, it’s helpful
to give some indication of what you like about
that person’s modeling. Most of the sites allow
you to leave public comments on the images
themselves. They also have some sort of private
message mechanism. Some have something
akin to the friends feature on MySpace. It’s a
good idea to post a comment or establish some
other communication with the model before
you send a friend request.
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What you see is not necessarily what you
get. Operating through the networking sites
can put you in touch with a lot of models fast,
but that doesn’t mean that you’ll get the best
results. Expect no-shows, last-minute cancellations, and awkward novices among the good
connections. You may get in touch with a model
who seems enthusiastic to work with you at the
start, but somehow never manages to schedule
a shoot. Other seemingly good prospects will
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just delete their profiles without notice, leaving
you with no way to keep in touch with them.
Web sites are not the only way to network.
Finding sitters through your own social circles
can often put you in touch with more interesting
people who will even afford you a certain amount
of trust up front. You can literally meet subjects in
a coffee shop or a bar. Justine Kurland, who has
made a name for herself making photographs of
earthy mothers in wilderness settings, describes
prospecting for subjects this way: “I hang out in
health food stores and Â�playgrounds with a box
of prints and talk to strangers, try to show them
pictures, tell them what it’s about. The ones who
believe in the vision are the ones who come.”
(NewÂ€ York Times, 2/25/07, “So They All Get
Naked and Play, Like Mom Did.” www.nytimes
.com/2007/02/25/arts/design/25kino.html.)
Modeling agencies understand the value of
high-quality photos for their models’ portfolios
and they often send them out for test shoots.
Some test shoot models will agree to do nude
or semi-nude shots after the portfolio work is
done. The fashion model look isn’t what every
fine art photographer is looking for, but if it
fits your aesthetic, all you need to get started is
about a dozen quality samples of your work to
show the agencies.
The expectation is that you will shoot some
number of photos that they can use in the models’Â€books. If you do great work, you can have access
to a large pool of talent that has been vetted and
has high professional standards, but if you don’t
produce images of high enough quality and in a
timely fashion, you won’t have the opportunity to
shoot any more tests with their models.
In larger cities, photographers often arrange
meet-‘n-greet events and shoot-offs, where
you have the opportunity to bring a portfolio,
business cards, or leave-behinds, and even your
camera. These can be great events for finding
new talent to work with, and even for shooting
new portfolio images.
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A Matter of Comfort,
Collaboration, and Trust

Perhaps the most important thing to be aware
of is that your sitter brings expectations to the
shoot, and it is important to manage those expectations. If you’re offering photos as any part of
the compensation for shooting, it’s important to
get the images to the model in a timely fashion.
A kind of negotiation happens whenever you
make a picture of someone, and that involves
reconciling the image that you want to make
with the way that person wants to be seen. You
can often see this in play after the shoot. If you
give the model the opportunity to select photos
for his or her portfolio, very often, he or she will
select different photos than you would.
The words “model,” “subject,” and “sitter” are
all somewhat problematic as a way of referring
to the person who will be in front of the camera, because each term implies a certain power
relationship and almost constrains the nature of
the ways in which the person on either side of
the camera will think about the collaboration.
In a similar way, we often talk in terms of
the model “posing,” a concept that has its own
built-in limitations. As you read the rest of this
chapter, it is hoped that you will take these
terms in the most expansive context. A lot of
creative juice comes from bending or breaking
with the norms. The model does not have to be
a plastic figure that strikes poses. Certainly, in
the case of a portrait, you’re trying to capture
some “realistic” aspect of a personality that will
communicate visually. In the case of a tableau,
the sitter can breathe life into a believable character that you create collaboratively and photograph in the context of a kind of performance.
The photographer does not have to play the
detached observer, but can operate more like
a stage or screen director who gives the actor
what they need to elicit the best performance.
You can be coach, cheerleader, or provocateur,
as well.

A condition of trust is crucial. It’s unfortunateÂ€ that art models, whether they model for
drawing studios or photographers, are compelled
to protect themselves from predatory behavior.
GWC, short for “guy with camera,” is a term
models have for hacks that use their cameras as
a pretense to leer at them naked or to get them
into bed. Art history may be full of lore about
sexual liaisons between artists and their muses,
but it’s risky. Bear in mind that word about any
transgressions can spread widely and efficiently
with the aid of social networking sites.
Some models will want to meet, and some
will want to talk on the phone in advance of
shooting for the first time. This is often so that
they can give you a “sniff test.” If you’re shooting with a model for the first time, she or he
may want to bring someone along for security.
During the shoot, you shouldn’t forget that
even without clothing, your sitter has a personal
space that you don’t want to violate. Touching is risky and should be avoided, but if you
feel you must touch in a way that gives direction, ask permission, and don’t forget that “no”
meansÂ€“no.”
Models on some of the networking sites
will often post disclaimers like “no pornography” or “tasteful nudes only.” These statements
are boundary markers, and because everyone
defines concepts like pornography and tastefulness differently, it’s important to come to an
understanding of what your potential model
means by that language ahead of time. In the
worst case, not doing so could mean a complete
waste of time.
It is often useful to show your sitter work
samples, sketches, or reference material in
advance of shooting, so that they will have an
idea of where you are going with your concept, 129
but don’t overwhelm them. The British have a
lyrical phrase for giving too much information:
“you’re blinding me with science.” You want

to develop a sense of how much information
your model wants and needs, and keep them
in the loop without overdoing it. Particularly
with more conceptual or performance-oriented
work, your model may need more background
information to strike the right tone, but too
much info will probably have the opposite
effect.
Compensation

You can expect to negotiate the terms of compensation every time you book a shoot. There
are professional art models who make a living
from posing, there are hobbyist models who
just do it for the love and adventure of it, and
there are novice models who hope to be paid
well in the future, but need a portfolio to get
started. You can expect to pay as much as $150
per hour or more for high-end models, while
some other models just want good pictures out
of the deal. Art models often work for schools
and drawing or painting sessions at $25–$50
per hour, but charge substantially more to be
photographed.
Another form of compensation in common use on the networking sites is abbreviated TFCD or TFP. The abbreviations mean
time for CD and time for print, respectively,
and theyÂ€ are sometimes shortened to TF or
TF*. Agency models will often agree to similar arrangements as a test shoot or a trade. The
idea is that the model gives his or her time in
exchange for images. The phrases mean very
different things to different people. If you plan
to shoot with these kinds of agreements, you
should develop your own clear and consistent
set of terms for entering into them, and state
your policy before you begin your shoot.
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The essence of a TF agreement comes down
to the value of your images and time versus the
value of the model’s time and talent. In valuing your images, you should consider that even
if you don’t pay out of pocket at the time of
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the shoot, there is sill some cost associated with
each shoot. There are a number of books that
devote one or more chapters to assessing your
cost of doing business, so we won’t go into that
here. However, it is important for you to make
some determination of the value of your images
based in part on your cost of producing work
when you develop your TF policy.
Whether you’re doing TF or licensing your
images to a client, the same pricing considerationsÂ€should apply. This includes the basic creative fee, any retouching and post-Â�production
fees, and licensing fees based on usage. A fairÂ€deal
works out to parity between what youÂ€ would
charge and what the model would charge. Any
model that describes a TF arrangement as
“working for free” does not see any value in the
photographer’s work.
Some models expect to leave a TF shoot with
a CD containing every frame that was captured
during the session. That is tantamount to using
your talents as a photo booth. If you are interested in promoting your work and developing
your reputation based on the quality of your
images, it’s never a good idea to agree to that
sort of arrangement. Often, those same models will take your images and edit them. The
result can be a bad image that is attributed to
you. Some photographers have all models sign
a release that stipulates that the images cannot
be edited and are licensed to the model only for
specific uses, such as self-promotion. We will
discuss more on releases shortly.
Consider these figures: in New York, there
are a number of portfolio photographers who
charge about $250 to $500 for a portfolio session. You review the images and pick your
favorites. The photographers will in turn do
“basic retouching” on a limited number of
images, usually four to eight. They charge extra
for more involved retouching and for additional
finished images. Advanced retouching varies
widely in price, but can often go for something
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in the range of $50 per image. Some, but not
all, portfolio photographers will also release a
CD of all the frames from the shoot in lowresolution web-size files. Typically, the photographers retain the copyright to the photos and
only grant the model the right to use the photos for self-promotion and portfolio usage.
Most models who have a pricing policy
have a two-hour minimum, and some give
a price break for three or more hours. So the
model’s feesÂ€ for a three-hour session might
range anywhere from $300 to $450. That’s
about parity with the fees for a basic portfolio
package including about six images with basic
retouching.
Some models maintain portfolios on sites
like deviantART, where they have the ability
to resell prints. Others may want the option to
license the images from a session for a magazine, a book, or a pay site. The economics of
each of these scenarios can vary widely, but
it is worthwhile to research these media and
develop your own pricing policy for licensing
these ancillary rights.
Releases

U.S. law governing model releases has to do
with granting the photographer permission to
use a photo for purposes of trade. Specifically,
you can’t use someone’s image in a way that
implies that they endorse a product or demonstrate its benefits without their permission in
the form of a release.
Editorial use of a person’s image, which
includes fine art, does not require a release
and is protected under the first amendment.
However, even though the fine art use of
an image may place you on solid legal footing, that doesn’tÂ€Â�prevent you from having to
defendÂ€Â�yourself in the event that someone
brings a lawsuit over the use of their image.
Nussenzweig v. diCorcia is a celebrated case that
concluded that the fine art use of an image,

even including limited edition sales of prints,
is not “for purposes of trade.” TheÂ€case lasted
from 2005 through most of 2007, when the
New York Court of Appeals ruled in favor of
diCorcia. The cost of Philip-Lorca diCorcia’s
defense had to be enormous. As an established
A-list artist, he had the resources of the Pace/
MacGill gallery at his disposal, something that
most of us do not.
Thus, it’s a good idea to have your model
sign a release anyway, as a way of having the
model acknowledge how the photos might
be used. You can get language for your model
release from a number of places, including the
ASMP (American Society of Media Photographers) web site. The language doesn’t vary
much between the different sources.
You may also encounter models (usually
early in their careers) who want you to sign a
release form that they have prepared, in addition to your own. It is likely that the document
contains stipulations about how you can use the
photos. It is probably not a good idea to sign
such documents. Maybe you can amend your
own release to address any concerns the model
may have; otherwise, it’s best to walk away from
such arrangements.
Copyright

Standard model releases only contain language
about the photographer’s use of the image. It
is a good idea to add language to the release
or have the model sign a second document
that makes it clear that you are the copyright
holder and stipulates the usage rights granted
to the model. Many photographers state that
the model has the right to use the photos for
self-promotion only, and even stipulate that the
images cannot be edited.
Some models believe that they are the author
or co-author of a photo, based either on the fact
that their likeness appears in the image, or on
the degree of collaboration in creating the idea.
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It is important to recognize that copyright law
is designed to protect the unique expression of
the idea and not the idea itself, and that it automatically recognizes the copyright as belonging to the photographer from the moment the
exposure is made.

© + year of first publication + your name. This
Â�format is recognized internationally. Be sure
toÂ€ use the copyright symbol—circle c—not
parentheses (c).

If you feel generous and want to declare that
you and the model jointly own the copyright,
you can, but joint ownership means that either
party can do whatever they like with the image,
without securing the permission of the other,
and without sharing in any benefits of that usage.
Instead of joint copyright, you might consider
retaining the copyright and granting broad but
specific usage rights to the model instead.

If the work you undertake is of a sexual nature,
there is one other legal matter that warrants attention. Imagery that depicts “sexually
explicit conduct,” whether it’s real or simulated, including masturbation and “lascivious exhibition of the genitals or pubic area”
falls under the regulation of the United States
Code, Title 18, Section 2257. You will need
to maintain records documenting the age and
names of the performers at the time the imagery was made.

What if your copyright is infringed? Even
though copyright is automatically granted, you
can’t recover much in the way of damages unless
you register your images. The easiest and most
economical way to register is in bulk, before
the images are published. Your pictures should
always run with a copyright notice that reads
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2257 Regulations

The vast majority of nude art, and even erotic
art photography, is not affected by this code, but
these regulations are in a constant state of flux,
and it is a good idea for the erotic artist to keep
an eye on the latest developments.
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The Shoot
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I

n a shoot, all of the equipment is in service of getting the
image, and an effective image requires the right connection
with the model. If you get lost in dealing with the camera, the
lights, or any of the logistics of shooting, your chances of getting a strong image are greatly reduced. We looked at various
qualities of light in Chapter 5, and much of this chapter will
discuss some of the equipment that can be used to produce
those qualities. The equipment described here ranges from
items that you might use in a small, intimate setting to equipment for a major production shoot with multiple models.

Some photographers always work with a minimalist camera and
lighting arrangement as a way of keeping the equipment from dampening the interaction. Richard Avedon would set his camera on a tripod and never look through the viewfinder (or at the ground glass of
his view camera) while he was shooting, because he felt it imposed too
great a separation. He used a remote shutter release, moved around the
room, and often used psychology to provoke responses in his Â�sitters.

9

The more you can make the equipment and
process disappear, the stronger your connection
to the subject.
If you’re working with more elaborate setups, it’s helpful to minimize the downtime of
futzing with equipment by planning and preparing ahead of time. If your camera is new,
learn as much as you can about how to perform
the operations you’ll need before the shoot. Or,
if you’ve got the finances, hire a skilled assistant
who’ll take care of it all for you!
You will probably need to break the ice
before you do any actual shooting. This may be
as much for you as for the model. Lots of photographers who are beginning to shoot nudes
are actually nervous being around naked models. You want to be relaxed and confident. Conversation can be almost anything, but it helps if
you’re genuinely interested in your sitter. It can
be just small talk, but if you say too little, that
almost guarantees that your model will be stiff
and ill at ease, or just plain bored. Talking about
current events can be tricky, because it can stray
into hot-button topics like religion and politics.
If your model volunteers information about a
girlfriend or boyfriend, it’s probably okay to
talk cordially about the subject, but you don’t
want to give the impression that you’re prying
or coming on to them.

136

For nudes there is the practical issue of skin.
Tight-fitting clothing leaves marks. Experienced nude models often arrive at the shoot
wearing loose-fitting clothing and no underwear. If your model arrives wearing tight
clothes, offer her or him a robe and plan to wait
around half an hour for the marks to go away.
Otherwise, you’ll probably have some work to
do in Photoshop with the healing brush after
the fact.
Preparation and giving good direction can
make a big difference in your shoot. No one
directorial style works for all situations. Irving
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Penn’s book A Notebook at Random shows preparatory sketches he used for some of his fashion shoots next to the finely crafted finished
product. These are examples of pre-Â�visualization
and shooting with a clear end in mind, where
the model almost functions as a prop. On the
other hand, various accounts of his “Earthly
Bodies” sessions describe his interactions with
his models as being highly collaborative and
almost nonverbal, where Penn communicated
with them in a primal way using “coos, murmurs, and supportive breathing to convey that
everything was wonderful, just right in this
perfect situation.”
Sometimes, it helps to show a few photos of
poses and concepts that are interesting before
you start shooting, but photos can have too
much specific information. Sketching or tracing shots and poses you’re interested in can
simplify the image so that your sitter will relate
only to the form of it. Don’t show too many,
and remember that you can always refer back
to your collection of posing ideas and introduce
new ones during the shoot if you have extra
time or start to lose momentum.
Once you start shooting, it’s important to
keep the communication open. Directing the
model during the shoot can work in a number of ways. The approach depends somewhat
on the model’s style of working. Many experienced models know what sides to show, and
are also aware of how light falls on their bodies. On the other hand, many models can fall
into rote poses. Look for ways to coach them
to strengthen the poses, or suggest alternatives
that build on their strong points. If your sitter
is new to modeling, it’s especially important to
keep your input to small chunks, interspersed
with banter. You want to use simple directives
like “Turn your head a little more” or “Can you
bring your chin down a bit?” For more elaborate poses, be ready to act out your idea, even
badly.
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Your sitter wants confident, competent direction, a sense of where your shoot is going, and
an opportunity to collaborate. Paraphrasing a
post from a model in an online forum, a great
photographer does the following:

• Comes to the shoot with creative and
innovative ideas
•	Listens to a model who is creative
• Does not make the model come up with all
the ideas
•	Tells a model “chin down,” “soften your
eyes,” “pop your hip, push out your pelvis,
and twist to elongate”
•	Tells a model “you have a hair out of
place,” then comes and fixes it

Music can help to create atmosphere during the shoot and take some of the pressure off
you for creating banter. Some models routinely
bring music, and others will bring it if asked.
You can play your own music, but always be sensitive to how it affects the space of the shoot. If
it’s too loud, is too distracting, or doesn’t seem
to suit the sitter’s tastes, turn it down, change it,
or turn it off.
There can be a lot to think about, prepare,
and manage before, during, and after a shoot.
But a shoot shouldn’t be overly stressful, and
even if it’s not giddy fun, it should be enjoyable,
and the results should be satisfying.
Studio or Not

Both the benefit and the challenge of the studio
is that it starts as a blank canvas. Many photographers simply put up some muslin or seamless
paper and a light or two and shoot in a minimalist style, but it can be useful to think of a
studio as something more akin to a movie sound
stage. Some photographers even construct sets
inside the studio. A bit of Â�wainscoting and

some vintage-looking wallpaper on a piece of
sheetrock with a support can transform a bare
white-painted cinder block space into the wall
of a country cottage. The studio is a place where
you can build illusions.
In the early part of David LaChapelle’s
career, he converted a very small apartment
into a studio, and had to find creative ways of
working within the small space. After he had
gained a degree of success and moved into a
much more expansive space, he felt compelled
to build a small set that approximated the tiny
space he was used to working inside. He fed
creatively off the constraint.
Spencer Tunick creates spectacles with hundreds of naked bodies sprawled across expanses
of terrain, populating famous locales, or filling
the voids of striking pieces of architecture. The
studio setting is far too restricted for the kinds
of images he is interested in creating. His is
location shooting in the extreme.
Natural Light vs.
Continuous Light vs.
Strobes

Some photographers swear by natural light,
and it is the only light they use. Paolo Roversi is
known for his elegant nudes, shot mostly with
window light. Photographers who work with
natural light become keenly aware of how it
changes and moves throughout the day. Many
shoot mainly in the “golden hours” near the
break of day and sunset, and many more have a
strong appreciation for how much the sun can
change within just 15 or 20 minutes.
Helmut Newton did a series of diptychs
involving the opposition of “naked” and
“clothed.” He shot part of the series at a villa
in northern Italy in 1981. In one of his first
diptychs, he shot the same woman clothed and
undressed (except for high heels) in similar poses
and in the same location. He didn’t try to make

137

a strict duplication of the pose, in part because
he realized that the light would change, and he
didn’t want the light to be the only difference in
the images. In essence, he was acknowledging
and embracing the constantly changing character of natural light and emphasizing that the
two moments were unique.
Some photographers prefer to have more
controlled lighting. Continuous lights offer
visual confirmation of what you’re going to get
before you trip the shutter, while strobes offer
intensity and the power of stopping motion.
Strobes also offer a range of light-shaping tools
that are not available with continuous lights.
We’ll cover a number of lighting instruments
and light-shaping tools later in this chapter.
Program and Preferred
Modes

One way to take creative control of your shots is
to override program mode on your camera. This
doesn’t necessarily mean switching completely
to manual, and it really works by degrees.
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The first degree of override might be called
P* mode, because many cameras put an asterisk next to the program mode indicator when
you override the default setting. In the old days,
when you put your camera in program mode,
you simply had to accept the determination of
shutter speed and aperture made by the camera.
Many current models have a thumb wheel that
allows you to bias the choice that the camera
makes: press the shutter button halfway down
to get a meter reading, then spin the wheel one
way to get equivalent exposures with faster
shutter speeds, or the other way to get equivalent exposures with wider apertures. When you
get to the aperture or shutter speed you like,
press the shutter button the rest of the way.
Shutter preferred mode is best for situations
where you are most concerned with the duration of the exposure and you are willing to let
the camera determine the aperture. Very often,
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we’re talking about dragging the shutter to
emphasize motion blur and camera shake, or
speeding up the shutter to freeze motion. Drag
shutter effects only work with a certain amount
of ambient or continuous light present.
Aperture preferred mode is best for situations where the primary concern is depth of
field. The camera will set the shutter speed for
you. When shooting in this way, you can anticipate what will be in focus. With sufficient depth
of field, you can pre-focus the camera and just
shoot without having to wait for auto-focus.
This can be particularly useful in low-light
situations where auto-focus systems sometimes
struggle to get a lock. The downside is that
your shutter speed can drop to the point where
motion blur and camera shake are a problem.
Exposure, the Histogram,
and Manual Mode

Your camera’s metering system generally makes
a “correct” exposure by calculating the shutter
and aperture setting so that the resulting tones
in the image average out to 18% gray. To properly register a low-key image, we need to tell
the camera to underexpose the image. Similarly, we need to tell the camera to overexpose
in order to register a high-key image properly.
That’s where exposure compensation comes in.
Exposure compensation tells the camera to
over- or underexpose the image in program,
shutter, or aperture mode. There is no exposure
compensation in manual mode, but if you want
to over- or underexpose in manual, you can
use the built-in metering system to determine
exposure or use a handheld meter, then simply
adjust either the aperture or shutter speed.
As you increase or decrease the exposure,
the peaks in the histogram will move accordingly. While a “normal” histogram should not
show spikes, or clipping, on either end, it may
be appropriate to have such spikes in low-key
and high-key images.
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When shooting in RAW, the histogram
shows the distribution of tones as they would
occur in a JPEG file shot with that exposure.
While that might sound like a problem, it’s
not. The distribution of tones in an unprocessed raw file doesn’t make sense to our eyes;
they are recorded in the language of machinery. A RAW file captures light impressions in
a linear fashion, but a JPEG file, and any photographic image, is the product of a nonlinear
response curve. The only way that a histogram
makes sense is by applying a response curve to
the data first.
Mixing Ambient Light
with Flash

The short duration of a strobe’s light makes
it operate as if it has its own shutter. This is
very useful when you want to mix flash with
ambient light, because it means that you can
put your camera in manual mode and let the
aperture control your flash exposure while the
shutter speed controls the mix of ambient light.
Decreasing the shutter speed captures more
ambient light, and increasing the shutter speed
captures less of it.
Using studio flash, the process starts with
taking a reading of the ambient light. Let’s say
that your light meter tells you that a proper
exposure would be 1/30 (second) at f/4. Since
you want the flash to be at least one stop more
powerful than the ambient light, you can set up
the flash so that its intensity reads f/5.6, one stop
over the ambient light reading. That means that
if we set the camera to f/5.6 and shoot at 1/30,
the image would register the ambient light one
stop underexposed, and at 1/60 it would be two
stops underexposed. You can experiment with
different shutter speeds until you find the one
that gives you the most pleasant mix.
If you were to slow the shutter down to
1/15, an interesting thing would happen. At
that point, the ambient light would be recorded

at 1/15 at f/5.6, which is an equivalent exposure to 1/30 at f/4. The intensities of the ambient light and the flash would combine, and
you would end up with an image that is overexposed by one stop. That only happens when
the intensities of the ambient light and the
flash are at parity.
Assuming that your indoor lights are tungsten and you set your white balance to the color
temperature of your flash, the color of the ambient light would take on a yellow-orange hue.
If you had a tungsten white balance instead,
the light of the flash would have a pronounced
bluish cast. If you want less of an apparent difference in color temperature, you could put an
orange filter over the flash to bring its color
temperature closer to that of the tungsten light.
Then you could use either a high color temperature setting to emphasize the golden color
of the light or a tungsten color temperature to
make all of the light neutral.
Outdoors, you have a lot more power from
the sunlight, but the same principles apply.
You’re likely to want to use a lower ISO to keep
your shutter speeds and aperture in a manageable range. In this case, your camera’s maximum
flash sync speed is a concern. For many DSLR
cameras, the maximum sync speed is 1/125, but
for some it’s 1/250. You’ll need to check your
camera’s manual, though, because some cameras only sync up to 1/60.
With that in mind, one interesting look is
where the ambient light is underexposed by
about two stops. Let’s say you are able to get
a reading of 1/125 at f/8. If you set your flash
to register f/16 and shoot at 1/125, you’ll get
the two stops underexposed look you’re going
for. If that doesn’t render your background
dark enough, and your maximum sync speed
is 1/250, you can increase your shutter speed
a little more. If you can’t, you’ll want to try to
get more light from your strobe, increasing it
to f/19 or f/22, for example, and then setting
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your camera’s aperture accordingly. If two stops
under (1/125 at f/16) renders the ambient light
too dark, you can slow the shutter down by
degrees until you achieve a pleasing balance.
A different look is fill flash, where the ambient light dominates. In that case, you would
simply set your aperture and shutter based on
the ambient light reading, then set your strobe’s
output to read one or more stops under. So, if
the ambient light reads 1/125 at f/8, a flash
reading of f/5.6 or lower will provide fill.
These calculations can be done automatically
using a TTL flash such as Nikon’s SB-800 and
Canon’s 580EX. For details on using fill flash
mode, check the manual. To make the ambient light underexpose and the flash overexpose,
there are two possible routes. The first is to set
your camera in manual mode, set your flash
in TTL mode, then experiment with aperture
and shutter speed. Because the flash is in TTL
mode, it will increase output as much as it can
as you increase the aperture number.
The other route to take with TTL is to set
your camera in either program mode or aperture mode. From there, you can use exposure
compensation to decrease the exposure of the
ambient light and increase flash compensation
to increase the output of the flash. Start with an
exposure compensation of –2 and a flash compensation of 0, and see how that looks.
Gray Card for White
Balance
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Using a Camera RAW workflow, it’s extremely
easy to get consistent, accurate white balance for
all of your shots by taking one reference frame
with a special neutral gray target. Since color
temperature can change as you vary the mix of
lights or the power setting on your strobes, it
is best to take a reference shot each time your
lighting setup changes significantly. If you plan
to shoot with colored gels, though, be sure to
take your reference shot with the gels removed.
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As we saw in Chapter 5, color temperature
can vary over a wide range for any particular
type of light source, so the preset color temperatures in your camera may not do such a
great job of neutralizing the whites. Auto white
balance can work better, but it generally doesn’t
work so well in low-light situations, and in
mixed light situations, the white balance can
shift a lot between frames.
Before shooting, you can choose a particular
preset white balance in your camera, or use a
gray card to set a custom white balance, just so
that all of your captures have a consistent color
when you start reviewing them. This is not critical, but it is often useful, even if you plan to
correct the color in post-production.
Another significant difference between
shooting with a particular white balance in
your camera versus neutralizing in Camera
RAW is that most cameras do not have separate adjustments for color temperature and tint,
while Photoshop does. It’s not uncommon for
the camera to get the color temperature right,
but skew either green or magenta. Greenish
skin always looks sickly.
Lights and Light Modifiers

Having looked briefly at the overall shoot and
some of the techniques, we now turn to some
of the lighting equipment involved. Of course,
the treatment here cannot do justice to the
entire subject of lighting equipment. Hopefully, the following will provide some with new
ideas about lighting that are worth exploring
further.
Continuous, or “Hot,” Lights

The phrase “hot lights” is slowly being phased
out and these lights are increasingly referred
to as continuous lights because color-balanced
fluorescent systems are becoming increasingly
popular, meaning that not all “hot” lights get
hot. These lights are the most straightforward
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to work with, because you have a fairly clear
idea of what the camera will record as soon as
you set them up and turn them on. This makes
them great tools to learn lighting techniques
with, because you don’t even have to make an
exposure to see the result.
The simplest and least expensive lighting
setups use a metal parabolic reflector, possibly
an umbrella, and household bulbs for illumination. The tungsten filament in a household
bulb slowly evaporates as it ages, and the color
temperature of the bulb will change over time
as tungsten deposits develop on the glass. Halogen bulbs are filled with a gas that interacts
with the tungsten vapor. A chemical reaction
causes the tungsten to be deposited back onto
the filament instead of adhering to the glass.
These bulbs do not shift color as much when
they age, and they also burn brighter and at a
higher color temperature.
Fixtures employing halogen bulbs can be
simple affairs with just a reflector or a more
elaborate design that has a focusing mechanism. Halogen bulbs emit a high amount of
UV light, and they should always have protective glass or a diffuser in front of the bulb.
Lighting systems that use special fluorescent
bulbs have come on the market in recent years.
These are different from household fluorescent
fixtures in several important ways. First, the
lights are available in daylight or tungsten color
temperatures. Second, they don’t exhibit the
greenish cast of household fluorescents. Last,
they cycle much faster than household fluorescents, so that they don’t appear to flicker. This is
more of an issue for the film industry than for
shooting stills.
HMI lights are a descendent of the carbonarc lights used in filmmaking from the early
days. They are expensive and hot, and are less
likely to show up in the studio of a starving artist,
but they have advantages for some applications.
They use a lot less energy than the equivalent

halogen light, and they produce light with a
color temperature of daylight. Even small HMI
fixtures can produce very intense light, so they
are typically bounced onto the scene from a wall
or bead board.
Some Manufacturers of
Continuous Lights

Smith-Victor’s lighting tools have been around
for many years. They make a wide range of inexpensive reflectors, fixtures, and stands that typically use household bulbs. These instruments
generally produce low-intensity light that is
relatively hard. You will probably want to put
your camera on a tripod for best results.
Lowel produces a range of lights that are
Â�particularly popular in film production. These
lights typically use halogen bulbs and are
designed for varying applications. The Tota
light is designed to fold up and be extremely
portable. It features a pair of reflectors arranged
in a V and is made to throw a wide, even pool
of light, which can be useful for lighting backgrounds. The Rifa light folds up like an umbrella,
making it quick to set up and take down, and it
is extremely portable. It has a panel of diffusion
material across the front and produces a soft
light that is great for portraits.
Arri and Mole Richardson make the lights
that are probably most associated with filmmaking. When you see shots of movie lights
or scenes of the inside of a television studio,
you’re likely to see lights by one or both of these
manufacturers. The Arri 650 is a relatively small
unit that throws a good amount of light. It can
be used for lighting a person or throwing light
onto a background. It features a Fresnel lens
(pronounced fruh-nell), which allows you to
focus the light. The quality of Fresnel light is
very distinctive, and many of the classic Holly- 141
wood portraits were shot with this kind of light.
The beam can be set to a tight, bright spot or
opened up to produce a softer flood. Thus, the
spot/flood knob can also be used as an intensity

control. You can also replace the 650-watt bulb
with a lower-intensity bulb.

the light in increments over a range of three to
five stops, often in increments of 1/3 stop.

Kinoflo and Rololight specialize in fluorescent lighting systems. These units feature arrays
of fluorescent tubes that produce a broad, soft
light. The Rololight system allows you to separate the individual tubes and arrange them in
different ways. The fixture also rolls up and
stows in a bag for easy portability. The light
from these units is good for portraits and
figurative work, and they are popular because
of their low-temperature operation and low
power consumption. They can also be used in
places where tungsten-based lighting would
blow theÂ€fuses.

Most studio strobes have a modeling light
that can be turned on or off. The light is usually 150 to 250 watts. With some light-shaping
tools, that’s barely enough intensity to be visible. It is usually enough to tell you if you’re
aiming the head in the right direction, though.
To see what the light is really doing, you need
to take a test shot.

Studio Strobes

Studio strobes work by storing substantial
amounts of energy from the wall in capacitors,
then dumping it on command into a gas-filled
tube. (A capacitor is different from a rechargeable battery in that batteries trickle out the
energy they have stored up, while capacitors
release their energy all at once like a lightning
bolt.) The resulting flash of light is very bright,
and typically lasts 1/1000 of a second or less. As
mentioned earlier, that’s faster than most camera shutters, and so the strobe functions as if it
has a shutter of its own.
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Because the flash of a strobe is so brief and
intense, it freezes action. The impressionistic
blurring of continuous lights is not available
with strobes. If your room is dark, and your subject’s pupils are dilated, the flash will switch on
and off faster than they can constrict, causing
red-eye. A number of photographers have used
this fact to their advantage, intentionally inducing red-eye, especially for fashion photography.
Moving the light off-axis and keeping the camera is close can create a very different effect, and
the appearance can be striking.
Strobes generally have output switches or
dials that allow you to control the intensity of
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There are two main designs for studio
strobes: pack and head systems and monolights.
With pack and head systems, a power pack
(sometimes referred to as a generator) houses
the capacitors and controls, and you attach a
separate head to the pack by means of a power
cable. Most packs can control two or three
heads, and are designed so that the power can
be divided evenly or asymmetrically between
the heads. One advantage of this design is
that the heads are light and the controls stay
on the floor. With only one head connected to
the pack, a substantial amount of power can be
delivered to the head.
Monolights are self-powered heads. They
contain a set of capacitors and controls, which
makes them a bit less convenient for applications like placing a light on a boom, both
because of the added weight and because you
have to climb a ladder to adjust them. On the
other hand, they tend to be more affordably
priced than pack and head systems. Their integrated design also makes them convenient to
travel with.
The power output of studio strobes is generally rated in watt seconds, abbreviated ws.
AÂ€600-ws or 750-ws monolight is a very versatile unit. Packs rated at 1200 ws are good for
most digital applications and are smaller and
lighter than 2400-ws packs. The extra headroom of a 2400-ws pack can be useful, especially
with power-hungry light-shaping tools or in
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Â�
outdoor
applications, but there are times where
it is a challenge to reduce the power enough,
especially when working in a small space.
High-power packs mean that you can keep the
ISO setting low on your digital camera. Some
cameras begin to show noise problems at ISO
800. Since you generally won’t be using these
packs at full power, it’s also likely that your pack
or monolight will recycle faster.
Raw power output, whether in watt seconds
or any other measure, is not really what we are
concerned with, since much of that power can
be soaked up by the light-shaping tools we use.
What we really care about is the intensity of the
light that results and the corresponding f-stop
that will produce a correct exposure. If the full
power of a 1200-ws pack in a particular setup
gives a reading of f/5.6, substituting a 2400-ws
pack at full power will give f/8. If you need f/11,
it’s time to move the light in about 1/4.
When you are working with two or more
lights, you can use a light meter to get your
lighting design working the way you want it
to much more quickly than with test shots.
Bearing in mind that you need at least a onestop difference in intensity to register noticeable lighting contrast, you can hold the meter
close to the subject and take readings of each
light source, adjusting one light at a time as
needed.
The usual way of triggering a strobe is with a
sync cable, which is notorious for breaking and
failing at the worst possible moment. The tiny
connection is fragile, and so are the wires inside
the cable itself. If you use sync cables, be sure
to have a spare handy. There is an alternative,
and it is called the Pocket Wizard. It is a small
radio transmitter that attaches to your camera
via the hot shoe and a receiver that attaches to
your power pack or monolight. This radio connection replaces the physical cable.
There are times where one pack is not sufficient to do the job. How do you get both packs

to fire? Trigger one with the camera, and let the
light of the first one firing trigger the second.
You do that by switching on the slave (unfortunate term) feature of the second unit. Virtually all flash systems have this feature, but if you
ever encounter a system that does not, you can
buy a small photocell that plugs into the sync
socket and triggers the unit.
The Sekonic L-358 is a workhorse light
meter that has an optional Pocket Wizard
module to run your metering process wirelessly.
It has a flat disc mode that allows you to shield
the light dome so that it reads one light at a
time in multi-light setups.
One performance characteristic that separates different strobes is recycle time. Better
systems can recycle extremely fast, even at full
power, while other systems can take several
seconds to do so. That may not seem like a lot
of time, but if you are trying to photograph
intricate movement on the fly, the lag between
flashes can seem interminable. Some systems
will flash before they are fully charged, but the
output is dimmed, and generally the color temperature decreases.
Most strobes temporarily turn off the modeling light when the flash fires and turn it back
on when the unit is fully charged. In cheap systems, this is the only indication that the system
is ready to fire. Better systems have the option
to switch off the modeling light and beep when
the system is ready. This can be important in
applications where you are mixing the strobe
with ambient light and you don’t want the
modeling light to affect the scene.
Some Makers of Studio Strobes

Swedish manufacturer Profoto is one of the
top brands. Their units are solidly constructed,
and the systems are designed for performance, 143
ease of use, and safety. Profoto also manufactures an extremely wide range of specialized
light-shaping tools. They make several systems,
including Acute, Compact, and the Pro-7.

The Acute systems are in wide use in photography schools. The Compact systems are Profoto’s
line of monolights. Pro-7s are nearly ubiquitous
among high-end rental studios in the United
States and are very popular among fashion
photographers. Profoto offers many models
with Pocket Wizard receivers built in.
Broncolor is also a Swedish manufacturer
that competes with Profoto at the high end
of the market. It is the other brand that fashion photographers most often use. While their
units are available in the United States, they are
much more widely available in Europe.
Dynalite is an American maker known
for its small, rugged, and extremely portable
systems. The emphasis on portability makes
Dynalites particularly good for location shooting. The company offers many models with
Pocket Wizard receivers built in.
Travelites are a line of monolights made
exclusively for Calumet by Bowens. They are
economical, solidly built, and well priced. Calumet also offers the Traveler series of pack and
head systems built by Bowens. The Calumet
designs have some features that are distinct
from the Bowens offerings. It is worth comparing the two.
Hot Shoe Flash
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Advanced hot shoe flashes such as Nikon’s
SB-800 and Canon’s 580EX are often referred
to as speed lights. It is well known that these
are sophisticated flash systems that can communicate with the camera to automatically set
their own power output in situations like event
photography. It is not as well known that they
can be placed on light stands and used as manual studio strobes. In manual mode, the power
on the SB-800 can be adjusted over a range of
six stops in 1/3 stop increments.
You can even trigger the SB-800 with a
Pocket Wizard. The sync cord plugs into a
Â�terminal on the side of the SB-800, and you
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put the unit into SU-4 mode. In this mode,
the SB-800 can be triggered by the Pocket
Â�Wizard or by the light of another strobe.
That’s fine if you’re the only shooter, but if
other people are setting off their flashes, it
can be a bit of a problem. Covering the electric eye and the red lens on the front of the
unitÂ€ with gaffer tape will blind it to other
flashes.
The power output of speed lights is rated
differently from studio flashes. Instead of a ws
rating, the flashes’ output is measured with a
guide number, which relates to the brightness
of the light at full output at a certain distance.
This doesn’t translate directly into watt seconds,
but the SB-800 and 580EX compare favorably
to a monolight in the range of 80 to 160 watt
seconds.
Ring Lights

The ring light, or ringflash, is an interesting
device. You can see an example of the light it
produces in Chapter 5. It’s part flash head and
part modifier. The light was a staple of Helmut
Newton’s lighting style for several years. The
basic ring light is a circular light source that
surrounds the lens and attaches to the camera
by way of a bracket that screws into the tripod
mount. Because the light comes from equal
distances all around the lens, most shadows are
canceled, and the illumination has a distinctive
look. When your subject is close to a wall, it
will create a shadow that looks like you outlined him or her with a thin, dark marker. The
outline expands to some degree as you move
away from the wall.
The original ring light design was a special
flash head with a large circular flash tube that
attached to a power pack. Profoto, Broncolor,
and Elinchrom all make versions of this design.
The basic design is essentially a bare doughnut, but different manufacturers offer a range
of diffusers and soft light reflectors that further
soften the look.

C H A P T E R  N I N E    |   L i g h t s a n d  L i g h t M o d i f i e r s

Expo Imaging is marketing the Ray Flash,
an interesting converter that clips onto the front
of your hot shoe flash and turns it into a ring
flash. Canon, Nikon, and Sunpak also have ring
light attachments that work with your camera’s
hot shoe, but these are primarily designed for
macro shooting.
Light Modifiers

A number of photographers have successfully
exploited the aesthetic potential of a raw light
source, but light modifiers dramatically expand
the creative potential of working with light.
Through light modifiers, you can harden, soften,
focus, constrain, color, and shape light.
Umbrellas are extremely simple to use and
among the least expensive of the light-shaping
tools. Their function is to soften and spread
light. Bouncing the light from a silver-lined
umbrella gives a light that has brighter highlights and more saturated color. It’s a slightly
harder look than the light from a white-lined
umbrella, which generally has a slightly warmer
look, as well. There are also translucent “shootthrough” umbrellas. These produce a flatter,
lower-contrast look than what you get with the
bounce-style umbrellas.
Size matters. As you increase the size of
the umbrella, relative to the subject, the light
becomes softer. So a 45-inch umbrella gives a
softer light than a 30-inch umbrella at the same
distance. The shorter the distance to the subject,
the larger the relative size of the umbrella, too,
so closer and bigger means softer. However, you
want to consider the application. It is possible
to have too big an umbrella, and it is possible to
move the instrument too close.
Photoflex and Westcott are two manufacturers that make convertible umbrellas with
a translucent interior and a detachable black
cover. These easily switch between bounce style
and shoot-through use. Some manufacturers make heat-resistant umbrellas designed to
work with high-temperature lights.

Umbrellas spread light over a wide area,
producing a lot of spill, which can be hard to
control, but that also makes them excellent
for illuminating backgrounds, floors, and large
areas. You may recall from the end of Chapter 5 that the feathered edge or penumbra of a
bounce-style umbrella’s light has a softer quality than the light reflected from the middle.
You will generally get better, more controllable results with an umbrella if you don’t tilt
it down toward the subject. Draw an imaginary
line between the tips and across the opening of
the umbrella, and keep that line parallel to the
vertical pole of your light stand. To adjust the
light, just move it from side to side or vertically
until you get the look that you want.
To use an umbrella with a hot shoe flash,
you need an umbrella swivel adapter with a cold
shoe. The foot of the flash slips into the shoe
and locks in place. The shoe fits into the swivel
in turn, and the umbrella fits into an angled
hole in the swivel and is held in place with a
thumbscrew.
Softboxes, sometimes called light banks, are
effectively an extension of umbrellas, and some
even retain the parabolic shape of an umbrella.
However, they improve on the idea in several
key ways. With a softbox, the softening of the
light is achieved by bouncing the light around
the inside of the box and then passing the light
through translucent diffusing material that is
stretched across the front of the tool. Many
softboxes have the option to install a second
layer of diffusion, known as a baffle, inside. The
shape of the softbox and the diffusion material
causes most softboxes to create a pool of light
that falls off more quickly than the light from
an umbrella, meaning that you’ll have inherently less spill to contend with when using a
softbox. The soft, diffused light of a softbox 145
hasÂ€one effect that can sometimes be an issue:
colors are less saturated in this kind of light.
Size matters with softboxes, just as with
umbrellas. They are typically described as small,

medium, and large, though the dome-type
softboxes are often specified by size. Larger
is softer, and softboxes have a “sweet spot,” or
optimum distance. A good rule of thumb is to
place the surface of the softbox at a distance
from the subject equal to the longest dimension
of the softbox. In other words, if you’re using a
medium rectangular softbox (roughly 36 inches
× 48 inches), you’ll get optimum results with
the light about 48 inches from the subject.
The basic shape of a softbox is rectangular,
with a more boxy shape than an umbrella; however, there are several useful variations on that
form. Strip lights are tall and thin, and create
a narrow plane of soft illumination with very
limited spill. They are very useful for creating rim lighting effects with the figure. Octas
have the shape of large umbrellas, and typically have eight sides. They can be very large,
and are sometimes used without the diffusion
material across the front. The shape of the light
source shows up in the catch lights of the sitter’s eyes, so fashion and beauty photographers
who do not like the look of rectangular catch
lights tend to quickly embrace the octas. Some
octas even have a bezel with a circular cutout
that attaches to the front of the diffusion panel
to make the catch light perfectly round, instead
of octagonal.
Several manufacturers make softboxes out
of Nomex, a heat-resistant material that can be
used with high-temperature continuous lights.
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The softbox attaches to a lighting fixture by
way of an adapter called a speed ring. In this
way, you can use the same softbox with an array
of fixtures; you just need the appropriate speed
ring for each type of fixture. The speed rings
are not really brand-specific. For example, you
can use a Chimera speed ring with a Photoflex
softbox.
Chimera makes a lightweight, high-quality
range of softboxes called Pro II. These are integrated units that allow you to add the interior
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baffle for extra diffusion, but they do not come
completely apart the way more expensive softboxes do. Chimera also makes speed rings that
adapt the SB-800 and the 580EX to a softbox.
Photoflex makes moderately priced 5 foot and
3 foot octa softboxes.
The beauty dish, sometimes called a soft
light reflector, attaches to a strobe. It is a hard
metal parabola, usually painted white inside,
with a reflector suspended over the center. Light
from the head bounces off the reflector in the
center and back into the dish before it is radiated out to the sitter. The light has a very soft,
luminous quality, especially when used close to
the subject. It creates distinctive catch lights in
theÂ€eyes.
Grids focus and harden the light, instead
of spreading it. They fit on the front of studio strobes by way of an adapter or a reflector designed specifically for grids, although in
a pinch, you can also attach a grid to a plain
umbrella reflector with gaffer tape. The grid
works by soaking up the light beams that are
not heading in a more or less straight path from
the light source to the subject. Some grid reflectors can additionally accept a snoot or a set of
barn doors.
Grids are usually sold in sets, and are graded
in degrees for the amount of spread they
allow, typically 10, 20, 30, and 40 degrees. The
more spread, the brighter the light that passes
through the grid, and the more feathered the
edge of any shadows will be. Because the grids
restrict the spread of light, they are useful for
controlling spill.
Egg crates and louvers are essentially grids
designed for softboxes. They further reduce the
spill of light, and have the additional effect of
making colors more saturated, while maintaining much of the soft quality of the light.
Several manufacturers, including Bowens
and Profoto, make Fresnel attachments for
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their strobe heads. These are focusing lenses for
the strobe that give the distinctive light quality
of the hot lights.
Snoots are funnel-shaped devices that fit
onto the front of a lighting head. The small
aperture allows just a small circle of light to
pass through. This can be used to create a bright
highlight, isolating or emphasizing one part of
the body. The edge of the circle of light produced by the snoot can be made harder by putting a snoot over a grid. There are also snoots
designed to fit over Fresnel hot lights like the
Arris.
Expo Imaging distributes the Honl Photo
Speed system, an assortment of light modifiers for hot shoe flashes including two different
grids and a snoot.
Barn doors are more commonly seen on
lights like the Arris and movie lights, but
they are often available for many other types
of lighting equipment, including strobes. They
generally have either two or four wings that
swivel to allow you to block the spill of light in
one direction or another. With the light source
above the camera and pointed down toward the
subject, you can position the barn door so that
much of the background is in shadow. This will
make the subject’s face pop out from the background, especially if the background is dark.
This technique generally works with head and
shoulders and even 3/4 portraits.
Gels are thin sheets of translucent material
that are used to color a light source. Many are
heat-resistant and work with either strobes or
constant lights; just be sure that you don’t put
the type that is not heat-resistant on a hightemperature light. There are holders for gels,
but many photographers simply use clothespins, box clips, or gaffer tape to hold the gels
in place.
CTO (color temperature orange) and CTB
(color temperature blue) gels are designed to

convert color temperature. Placing a CTO gel
over a strobe makes the light more consistent
with tungsten light, and placing CTB over an
Arri tungsten light, for example, will make its
light more consistent with strobe or daylight.
You can get 1/4, 1/2, or full CTO or CTB gels,
and you can double up the gels to control the
degree of color shift.
There is a wide range of other colored gels,
including the Storaro gels by Rosco, mentioned
in Chapter 5. These gels color the light for various aesthetic purposes. One caveat about colored light is that color becomes desaturated
and blows out as you increase exposure. Underexposure works better for colored lights. If you
want your colored light to look colored, use it
as a fill on the shadow side or shoot your image
low-key.
Using neutral density (ND) gels is a way
to decrease light output without moving your
lighting instrument. They are neutral in color
and soak up light. Depending on how much
you need to cut the light, you can build up multiple layers of ND gels.
Scrims are often made of metal screen and
are generally used to cut the light output from
hot lights. Full scrims cut one stop, and half
scrims cut half a stop. There are also scrims that
physically cover only half the light implement.
These are good for taming the light in one part
of the scene when everything else is lit just
right. Because they are made out of mesh, they
do not produce a hard shadow line.
Cookies create the effect of dappled light in
the studio. The term is a nickname for the actual
name of the device: a cuculoris. You can make
or buy these. They’re essentially a piece of plywood, foam core, or other opaque material with
shapes cut out to let some light pass through 147
and produce a pattern of shadows. Or you can
attach shapes to a piece of window screen. These
can simulate the way light spills through trees,
or can be cut to more specific geometric shapes.

The harder the light source, the more defined
the projected shapes will be. If the cookie is
used close to a high-temperature light source,
it’s important that it be fire resistant, but if not,
it can be placed on a stand a bit farther from
the source.

Flags are particularly useful in situations
where you are working with back lighting and
have issues of spill. A flag can be a notebook
held in your hand to block the light from the
lens, or it can be a cloth or plastic piece made
for that purpose, attached to a stand.

Reflectors, used to fill shadows, are commonly made of fabric stretched over a flexible
circular frame that twists and collapses into a
smaller shape for easy transportation. The reflective surface can be used to bounce light into the
shadow areas of a shot, to open a face, for example. They are especially useful in natural light
settings where fill flash is not available or not
wanted, but they work great in a studio setting
with flash, too. Reflectors are typically white,
silver, gold, or zebra colored. Some companies
make a frame with interchangeable coverings.
The gold and zebra colors add more warmth
to the reflected light. A number of companies,
including Photoflex, make reflectors.

You can also make your own flags out of Cinefoil, a heavy aluminum foil painted flat black. It
is easy to cut and shape, and stiff enough to hold
its shape. It is also lightweight, so it can easily
be taped to things. For example, it could be used
to create a skirt along one edge of a softbox or
umbrella to kill a troublesome bit of spill.

Bead board is a foam material with a pebbled surface that is also used for bouncing light,
especially from a light fixture. It is widely used
in movie production.
Silks and butterflies are pieces of translucent material that can be fastened to a frame
or taped over a window to provide diffusion.
TheyÂ€ are particularly useful in settings where
bright outdoor sun is too hard and highcontrast. California Sunbounce makes a number of products for both diffusion and bounce.
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V-flats are made from two large pieces of
foamcore taped together to form a hinge. The
flats will then stand on their own when unfolded
and stood on their end. They fold flat for storage. Foamcore is available in white, black, and
black on one side. The black-and-white version
can be taped together so that when folded to
show the white side, it serves as a bounce for
light sources, and when folded to the black side,
it becomes a black bounce. Black bounces are
also sometimes known as B-flats.
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Light Stands

Beyond understanding the various types, the
biggest thing to know about light stands is
how to use them safely and properly. There is
a temptation to use stands that are not rigid
enough, because they are lighter to carry and
easier on the wallet, but puny stands can cause
accidents.
With tripod-style stands, the stand is most
stable when the stays that attach the legs to the
vertical bar form a right angle with the vertical.
They can angle downward from the legs, but
they should never angle upward.
When working outside, even a light wind
can turn softboxes and umbrellas into sails. The
higher you hoist the lights, the bigger the problem. It’s a good idea to use sandbags to weight
the bases of light stands outdoors and to have a
spotter or two to keep an eye on the equipment
in case the wind kicks up.
Convertible stands like the Bogen/
Manfrotto 420B have an articulated joint that
allows the top portion of the stand to swivel
and become a boom arm or function as a conventional stand when you don’t need the boom.
The extended boom on this model can only
hold 11Â€pounds. The stand comes with an empty
counterweight sandbag. You just add sand.
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Full booms have longer arms and can support a little more weight, but they also have
controls that allow you to rotate and tilt the
instrument at the tip of the boom. Often, the
boom arm and stand can be purchased separately. An example is the Bogen/Manfrotto
025BS Super Boom with 008BU Stand, which
supports 15 pounds when extended. The stand
has one leg that can be extended for leveling
and has casters.
Booms are very useful, because they allow
you to place light above your sitter without the
stand being in the shot. It’s important to properly counterweight your light and sandbag the
base when you use such setups. Also, make sure
that the head is securely attached to the boom
arm. Pay attention to the maximum loads—
the extended boom on the 420B can hold just
11Â€pounds.
An interesting variation on the standard
boom arm is the Red Wing, which is an articulated arm that can be used with any appropriate
base, including the 008BU mentioned above.
The arm is cantilevered so that it can easily be
repositioned during a shoot. As it tilts, the head
rotates so that the lighting instrument at the
end continues to point in the same direction.
This comes at a price, but for some applications,
it makes switching setups almost trivial.
C-stands, also called Century stands, are
sturdier and more stable than tripod stands.
They come with a mini boom called a Hollywood arm, which attaches to the vertical support with a swiveling clamp called a knuckle.
The arm has a bare end and a knuckle on the
other end. The knuckle on the arm can be used
to hold flags or cookies, and the head of a flash
easily attaches to the bare end. They are most
stable when the you load them so that the
weight leans over the long leg.
Standard backdrops can be seamless paper
or simple muslin, but you can get creative
and use anything from newspaper to shower

Â�
curtains
to bubble wrap. Sometimes, it makes
a tremendous difference to add just a touch of
illumination for the background itself.
Many vendors will cut your seamless paper
to size. One standard width for seamless is nine
feet, but if 6.5 feet works better, stores such as
the Set Shop will cut it down at your request.
It’s relatively easy to put seamless paper on
aÂ€ wooden bar and hold it in place with an A
clamp, but often the paper spins around and
gets torn. Manfrotto’s 046MC Expan Drive
paper holders fit inside the core of the seamless roll and allow you to easily raise and lower
the paper by pulling a metal chain. The paper
is held in place by adjustable friction, and the
holders can easily be attached to light stands,
autopoles, or a wall with the appropriate adapter
and hooks.
Muslin can be plain or dyed in different
ways. The danger of dyed muslin backdrops is
that they have been used for so long that they
can easily impart that department store portrait
studio look to your images. Pattern-dyed muslin
works best if you keep the depth of field shallow so that the background is rendered slightly
out of focus. This is hard to do with some lenses
and lighting, because you can easily find yourself shooting at f/8 or f/11, which is likely to
make the background sharp. Plain muslin can
be especially interesting if you crumple it so
that it has lots of wrinkles and texture. Lighting
it from the side will then drive up the texture.
Renting vs. Owning

If you are so inspired, you might research the
cost of purchasing some of the more interesting
items mentioned here, and it is likely that you
will quickly discover that it adds up to a notso-small fortune. Many of the items are available for rent, especially if you live near a major
city, and companies like Profoto have leasing
programs. You can lose a lot of time picking up
and returning rental equipment, so it does make
sense to own a minimal lighting setup of your

149

own. Don’t forget that you can do a lot with
speed lights and that good used equipment can
be found online. If you do decide to buy used,
caveat emptor—research what you’re buying
carefully, so that you know what you’re getting.
Parting Tips

We close with some last reminders about safety.
Hoisting lighting equipment above the ground
can be risky stuff, for both people and equipment. The higher you hoist things, the more
unstable they become, and the more important
it is to properly sandbag the base. Be sure to
take precautions.
Tungsten hot lights, and even the quartz
modeling lights on most strobes, can put out
a lot of heat. Snoots and grids get hot, even
on strobes. Handle carefully. It’s a good idea
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to have work gloves, oven mitts, or some kind
of heat protection when you’re adjusting such
lights.
Strobe heads often have plastic protection
cones for transportation. Be sure to remove
those cones before plugging in the head, or you
could have a meltdown or a fire on your hands.
Wires are a tripping hazard. Route them
carefully. If you run the power cable for a strobe
under the leg of your light stand, kicking the
cable is more likely to make the stand slide than
tip over. Avoid tangling your cables, and it’s a
good idea to tape them down in areas that will
receive a lot of foot traffic. If you have something
like a boom with an end that juts out, mark it
with something brightly colored, so that no one
accidentally walks into it. As the old saying goes,
it’s all fun until somebody loses an eye.

This page intentionally left blank
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Digital Technique
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W

hether you shoot digital or scan film to create a digital file, once you open that file in a digital post-production tool, there are two very different routes you
can travel. The first route is to produce work that emulates
the look and feel of imagery that is done completely with film.
The other route is to take advantage of the digital environment to create work that is difficult or impossible to do in the
darkroom. A major challenge of making digital art echoes the
challenge that art photography itself faced at its inception,
namely, avoiding the perception that the machine, and not the
artist, is creating the work. We begin with a few examples of
different approaches.

Matthew Barnes shot the chapter-opening image. He put a paper
ray gun in model April’s hand and they improvised from there. Matt
decided later that she should be holding a chainsaw instead. Her hand
was in the perfect position for it. Matt describes himself as a spontaneous person, so he doesn’t carefully pre-plan his images.

10
OPPOSITE PAGE: Model: April Hutchinson. Photo by Matt Barnes/ThatsTheSpot.com.

The scene was lit from the left with a magnum deep-dish reflector fitted with a grid, and
a backlight was added to make the smoke stand
out. It was shot against a gray background with
aÂ€ Hasselblad 503 CW and a Phase One P45
digital back. The initial processing was done
through Capture One, and then post-Â�production
was done in Photoshop CS3.

Gaspar Marquez creates polyptychs, which
he calls bodyscapes, in-camera using film and
shooting intuitively (see the photo below). He
scans the resulting contact sheet and works in
digital from there. In Photoshop, he cleans up
dust spots and blemishes and tweaks the light.
He often makes digital prints as big as 46 inches
in the longest dimension.

The post-production began with general
cleanup and contrast. The chainsaw was shot
separately and pieced in. Finally, the original
background was replaced with a clean one.

The triptych in the top figure on page 155
is reminiscent of the more elaborate “photocubist” images of David Hockney. Cokeliss
Â�primarily uses digital to show his work online.

Reproduced by Â�permission of Gaspar
Marquez.
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The triptych was scanned from three separate
prints and was made the largest possible size
that would fit on the flatbed scanner at his service bureau. His exhibition prints are typically
16 × 20, Â�making this triptych a bit more than five
feet wide when presented in a gallery setting.
The gallery piece would be mounted by hand
and assembled from three separate prints.
For complex projects Cheirodon pre-plans
everything down to where individual strands of
hair should be. Sketches and rough animated
plots are made in advance of the shoot. He also

often has many hours of discussions with the
model prior to shooting.
For Cello Player (the bottom photo), the
model literally bent over backwards across a
stool that held her several inches above the
ground to create the illusion of being suspended in mid-air. The photographer was on
a ten-foot ladder, using a Canon 1D fitted
with an 85mm lens at f/5.6. The background
was white, and illumination came from two
softboxes approximately ten feet from the
model.

TOP: Reproduced by permission
Â�
of
Barney Cokeliss.
BOTTOM: Cello Player.
Image by Cheirodon.
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TOP: Nude in New Mexico and the Sky Above Her. Reproduced by
permission of Nina Pak.
BOTTOM: Reproduced by permission of Terry Donovan.

In post-production, the model was carefully
cut out—the hair being the difficult part—and
then the gradient background and other Â�elements
were added. The wire coil was created with Bryce
5 and the editing was done in CorelÂ€14.
Nina Pak routinely photographs textures
that she incorporates into her composites Â�(top
photo). In an e-mail exchange about her work,
she said, “For the Nude in New Mexico and
the Sky Above Her, I made a textural layer
in my painting studio using molding paste
and brown stain, (the kind you use to paint a
wooden deck), I layered molding paste from
Golden with a pallet knife, onto heavy watercolor rag stock and waited for it to dry. Then
IÂ€covered it with the stain using a rag. IÂ€rubbed
off the excess but let the stain fill the cracks to
give it the antique feeling, and tore the edges
of the paper around where the molding paste
had dried, leaving a thicker layer. IÂ€went over
the edges again with the stain. Later I photographed those various pieces of textured paper
and put them into my textures file, which I use
with the photographs in the layering process.”
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The digital compositing process can be very
exploratory. Terry Donovan described the creation of the light bulb image (in the photo to
the right) in an e-mail exchange: “The body shot
had intrigued me to start out with, but seemed
like it needed something other than the busy
kitchen background I origiÂ�nally had. So I erased
everything but the body, and made the background white. The shape instantly reminded me
of a light bulb…” He remembered an old shot of
a colored light bulb that he had shot many years
earlier….
“I threw it in as a layer [probably in overlay
mode], but it didn’t fully work until I inverted
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the body and white background and got the
black. Having the ‘light’ between the legs
[which resulted from inverting the shadow]
reminded me of a filament and seemed like it
just completed the picture.”
The Two Paths

One way to approach digital processing is
to make it completely transparent, with the
resulting image as indistinguishable from analog photography as possible. The look of digital output has now achieved a high degree of
parity with images produced through the wet
darkroom process. There are even specialized
tools to make images look like they were shot
on specific film stocks, and your prints can even
feel like they came out of the darkroom. You
can make ink-jet prints on fiber-based paper or
stock that resembles resin-coated papers. You
can also have C-prints made from your digital
files—these are photographic prints that use
silver-based paper and wet chemistry.
Shooting “straight” nude portraits digitally
would typically entail some adjustments to
color and contrast and possibly exposure, and
little else. In this application, digital is essentially a streamlining tool used for retouching,
color correction, and printing. From there,
digital images can be made to look more like
they were shot on film by reducing the saturation and adding grain. Scanned transparencies, negatives, or prints are the basis of a
hybrid workflow that is common today. Printing from a digital file makes large-scale prints
much more accessible than when working with
enlargers.
If you are interested in work that goes
beyond “straight” imagery, two groups of photographic artists that might provide inspiration
for a digital art-making process are the members of the Photo Secession, who advanced the
philosophy of Pictorialism, and the Surrealists.

Photographers in both movements had a vision
of the photograph as something more than a
direct transcription of whatever tableau was
laid out in front of the lens. The Pictorialists
felt that the act of altering the photograph is
what made it art, and the Surrealists completely
deconstructed photography to create works that
sometimes defied the category.
By combining technique and technology,
both groups produced images that used the
photographic process, but were intended to look
like something other than plain photographs.
Their techniques included cropping, toning,
burning, dodging, and combining images, either
by collage or by multiple exposure. A mainstay
of Surrealist technique is solarization—perhaps
the artistic effect most specific to photography.
If you have ever seen the dreamlike Surrealistic work of Jerry Uelsmann, it’s easy to
think that it is a masterful application of Photoshop, but it was all produced in the darkroom
through an elaborate process involving multiple
negatives and as many as seven enlargers. It is
a technique that he refined in 1960, predating
the first personal computers by nearly 20 years,
about 30 years before Photoshop 1.0, and it
is the process that he continues to use today.
ItÂ€is likely that his work was a point of reference for the developers of Photoshop, setting
the standard for the blending effects it had to
be capable of producing.
Uelsmann’s first big break came from John
Szarkowski, who gave him a solo show at
MoMA in 1967. He describes the experience
as akin to being blessed by the Pope. It’s interesting to note that when he first began showing
his work, many people felt that it wasn’t photography, a point of view that is echoed today
in people’s attitudes toward digital work. Even
Uelsmann’s earliest work does not look dated
and can be a source of inspiration and a point
of departure for digital artists.
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Exploring a Digital
Workflow

Whether you shoot film and scan to digital files
or shoot digital directly, the digital workflow is
largely the same. The stages are as follows:
• Archive and catalog source files
• Pre-edit with Camera RAW
• Photoshop editing and post-production
• Printing and export to web

There are various approaches and tools to
manage the workflow. Regardless of which
tools and methods you use, a common thread
is color management. Most workflows also
favor nondestructive editing techniques such
as using adjustment layers rather than applying adjustments to pixels, and using layer masks
instead of erasing. Much of the remainder of
this chapter will move through a digital workflow in sequence.
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Into the Computer

After the camera or the scan, the first stop in a
digital workflow is storage and cataloging. This
can be accomplished with a number of tools,
but we’ll focus mainly on Adobe Bridge, which
comes with Photoshop and allows you to organize, assign metadata to, search, and preview
your images. You can also use Bridge to generate web galleries, slide shows, and image collections in PDF format.
Adobe Photoshop Lightroom is an alterÂ�
native to Bridge. It stores thumbnails and
metadata in its own database, making some
operations faster, and it also has the capabilities
of Camera RAW built in. If your photographic
practice emphasizes creating work in-camera,
it is possible to use just Lightroom, bypassing
Photoshop altogether, but if you need to do
localized adjustments or build up an image using
layers, then you will ultimately need to work in
a tool with the capabilities of Photoshop.
Adobe Bridge helps you preview, organize, and find images.
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Techniques in Camera RAW

Camera RAW was originally designed specifically for editing RAW files, but it has evolved
so that you can use the same pre-processing
interface for JPEG and TIFF files, if you like.
Opening these files in Camera RAW doesn’t
make them equivalent to RAW files, though.
There are a number of Camera RAW features
that are not available when you are working on
a JPEG or TIFF file, but the ability to edit these
files is equivalent to that feature in Lightroom.
White Balance

In a “straight” digital process, it’s useful to start
with an accurate white balance. You can shoot
a reference frame with a gray target such as the
Whi-Bal gray card shown in Chapter 5 and the
opening of Chapter 9.To use the reference image
in Camera RAW, simply select the White Balance dropper tool and click on the gray card in
the image. Once you have established the white
balance for that image, you can synchronize
other files to that white Â�balance. Using Adobe
Bridge, the process works as follows:

1. In Adobe Bridge, select a group of images,
including the one containing the gray card.
2.	Use Command [Ctrl] + R to open the
images in Camera RAW. The images will
appear in a strip down the left of the Camera RAW interface.
3. Scroll through the list of thumbnails to
locate the frame containing the gray card
and click on it to display it in the preview.
4. Click the White Balance dropper tool to
activate it.
5. Click the gray card in the image to set the
white balance.
6. Click the Select All button.
7. Click the Synchronize … button. The synchronize dialog will appear.
8. Choose White Balance from the synchronize
menu at the top of the dialog.
9. Click OK.

Using the White Balance dropper.
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Synchronizing White Balance with multiple images.

Camera Profiles

160

One of the criticisms of Photoshop for processing RAW files prior to Camera RAW 4.5 was
that the color rendition and contrast was dull.The
proprietary routines that Canon and Nikon, for
example, used to interpret color from their RAW
file formats had a Â�characteristic way of tweaking
the colors. As a result, files that were processed
through converters such as Nikon’s Capture NX
looked better than the same fileÂ€processed with
the default settings inÂ€Camera RAW.
Adobe has substantially addressed this issue
with camera profiles. To use them, you click on
the Camera Calibration tab in Camera RAW
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and choose a profile from the Name menu. If
you like, you can further tweak the tint in the
shadows and the hue and saturation of the red,
green, and blue primaries.
Color Manipulation

Camera profiles, used in creative ways, open the
door to manipulating the color of your image
beyond a neutral or “straight” interpretation. That
is just the beginning. It has been mentioned earlier that you can intentionally push the color temperature. You can use the White Balance dropper
to sample a gray card, then slightly warm or cool
the result for a subtle effect. A more dramatic
effect can be accomplished by simply dragging
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Camera profiles allow for different preset looks when rendering RAW files.

the color temperature slider strongly to the right
or left. A third approach is to click on something
in the image that is not neutral, such as the skin.
If you sample the skin with the White Balance dropper, the tones will be adjusted to make
the skin neutral, and the image will take on an
overall cool tone. If you sample something that
has a cool tone, the image will become warm.
The overall color cast that results will be the
opposing color of the area that you clicked on.
The HSL/Grayscale tab allows you to separately adjust the hue, saturation, and Â�luminance
of key bands of color in your image: reds,
oranges, yellows, greens, aquas, blues, purples,
and magentas. These sliders can be worked individually to either enhance or diminish the significance of various fields of color in the image.
The HSL/Grayscale tab is just one place
in the Photoshop workflow that gives you the

ability to make black-and-white images. Many
photos look best as either black and white or
color, so it makes sense to make that decision in
Camera RAW, but you can also use a Black &
White layer in Photoshop to produce the effect.
The interfaces in each are the same. The Grayscale Mix sliders allow you to specify how light
or dark each of the spectral colors are represented
in the image. The result can be a conventionallooking black-and-white image, an emulation
of infrared film, or something unique.
There is one significant difference between
using the Grayscale option in Camera RAW
and using a Black & White layer on a color
image in Photoshop: when you check Convert
to Grayscale in Camera RAW, the image will
open in Photoshop in Grayscale mode. If you
want to do colorizing effects later on, you’ll need
to switch to RGB Color mode in Photoshop. If
you use a Black & White layer, the image will
still be in its original color mode.
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The HSL/Grayscale tab.

Use Split Toning

Camera RAW’s Split Toning tab does not have
a direct equivalent in Photoshop. In Chapter 6,
it was introduced as a tool for color composition.
You can apply split toning to any image, but it
generally works better over an image that has been
converted to black and white with the Grayscale
option in the HSL/Grayscale tab first.
The effect tends to look strongest with
opposing colors, e.g., red vs. cyan or yellow vs.
violet, but it is conceivable that two adjacent
colors could be used effectively. The easiest way
to establish the effect is as follows:
1. Push the saturation higher than needed
forÂ€both the highlights and shadows.
2. Pick the hues for highlights and shadows.
3.	Use the balance slider to set the crossover
point.
4. Adjust the saturation levels for highlights
and shadows until you have a pleasing mix.

Use Presets and Snapshots

If you are experimenting with several settings together to determine which is the best
Â�combination for your image, you can quickly
save a snapshot for each potential group of settings. To create a snapshot, do the following:

applied. To delete the selected preset, click the
trashcan icon at the bottom of the tab.
Snapshots record all of the settings in all
tabs, while presets allow you to select which
settings will be recorded. Presets are available
any time, while snapshots are attached to each
individual RAW file. To record a preset, do the
following:

1. Click on the Snapshots tab.
2. Click on the new Snapshot icon at the
bottom of the tab.
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3.	Enter a name.
4. Click OK.

To use a snapshot, click on it in the snapshot
list. The snapshot’s settings will immediately be
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1. Click on the Presets tab.
2. Click on the New Preset icon at the bottom
of the tab.
3.	Enter a name and select check the settings
you wish to record.
4. Click OK.
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TOP: Creating a snapshot.
Snapshots are attached to
individual images.
BOTTOM: Creating a preset.
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Use Workflow Options

Before Camera RAW hands off the converted
image to Photoshop, there are a few Â�important
decisions for you to make. These choices are
established in the workflow options. The most
critical choices to make are color space and
bit depth. You can also resample your image
and specify the print resolution ahead of time
through the workflow options. To enter the
workflow options, click the underlined text at
the bottom of the Camera RAW dialog.
In terms of color space and bit depth, Adobe
RGB in 16-bit mode is the best general-purpose
color space in which to work. If your machine
has limited computing power, you might consider Adobe RGB in 8-bit mode. The space you
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choose is dependent on what you plan to do
with the image after it leaves Photoshop. If you
know you only plan to make web files out of the
image, sRGB in 8-bit mode is probably a better choice. ProPhoto can hold some saturated
hues—blues, greens, and maybe magentas—
that your monitor can’t display but that your
printer can print. If your work involves those
strongly saturated colors—such as lush green
landscapes and saturated skies—you may find it
beneficial to work in ProPhoto in 16-bit mode.
If you choose ProPhoto RGB, be sure to use
16-bit mode all the way to printing, and do not
switch to 8-bit. Switching to 8-bit in ProPhoto
The workflow options in Camera RAW allow you to select color
space, bit depth, and resolution before opening in Photoshop.
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RGB is especially likely to cause posterization. Epson’s current print drivers have a 16-bit
option, and it should be used whenever you are
working in 16-bit.
The size options are a convenience feature.
Camera RAW can re-sample your image to make
it larger or smaller. The re-sampled size options are
all marked with either a plus sign or a minus sign.
It’s generally better to re-sample in Photoshop
when you need to, so if you don’t have a special
purpose for doing so, be sure that the size setting
you choose does not show a plus or minus.
The PPI setting in the Workflow Options is
another convenience feature, and is not critical.
The only places that the PPI setting has any
effect are in the option to view at print size
and when you send your image to the printer.
Chances are that you will change the setting
before you print the image.

Techniques in Photoshop

Once you have set your workflow options in
Camera RAW, you can click the Open button
to render the file and transfer it to Photoshop’s
editing environment. In the next part of this
chapter, we will primarily focus on techniques
for creative expression with Photoshop.
Refine the Color Palette
of an Image

One of the reasons many photographers prefer
black and white is that color in the real world can
quickly muddy things up. When you look at a
color image, sometimes there is a dominant set of
colors. The image will become much stronger if
you can diminish the effect of competing colors.
In the example in the photo below, the color
in the composition was altered to emphasize
Before and after selective color adjustments.
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the red/green color contrast. There was also
a slight yellowish cast on the skin that complicated the composition. Reducing the yellow and changing the green of the artichoke
to a slightly unnatural color strengthened the
image. Here’s how to do this:
1. In the Layers panel, choose Selective Color …
from the Add a New Fill or Adjustment Layer
menu at the bottom of the panel.
2.	With the colors menu set to Reds, set
theÂ€following adjustments: Cyan +6,
Magenta –2, Yellow –11.
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3.	With the colors menu set to Yellows, set the
Black slider to –24.
4. In the Layers panel, choose Hue/Saturation
… from the Add a New Fill or Adjustment
Layer menu.
5. Select Greens from the menu at the top of
the Adjustments panel.
6. Click the finger icon to activate the click
and drag feature.

The Layers panel featuring a Hue/Saturation and Selective Color
adjustment layer. The adjustments panel displays the controls for
the selected layer. Adjustment layers can be added through the
menue icon at the bottom of the panel.
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7. Click on the artichoke to target a color.
Notice that the dialog adjusts, and the
Â�colors menu shifts to Yellows.
8. Adjust the sliders as follows: Hue +29,
Â�Saturation +19, Lightness –4.

Convert Color Images to Black
and White

Photoshop’s black-and-white adjustment layers
were introduced in CS3, and they completely
altered the nature of converting images to black
and white in Photoshop. There were techniques
such as using the channel mixer or applying
a grayscale gradient that worked reasonably
well, but the black-and-white adjustment layer
eclipses all other techniques for intuitiveness
and ease of use.

There are a few ways to add a black-andwhite adjustment layer to a color file:
1. Go to the Adjustments panel and click on
the Black & White Layer button.
2. In the Adjustments panel, click on the
triangle next to Black & White Presets to
show the list, and then click on a preset.
3. In the Layers panel, hold the mouse button
down on the Create a New Fill or Adjustment Layer icon to display its menu, and
then select Black & White … from the menu.

Excellent color and black and white images can be obtained from
the same file through the Black and White adjustment layer.
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Once you have the adjustment layer in place,
you can adjust the sliders manually to get a
pleasing tonal distribution, or you can select a
preset effect, such as Infrared, from the menu
at the top of the Adjustments panel.
Tweak Tones with Curves

Often, the tones you establish with the blackand-white adjustment might need an additional boost with a curve. That could simply
mean lightening the image a bit, or making an
adjustment to the overall contrast. You can do
the following:

Once the curve is added, you can edit its
control points to further refine the effect.
There is another way to add contrast to
your image with a curve, which is less obvious.
Rather than adjusting the control points of the
curve, you can leave the graph unadjusted and
change the blending mode of the adjustment
layer to one of the contrast blending modes.
Those modes are as follows:
•	Overlay
• Soft Light
• Hard Light

1. Make the Adjustments panel visible.
2. If it is showing a set of controls instead of
the adjustment list, click on the arrow in the
lower left corner of the panel.
3. Click on the Curves button at the top of the
Adjustment panel, or click the triangle next
to Curves Presets and select a preset from
the list.

When the Adjustments panel is showing
Â�
controls for the current layer, click the
arrow at the bottom of the panel to
return to the adjustment list.
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• Vivid Light
•	Linear Light
• Pin Light
• Hard Mix

You may find that one of the contrast blending modes is the right general idea, but the
effect is too strong. In that case, you can use the
opacity slider to reduce the effect.
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TOP: The menu at the bottom of the Layers panel
allows you to add a Black & White adjustment layer.
When the layer is selected, the adjustment panel
allows you to apply a preset, such as infrared.
BOTTOM: In addition to the curve presets in the
Adjustments panel, the tonal effect of a curve can be
modified by changing the blending mode and opacity of the layer via the Layers panel.

169

Colorizing Black and White

The black-and-white layers can be used to create beautiful neutral-tone black-and-white
images, or they can be the basis for color
effects beyond split toning, which was discussed earlier in the Camera RAW section
of this chapter. Any black-and-white conversion can be used to modulate the tonality of
the underlying colors in a file. Just change the
blending mode of the black-and-white layer
to Luminosity. The colors from the underlying
layer will take on the tones of the black-andwhite layer.
Earlier, we looked at how the curves adjustment allows you to alter the tonality of an
image,Â€ but curves can also be used for color
adjustment. By default, the Adjustments panel
for a Curves layer applies changes equally to
the red, green, and blue channels, but a menu
in the panel allows you to curve each channel
separately. If you set the blending mode of a
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Curves layer to Color, you can curve each channel without changing the luminosity (light/
dark values) of the image. In this way, curves
can be used for color correction, or they can be
used for creative color applications.
Curves presets can be saved and loaded,
allowing you to easily reuse curves effects.
Â�Figure 10.21 is an example of that application.
In the wet darkroom, selenium toning is more
common than sepia toning, but in the digital
world it is the other way around. That’s because
sepia toning can be effectively simulated with a
simple brown overlay, but selenium toning colors the highlights differently than it does the
shadows, and the effect is subtle. That’s a job for
curves.

The Â�black-and-white conversion used the Red Filter preset. When
that layer was set to Luminosity mode, the effect was too strong.
Panel 3 shows the layer in Luminosity mode with the opacity
reduced to 60%.
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Simulated selenium toning. To create the effect, a preset Curves
adjustment was placed over a black-and-white adjustment layer.

world of wet photography, cyanotypes are
made as a contact print, often using objects
laid directly on the photosensitized material,
rather than being projected onto the surface via
an enlarger. The high-contrast medium tends
to show minimal fine detail, and the shadow
areas tend to block up to solid blue very easily. You can achieve the coloration of cyanotype with a Hue/Saturation preset, but if you
are out to make images that are not simply the
color of cyanotype, it makes sense to look for
ways to increase contrast, plug up the shadows,
and reduce fine details. The best ways to reduce
detail in the mid-tones and highlights will vary.
A curve layer set to hard light will give a pronounced weight to the shadows.
Use the Threshold Adjustment

The Threshold adjustment creates a strong break
between light and dark and can be used in conjunction with effects like cyanotype to make
dramatic and moody images.
Color Effects with the Hue/
Saturation Adjustment Layer

Two colorization effects that are relevant to
black-and-white images are emulationsÂ€ of
effects that come from the world of wet
photograÂ�phy, namely, cyanotype and sepia
Â�toning. To use them:
1. Click on the topmost layer in the stack to
select it.
2. Hold the mouse button down on the Create New Fill or Adjustment Layer icon to
display a menu and select Hue/Saturation….
3. Choose either Cyanotype or Sepia from the
menu at the top of the adjustment panel.

Cyanotype is an alternative photographic
process that is a relative of blueprints. In the

1. In the Layers panel, click on the topmost
layer.
2. In the Layers panel, hold the mouse button
down on the Create New Fill or Adjustment Layer icon and select Black & White …
from the menu. A new adjustment layer will
appear in the layer stack.
3. In the Adjustments panel, use the sliders
and presets in the dialog as needed to make
a satisfying black-and-white conversion.
4. In the Layers panel, hold the mouse button
down on the Create New Fill or Adjustment
Layer icon and select Threshold … from the
menu. A new adjustment layer will appear
in the layer stack.
5. In the Adjustments panel, move the slider
until you find a visually pleasing break in
the tones.
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TOP: Applying Cyanotype or
sepia effects with Hue/Saturation
adjustment layer.
BOTTOM: Setting a Curves
adjustment layer to the Hard Light
blending mode adds Â�contrast
without shaping the curve.
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An image that combines Threshold and Cyanotype, using layer
blending modes.

6. In the Layers panel, change the blending
mode of the threshold layer to Overlay.
7. In the Layers panel, hold the mouse button
down on the Create New Fill or Adjustment
Layer icon and select Hue/Saturation …
from the menu. A new adjustment layer will
appear in the layer stack.
8. In the Adjustments panel, select Cyanotype
from the presets menu at the top of the
panel.

Adding Textures

Textures can be an important dimension in constructed images. You can photograph orÂ€ scan
textures to add to your files, or you can generate
them. Three main tools for creating textures in
Photoshop are the Clouds, Noise, and Fibers
filters. Each of these creates random texture

effects that can be used as is or modified and
combined in different ways.
Each time you choose Filter > Render >
Clouds, you get a different arrangement of light
and dark. An example of using Clouds to create
a texture effect follows, but the key is to experiment and find your own effects.
1. In the Layers panel, click on the topmost
layer.
2. In the Layers panel, click on the Add New
Layer icon. A new layer will appear in the
stack.
3.	Tap the D key to set the default colors.
4. Choose Render > Clouds from the menu
bar. A random cloud pattern will fill the
layer. If you don’t like the pattern, choose
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TOP: A random cloud pattern.
BOTTOM: The cloud pattern after applying the Maximun filter.

Render > Clouds repeatedly until you get a
pattern that you like.
5. Choose Filter > Other > Maximum … to
alter the transition to the highlights in your
image. A dialog will appear.
6. Choose a radius and click OK to apply the
effect.
7. Choose Filter > Noise > Median … to smooth
the tonal transitions. A dialog will appear.
8. Choose a radius and click OK to apply the
effect.
9. Choose Filter > Stylize > Emboss … to make
the tonal effect look three-dimensional.
AÂ€dialog will appear.
10. Change the angle, height, and amount as
desired, then click OK to apply the effect.

Noise can be used to add a fine texture to
your images. Blurring it slightly makes it look
more like film grain.
1. In the Layers panel, click on the topmost
layer to select it.
2. Hold down the Option [Alt] key and click
on the Create a New Layer icon to add a
layer. A dialog will appear.
3. Change the mode to Overlay.
4. Check the box marked Fill with Overlayneutral color (50% gray).
5.	Optional: name your layer, e.g., Noise Layer.
6. Choose Filter > Noise > Add Noise….
174

7. Set the distribution and then the amount.
Gaussian produces a randomized effect
more akin to film grain.
8.	Optional: check the box marked Monochromatic. Leave it unchecked to create an
effect that emulates color film.
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TOP: The Median filter smoothes the squarish forms of the
Â�Maximum filter.
BOTTOM: The Emboss filter creates a dimensional effect.

9. Choose Filter > Blur > Gaussian Blur … to
smooth the edges of the noise and make it
look more like film grain.
10.	Enter a radius. A small radius (e.g., 0.8)
works best for a film grain effect.
11. Click OK to apply the effect.
â•›12.	Optional: if the effect is too strong, you
can either change the layer blending mode
to Soft Light or reduce the opacity of the
layer.

Noise patterns can be used to create a wide
range of pattern and texture effects. Applying
motion blur to noise can make it look like rain
or brushed metal.
Filter > Render > Fibers … creates a randomized fiber effect. The colors of the pattern come
from the current foreground and background
colors in the Tools panel. The effect replaces pixels already present in the layer, so unlike Clouds,
it won’t work on a blank layer.
1. In the Layers panel, hold down the Option
[Alt] key and click on the Create a New
Layer icon. A dialog will appear.
2. Set the layer mode to Overlay or Soft Light.
3. Check the box that says Fill with Layer
mode-neutral color (50% gray).
4. Name the layer, if you like, and click OK.
5. Check the foreground and background
colors. Hit the D key to select the default
colors (black and white), or click on each
of the color chips to pick foreground and
background colors individually.
6. Select Filter > Render > Fibers … to generate the effect. A dialog will appear.
7. Adjust the Variance and Strength sliders
toÂ€define the effect.
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TOP: You can add noise to an image by using a layer set to the
Soft Light or Overlay blending mode. Once you select the mode,
you can check the box to fill the layer with 50% gray.
BOTTOM: Applying noise to the 50% gray layer.

8. If you want a different pattern, click the
Randomize button as many times as
needed.
9. Click OK to apply the effect.

The Fibers filter always generates a vertical
pattern. You can change the orientation of the
pattern by rotating and scaling the layer:
1. If the Fiber layer is not selected, click the
layer to select it.
2. Zoom out so that some gray space is visible
around the outside of the image.
3. Choose Edit > Free Transform. Handles will
appear around the corners of the image.
4. Place the cursor near one corner. When the
cursor changes to a bent double-ended
arrow, it is ready to rotate.
5. Drag the corner in an arc to rotate it to the
desired orientation.

The rotated pattern will not cover the entire
image. To fix that, we’ll scale the effect.
6. Place the cursor near one corner. When the
cursor changes to a double-ended diagonal
arrow, it is ready to scale.
7. Hold the Shift key down and drag the
corner outward to expand the coverage.
Repeat with other corners until the scaled
effect covers the entire image.
8. Hit the Return key to commit the
changes.
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Sometimes, you only want the effect you’re
adding to be applied to part of the image.
AÂ€valid criticism of a lot of digital art is that
it looks as if someone simply poured one or
two effects over the entire image like a glaze.
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You can add a mask and paint it black to hide
the effect and remove it from parts of the
image.
1. In the Layers panel, click the layer to
select it.
2. In the Layers panel, click the Add Layer
Mask icon. A white layer mask thumbnail will appear next to the layer’s pixel
thumbnail.

Notice that there are bracket marks surrounding the corners of the layer mask thumbnail. This means that your painting will affect
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the layer mask, and not the pixels in the layer.
If the brackets are around the main thumbnail, you will be painting on the pixels. Click
any layer mask thumbnail to make sure you are
painting onto the mask and not the pixels.
3. In the Tools panel, select the Brush tool.
4. In the Tool Options panel, click the Brush
button to show the Brush Preset picker.
5. Check to see that the hardness is set to 0%.
Hit the Return key to close the picker.
6. In the Tool Options panel, set the opacity
of the brush lower—somewhere around
30% will do.
7. Make sure the foreground color is black.
You can tap the D key to select the default
colors and the X key to swap foreground
and background colors.

TOP: Applying the Fibers filter.
BOTTOM: Rotating the Fibers
layer.
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TOP: Add a Layer Mask
with the icon at the bottom
of the Layers panel, and
paint the mask black to hide
pixels instead of erasing.
BOTTOM: With the Brush
tool selected, the Tool
Options bar allows you
to use brush presets and
specify opacity. The black
and white color chips near
the bottom of the Tools
panel indicate the selected
foreground and background
colors.
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8.	Use the square bracket keys to change the
size of the brush. ] makes the brush larger,
and [ makes it smaller.
9. Stroke and release the mouse button
repeatedly to hide the effect in parts of the
image. The effect will build gradually.

If the effect goes too far, you can reverse it
by painting over the area in white. If your foreground colors are black and white, just tap the
X key to swap to white, and paint over the mask
as needed. After that, you can tap the XÂ€key to
go back to black and continue hiding the effect
as needed.

The fiber pattern in the overlay mode vanishes in the shadow areas,
but needs to be masked out of the upper left corner of this image.

More on Masks Simply put, a layer mask is

then add a new adjustment layer or add a layer

a bitmap that describes what partsÂ€ of a layer

mask to a pixel layer, the white parts of the

are visible, or what parts of an image will be

mask will correspond to the selected parts and

affected by an adjustment layer. The ability to

the rest of the mask will be black. Any areas

create and edit masks may be one of the most

that are partially selected will be represented

powerful features of Photoshop and is one of

by shades of gray. You can Command [Ctrl]-

the features that distinguish it from Lightroom.

click on a mask to load it as a selection. Channels are actually a special type of mask. You

The rule for masking is “black blocks”; in other

can load a channel as a selection, allowing you

words, wherever the mask is completely black,

to use the image itself to help you create pre-

the pixels will be hidden or the adjustment

cise masks and refine areas of the image.

does not apply. Wherever the mask is pure
white, the effect is applied 100%. If the mask

Once a mask is attached to a layer, there will

is any shade of gray in between, the effect is

be times when you want to see where the

applied partially.

mask is affecting the layer, what the mask
looks like, and what the image looks like with-

Selections can become masks, and masks can

out the mask. Photoshop has features to help

become selections. If you make a selection and

you visualize masks in a number of ways.
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1.	To view and edit a mask directly, hold the
Option [Alt] key down and click on the
mask thumbnail. Photoshop will display
the mask instead of the image, and you
can edit the mask the same way you do
any pixel layer. Option [Alt]-click on the
mask thumbnail again to return to normal
viewing.
2.	To view a mask as a colored overlay,
hit the \ (backslash) key. The default color
is bright red at 50% opacity. This rarely
needs to be changed, but there is a preference for it. Hit the \ (backslash) key again
to return to normal.
3.	To temporarily disable a mask, hold the
Shift key down and click on the mask
thumbnail. A red X will appear through
theÂ€mask, and the mask will have no effect.
Shift-click the mask thumbnail again to
restore its functionality.

Create a Double Exposure
Effect
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Double exposure can produce a dramatic and
somewhat mysterious effect that moves away
from the literal transcription of an object or
person and into the realm of dreams. If you
have ever tried to emulate double exposure
in Photoshop, you have seen that it is more
complicated than placing one image over the
other and lowering the opacity of the top
layer. AÂ€double-Â�exposed image is not a simple
overlay of the two exposures; instead, the two
images in a double exposure actually interact.
In essence, the highlights of the first exposure
punch through the details of the second exposure, and the second exposure registers most in
the shadow areas of the first exposure.
So, to simulate double exposure in Photoshop, the tonality of the bottom layer hasÂ€ to
serve as the template for a layer mask that hides
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parts of the top layer. The effect works best when
the base image has strong contrast and one or
more areas that contain dense, dark tones. An
example follows.
1.	Open the image that will act as your base
image.
2.	Open the image that will act as the second
exposure.
3. Holding the Shift key down, drag the second exposure image onto the base image.

When you release the mouse button, the
second image will snap into alignment with the
first on the canvas.
4. Click the eyeball icon on the top layer to
temporarily hide it.
5. Go to the Channels panel and hold down
the Command [Ctrl] key and click the
RGBÂ€channel. The “marching ants” pattern
indicating an active selection will appear.

Command [Ctrl]-clicking the RGB channel is a shortcut for loading a selection based
on the tonality of the image. That means that
the brightest parts of the image will be most
selected, and the darkest parts will be least
selected. That’s the inverse of what we want.
We’ll deal with that next.
6. Choose Select > Inverse from the menu bar.

Now, the darkest parts of the image are
most selected, and the brightest parts are least
selected.
7. Go back to the Layers panel and click on
the top layer to select it.
8. Click on the Add Layer Mask icon at the
bottom of the Layers panel.
9. Click the eyeball button to reveal the
double exposure.

From this point, there are several additional
tweaks that can be applied.
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The layers panel shows
the top layers with its
Â�visibility turned off. Holding
down the command key
and clicking on the RGB
channel selects areas of
the image based on their
tonality.

• If needed, you can decrease the
superimposition of the top layer by
Â�decreasing its opacity.
• Generally, the problem will be that your
layer mask is not dense enough, but if it is
too dense, you can click on the Masks panel
and decrease its density.
• You can adjust the contrast of the layer
mask, making the blacks denser or
Â�driving the highlights brighter.

1. Click on the layer mask thumbnail for the
top layer. You will know that it is selected
because angle brackets will surround the
four corners of the mask thumbnail.
2. Select Image > Adjustments > Curves from
the menu bar.
3. Adjust the curve and watch the image
change. Try any of these adjustments: slide
the black point or white point along the
bottom, or push the black point up the left
edge of the curve, or pull the white point
down the right edge of the curve.
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Creating double exposure effect.
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TOP: Click on the layer mask to select it. Brackets will appear
around the mask to indicate that it is active for editing.
BOTTOM: The Curves dialog, ready to adjust the tones in the mask.

4.	When you have a result that is satisfactory,
click OK.
5.	That last move altered the pixels in your
mask. If you don’t like the result, use undo
or step backward in the history panel to
revert.

• You can adjust the contrast of the top
layer, separately from the bottom.

1. Hold the Option key down while you select
Curves from the Create New Fill or Adjustment Layer icon at the bottom of the
Layers panel.
2.	When the New Layer dialog opens, check
the box marked Use Previous Layer to
Â�Create Clipping Mask. This makes the
curves adjustment apply to only the top
layer.
3. Click OK.
4.	Watch the effect as you adjust the curve
in the Curves panel. Use a preset, drag the
points, or start with a preset and modify it.

The Layer Blending Options control provides a second, slightly less flexible way to blend
layers based on the tonality of either layer.

1. In the Layers panel, click on a layer to
select it.
2. At the bottom of the Layers panel, press
the mouse button down on the fx menu
and select Blending Options.... A dialog will
appear.
3. In the section marked Blend If, leave the
menu set to the default (Gray).

183

TOP: Adding a curve with a clipping
mask. Note the indicator next to the
layer thumbnail.
BOTTOM: The fx menue icon allows
you to apply layer styles and control
Â�blending options for the layer.
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4. Move the black point or white point slider
for either layer to determine which parts
break through.

The sliders have two parts. To break them
apart, hold down the Option [Alt] key and
click on one side of a slider, then push it away.
Moving the two halves separately creates a
more gradual transition for the blend.
5. Click OK when you have a satisfactory
result.

A Cubist-Inspired Image

The main idea behind this example is to demonstrate some ways of making a photograph
look more “painterly” by evening tones and
selectively layering effects. It is more of a starting point for exploring such techniques than a
definitive approach.

1. In the Layers panel, duplicate the background layer by dragging it to the Create
a New Layer button at the bottom of the
panel.
2. Select Filter > Other > Maximum … from the
menu bar. A dialog will appear.
3. Choose a radius that creates an interesting
effect, and click OK.
4. Select Filter > Noise > Median … from the
menu bar. A dialog will appear.
5. Choose a radius that creates an interesting
effect, and click OK.

At this point, we have an image that looks
somewhat like it was painted. We’ll add back a
little bit of the original texture to create a cross
between painterly and photographic.
The starting image and a finished example.
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Drag the background layer thumbnail to the create a New Layer
icon to make a copy.

â•›6. In the Layers panel, drag the background
layer to the Create a New Layer icon to
create a second copy of the background
layer.
7. In the Layers panel, drag the new background copy layer to the top of the layer
stack. Make sure the new background copy
layer is selected.
â•›8. Select Filter > Other > High Pass … from the
menu bar. A dialog will appear.
â•›9. Choose a radius that shows some edge
detail but not enormous haloes,
e.g., 12.5Â€pixels.
10. Click OK to apply the effect.
11. In the Layers panel, change the blending
mode for the High Pass layer to Overlay.
â•›12. In the Layers panel, drag the High Pass
layer to the Create a New Layer icon to
duplicate the layer.

Duplicating the overlaid High Pass layer
strengthened the effect. We’ll group the High
Pass layers so that they’re a bit easier to work
with.
13.
â•› Hold the Shift key down and click on the
layer thumbnail of the first High Pass layer
so that both are selected.
â•›14.	Use Command [Ctrl] + G to create a
newÂ€group containing the two High Pass
layers.

Adding a mask to the group will allow you
to apply the overlay effect selectively.
â•›15. In the Layers panel, click on the Add Layer
Mask icon at the bottom of the panel.
AÂ€layer mask thumbnail will appear on
theÂ€group.
186

â•›16. Paint in black using a brush with a hardness of 0% and varying opacities to remove
part or all of the overlay effect in different
parts of your image, leaving texture only in
selected areas.
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Steps 2 and 4: Applying the Maximum filter creates squarish
Â�highlight areas. You can smooth that effect by applying the Median
filter,

Note: If you think the texture is too strong,
reduce the opacity of the group.
The image that we have at this point is good
in its own right, and you can save a copy, if you
like, allowing you to take the image in several
directions from here. The next step is to add the
elements that are inspired by Cubism.
For the next step, we need to combine all
the elements into a single layer. Instead of flattening the image and losing all the layers, we
will stamp a composite layer that contains the
combined result of all the layers below. We’ll
work with the stamped layer from then on. To
stamp a layer, do the following:
17. In the Layers panel, click on the topmost
layer to select it.
18. In the Layers panel, click the Add a New
Layer icon. A new blank layer will appear at
the top of the layer stack.
19. Hold down the Option [Alt] key and select
Merge Visible from the flyout menu in the
upper right corner of the Layers panel.
Don’t release the Option key too early, or
your image will flatten instead of stamping.

Now, we’re ready to create the Cubist-inspired elements.
20. Select View > Show > Grid from the menu
bar.
21. Hold down the View menu, and check to
see that Snap is checked. If not, select
ViewÂ€> Snap.
22. In the menu bar, pull down the View menu
and slide the cursor down to View > Snap
To, but don’t release the mouse.
23. Check to see that a check mark appears
next to Grid; if not, select View > Snap To >
Grid from the menu bar.
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TOP: Step 7: The Background Copy layer in position for the High
Pass filter.
BOTTOM: Step 8: The Background Copy layer with the High Pass
filter applied.

24. In the Tools panel, select the Rectangular
Marquee tool.
25. Drag a selection that isolates an interesting
part of the body. The selection will conform
to the grid.
26.	Use Command [Ctrl] + J to create a new
layer with the selected pixels.
27. In the Layers panel, press the mouse button
down on the fx menu at the bottom of the
panel to reveal the layer styles menu and
choose Inner Glow. A dialog will appear.
28. In the dialog, click the colored square in the
Structure section of the dialog to select the
color for your glow.
29. Set the Blend mode to Multiply, Technique
to Softer, and Source to Edge.
30.	Experiment with the other sliders to find an
effect that works for you.
31. Click OK to commit the changes.
32. Select View > Snap from the menu bar to
temporarily turn off snap to grid.
33. Select Edit > Free Transform from the menu
bar. Handles will appear around the slice.
34.	Rotate, skew, or reposition the slice as you
like. As an option, you can Control-click
[right-click] inside the handles to show a
menu and use one of the other transformation modes.
35. Hit the Return key to commit the
transformation.
36. Select View > Snap from the menu bar to
switch snap to grid back on.
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Repeat steps 24–35 above as many times as
you like to create more cutouts. You can simply use the Move tool to reposition elements
without transforming them. Use Command
[Ctrl] + H to hide or show the grid lines.
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Select two or more layers and use Command [Ctrl] + G to place
them in a new group.

Filters and 16-Bit Mode A number
of Photoshop’s filters are only available
in 8-bit mode, which presents a small
problem if you are working in 16-bit and
want to use them. The temptation is to
convert the file to 8-bit so that the filters
are available and then switch back to
16-bit mode afterward, but that doesn’t
work. When you switch to 8-bit, data are
thrown away, degrading the image, and
switching back to 16-bit does not restore
the data that were thrown away.
The best thing to do is to make a copy of
the file and convert that to 8-bit. You can
run the filter on the copy and then convert it to 16-bit and combine the layer
back into your composition.

Color Management

Color accuracy is at least somewhat important to most artists who work in color, and it
is extremely important to some. Using a colormanaged workflow can give you a high degree
of confidence about color fidelity when you
Â�display your work or print it.
Digital color is essentially a variation on
paint-by-numbers. Every pixel in an image is
tagged with RGB numbers that are supposed
to represent specific colors, but those numbers
are only one part of the equation. The other
part of the equation, and the part that’s critical
for accurate color, is the color profile. When an
image is tagged with an accurate color profile, 189
devices that use color management can ensure
that we see the correct colors. If the image has
no profile, all bets are off, and if it has the wrong
profile, the colors are guaranteed to be wrong.

For color management to work, it’s also critical that you have accurate profiles for your displays and for your printers. In fact, every printer
has a different profile for each type of paper that
you can print on. With accurate color profiles
for each device in the post-production chain,
the color management system ensures that the
color you see is the color that was intended.
However, there is a catch. When a device
can’t print or display a certain color, we say that
color is out of gamut, and color management
uses a strategy called a rendering intent to deal
with those colors. The relative colorimetric rendering intent replaces each out-of-gamut color
with the nearest in-gamut color, while the perceptual rendering intent tries to maintain color
relationships and gradients by compressing the
color space of the image to a set of colors that
are all in-gamut. With relative colorimetric,
the color of the overall image doesn’t shift, but
TOP: Step 16: A layer mask applied to a group.
The back areas of the mask hide the effect
completely, and the gray areas partially hide the
effect.
BOTTOM: Hold the Option key down and
choose Merge Visible from the menu to stamp
a composite of all visible layers. If you don’t hold
the Option key down, the layers will flatten.
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Step 20: Use View > Show > Grid in conjuction with the Snap
Â�feature to aid in selecting portions of the image.

Converting from a small space to a larger space
(e.g., sRGB to Adobe RGB) is less of a problem than going the other way, but it’s best to
convert as little as possible.
Display Profiles

Profiling your monitor is the most important
thing you can do for a color-managed workflow.
If your monitor is not representing color accurately, then any adjustments in color you make
are arbitrary, and you stand a chance of making
things worse, not better. With an accurate profile,
the color management system will make sure that
you are seeing the color that was intended, as long
as it is in-gamut. More on that in a moment.

thereÂ€is a risk that some gradients can become
posterized. Perceptual compresses the color
space by altering even some in-gamut colors,
often resulting in a noticeable color shift.
Neither rendering intent is a one-size-fitsallÂ€solution. For critical color output (particularly when printing), it’s important to run tests
using each rendering intent to see which works
best in that specific case. Because the relative
colorimetric intent clips colors, it’s potentially
most problematic when you convert between
ProPhoto RGB and sRGB.
Working Space Conflicts

Whenever you open a file that is in a different
color space than the working space you selected
in your color settings, Photoshop offers to convert the color space for you. It’s generally best
not to convert. Each time you convert the color
space in a file, you run the risk of degradation.

Profiling tools like the i1 Display from
X-Rite sell for less than $200. The i1 is a small
puck-shaped sensor that hangs over your LCD
display and measures the colors that it sees.
Software that comes with the i1 sends a series
of color patches to the screen to measure how
accurately it displays those colors, and then
builds a profile. Devices in this class are based
on sensor technology that resembles the sensors in a camera or scanner.
More accurate profiling tools are based on
a spectrophotometer. These were much more
expensive devices until X-Rite introduced the
ColorMunki Photo system, which has a suggested retail price of $500. The unit can create
print profiles as well as monitor profiles, and it
is simple to use. The software has two modes:
easy and advanced. It’s best to use the advanced
mode, because it has the option to create profiles based on your display’s native white point.
The easy mode uses the D65 white point,
which tends to look a bit bluish. If you work in 191
the pre-press industry, D65 is important, but
it’s not the best standard for evaluating images
that will eventually hang in galleries or on living room walls.

Step 27: Use the fx menu to add an innner glow efffect to the new
cubist element.
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Advanced mode also has an option to set the
optimal brightness and contrast of your monitor, which is a good idea. Many displays have no
contrast controls, and you can skip that when it
comes up in the software. In advanced mode,
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the ColorMunki software also has the option
to set the luminance of your display based on
ambient lighting conditions. That option is best
used only in settings where the light is well
controlled and relatively subdued.
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TOP: Step 34: Control-click (right-click) inside
the transform handles to change the mode of
transformation.
BOTTOM: The Embedded Profile Mismatch
dialog allows you to decide whether to
Â�convert to the working space when you open
a file that is in a different space.
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Profiling a display with ColorMunki. The advanced options allow you to optimize brightness and use the native white point of the display.

Mac OS X has a button marked Calibrate …
in the Displays system preference. A similar tool
for Windows users is Adobe Gamma. These tools
can easily produce results that are worse than
not profiling your display at all, and they are not
recommended.
Profiling doesn’t make all displays equal, and the
quality of your display can make a big Â�difference
in the results you get. Simply put, laptops are
not great for image editing, mid-range cinema
displays are a good value that are excellent for
general-purpose image editing, and high-end
displays are primarily for color pros.

Apple LED Cinema Display. A second issue
is that the appearance of an image on a laptop
monitor changes dramatically as your angle of
view toward the screen becomes more oblique.
Even when viewing the screen slightly off-axis,
the colors and tones begin to change. A third
problem is the newer glossy screens, which
boost contrast to a point where dark tones
are exaggerated. Glossy screens are also much
more reflective, meaning that reflections and
ambient lighting conditions can be a problem.
The limitations of working with laptop screens
illustrate some of the qualities that differentiate
better-quality monitors: edge-to-edge uniformity,Â€viewing angle, and gamut.

Laptop monitors are problematic for colorcritical work. The first issue is that the color
gamuts of laptop screens are significantly
smaller than those of desktop displays like the

Many laptops make it extremely easy to
connect a desktop monitor to them, and many
can be set so that the two screens work independently. With that configuration, you can

Displays
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Avoid using the Display
Â�Calibrator Assistant in Mac OS X.

run Photoshop on a wide-gamut screen of its
own, and keep everything else on the laptop
screen. Working with two monitors is great,
regardless of the configuration; adding a second monitor to your desktop tower produces
a great working environment as well. The display built into an iMac is essentially a desktop
display with a color gamut that is superior to
a laptop display. The caveat is that iMacs have
glossy screens.

It is worthwhile to invest in a screen that is
large enough to give an uncluttered view of a
substantial portion of your image at print resolution, and mid-range monitors will display
even middle tones more accurately. A 24-inch
display such as the Apple LED Cinema display
can show virtually the full area of a 13 × 19
image at print resolution. For about $900, you
will be able to get much better results in both
printing and preparing images for the web.
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Color space comparisons. It’s not simply a matter of relative size of the spaces; it’s a matter of which colors are available. Epson can print a lot of
colors that can’t be seen on a monitor. Clockwise from upper left: 20" Apple Cinema vs. Adobe RGB, MacBook Pro vs. Adobe RGB, MacBook Pro
vs. 20" Apple Cinema, Epson 2880 + Ultra-Premium Luster @ Photo vs. 20" Apple Cinema.
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In some circles, monitors that can display
90% or more of the Adobe RGB color space are
practically treated as fetish objects. The 22-inch
Eizo ColorEdge CG222W is more reasonably
priced than larger screens in the line and some
of its predecessors, but it still costs more than
twice the price of an Apple 20-inch Cinema
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Display. The strength of the wide-gamut monitors is their ability to display highly saturated
colors and show shadow detail. In pre-press situations where the cost of running color proofs
can add up quickly, a wide-gamut display will
easily pay for itself. In other settings, the benefits of these displays are not as cost-effective.
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Ambient lighting is also an important issue
in doing color-accurate editing work. It’s best to
work in slightly subdued light, and try to keep
that lighting as consistent as possible. Avoid
working in a place where a light source is aimed
at your screen. As we have seen elsewhere in
this book, the intensity and color temperature
of sunlight change during the course of the day,
so it’s best to avoid daylight illumination.
Printing

Accurate profiles ensure that your printer is
printing the right colors. It is worth repeating that for a given printer, each combination
of ink and paper has a different color profile.
Printer and paper manufacturers generally
offer free printer profiles on their web sites, but
the quality and accuracy of these vary greatly.
If you bought an Epson printer, the profiles
that shipped with the unit are okay, but Epson
America posts better profiles on their web site.
For their new Exhibition Fiber paper, Epson
refers customers to high-quality profiles built
by Pixel Genius.
To use a printer profile, store them in a
Â�particular directory on your computer. If you
areÂ€working on Mac OS X, you can put them
either in /Library/ColorSync/Profiles, or /Users/
<username>/Library/ColorSync/Profiles. If you
are on Windows XP or Vista, place them in\
Windows\system32\spool\drivers\color.
Custom profiles often produce much better results than many canned profiles, especially
those from paper manufacturers. The printer
profiling feature in ColorMunki photo makes
high-quality profiles and is easy to use. It works
by printing out a color target that you let dry,
then scan with the ColorMunki. That builds
your basic profile. From there, you can refine
the profile by printing out color targets that are
based on the colors in specific images. So if you
are shooting outdoor nudes, you can use photos
that have a lot of sky, skin, and foliage colors to
tweak your profiles.

You can also have custom profiles built for
you. Companies such as Cathy’s Profiles and
Dry Creek Photo will send you a file to print
and instructions on how to print it out. You
send that print back to them, and they build
the profile for you. If you need profiles for only
one or two types of paper on one printer, this
can be a reasonable option, but most of these
services charge anywhere from $50 to $100 per
profile, so it is easy to spend hundreds of dollars
on custom printer profiles.
With quality printer profiles installed, making an accurate print with Photoshop is a pretty
straightforward affair.

1. Select Image > Image Size … from the menu
bar. A dialog will appear.
â•›2. Make sure Resample Image is unchecked.
3.	Enter an appropriate width or height for
your image. The other dimension will
beÂ€constrained. For example, a good height
for printing on a U.S. letter-sized page
(8-1/2 x 11) would be 10".
4. Check the pixels per inch that result. If the
resolution is well below 240 ppi, then you
need to resample your image for highÂ�quality output.

A 10-megapixel image can be printed 16
inches wide at 242 ppi, so you won’t generally
need to resample for printing.
5. Click OK.
6.	Optional: flatten your image before printing. This can speed up the printing time.
Make sure not to save this flattened file,
though!
â•›7. Select File > Print … from the menu bar. The
first print dialog will appear.
8. Be sure the printer you wish to use is
selected in the menu at the top of the
dialog.
9. Click the Page Setup button.

197

10. Select the printer and paper size you wish
to use.
11.	The rest of the page layout settings are
optional.
12. Make sure the menu at the top of the
right side of the dialog reads Color
Management.
13.	The circle next to Document should be
filled in.
14. Set the Color Handling menu to Photoshop
manages colors.
15. Select the appropriate printer profile.

Note: Most printer profiles are named according to the convention <printer name> <paper>
<resolution>.icc. For example, SPR2880 UPrmMtte Photo.icc translates to an Epson Stylus
Photo 2880 using Ultra-Premium Matte paper
with a print quality setting of Photo (1440
dpi). The names of profiles from different
sources vary a little, but they typically follow
this format.
16. Choose a rendering intent: either relative
colorimetric or perceptual.

Note: See the discussion of rendering intent
earlier in this chapter.

You can change print size without resampling,
which can degrade the image. Increasing the size
decreases the resolution, but as long as resolution is
approximately 240 ppi or greater, you won’t need to
resample.
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17. Make sure Black Point Compensation is
checked.
18. Click Print…. The second print dialog will
appear.

The first print dialog was Photoshop’s print
dialog. The second dialog belongs to the printer
driver and will vary, depending on the make
and model of printer you are using and on the
operating system you are running. The example
here is with an Epson Stylus Photo R2880 on
Mac OS X version 10.5.
19. Select Print Settings from the menu in the
center of the dialog.
20. Select a media type that corresponds to
the type of paper you are using.

If you are using a non-Epson paper, you
won’t see the name of your paper here. Just
choose the one that describes a paper most like
the one you are using.
21. Choose color or grayscale.

The Advanced B&W Photo option allows
you to colorize your image in the print driver.
It’s better to apply those effects in Photoshop
and use a color-managed workflow.
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Printing with Photoshop color management depends on selecting the right high-quality color profile. The contents of the profile menu will vary,
depending upon which color profiles have been installed on your computer.
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22. If you’re printing from a 16-bit file, be sure
16 bit/Channel is checked.
23. Make sure the Color Settings menu reads
Off (No Color Adjustment).

That setting is crucial. If you leave it on,
the print driver will attempt to color-correct
the color-corrected information coming from
Photoshop. This generally results in prints that
have a strong magenta cast.
24. For Print Quality, make sure you select the
setting that matches the profile you have
selected; e.g., if you selected a Photo (1440
dpi) profile, set the Print Quality to Photo—
1440 dpi.
25.	With newer printers like the Epson 2880,
you should be able to print with High
Speed checked.

When Photoshop manages colors, it is Â�important
that the printer driver’s color settings are
switched off.
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Fine horizontal lines in your prints can
sometimes be caused by high-speed printing.
IfÂ€you notice them, uncheck High Speed, and
see if the situation improves.
26. Press Print. Your image will now be sent to
the printer.
27. If you flattened your file in step 6, use the
History panel to restore your layers.

Graphics Tablets

A lot of editing techniques in Photoshop
involve tools that emulate brushes and pens,
which require a stroking motion to apply them.
A mouse, or worse, a track pad, does not give
the optimum feel or control for these tools.
AÂ€ tablet like the Wacom Intuous has a stylus
that rests in your hand the way a real pen or
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brush does. The tablet takes a little getting used
to, but once you get the hang of working with
it, many editing gestures become much easier.
Wacom tablets also come with a multi-button
wireless mouse, allowing you to switch off
between pen- and mouse-controlled activities.
Processing Power

The most important computing capabilities
for running Photoshop CS4 are RAM, video
RAM (VRAM), and a GPU-equipped video
card that supports OpenGL. Photoshop will
take advantage of 4 GB or more of RAM
and gets an additional performance boost
when youÂ€give it 512 MB of VRAM. Certain
features in Photoshop CS4 are only available
when your machine is equipped with a video
card from companies such as NVIDIA and
AMD/ATI.
It is plausible that a few filters will run faster
on an 8-core tower, but for the most part, there
is not a lot of difference between running Photoshop on a high-end tower and running it on a
laptop with a 2.5-GHz core duo processor.
Backup

If you read the stories of enough photographers,
you will find that many have lost substantial
portions of their life’s work to fire, flood, or
some other disaster. In the digital realm, fire
and flood are still potential hazards, but a far
more likely disaster is a hard drive crash. In fact,
it’s not a question of whether your hard drive
will fail; it’s a question of when. It has been said
that if you don’t have two copies of your digital files, they don’t really exist, and that underÂ�
scoresÂ€how essential backup is.
There are two strategies for backing up files,
which offer a broad safety net when combined.
The first is mirroring your files, and the second
is a regimen of incremental backups. Mirroring
your files is simply duplicating them on a Â�second
storage medium. You can do this by manually

copying them, or you can use a backup utility,
but the most foolproof way to mirror is to use a
RAID system set to level 1.
If you copy your files to separate media and
store them, it is a good idea to create an indexing system so that you can easily retrieve the
files when you need them. Some backup utilities make managing the indexing a bit simpler.
If you are backing up to CDs or DVDs by
hand, you have to cluster your files so that they
fit the media. Ideally, you don’t want to leave
too much free space, and you won’t be able to
burn the disc if you have too many files. Backup
utilities will typically take care of allocating files
for you.
RAID stands for redundant array of independent drives, and there are several levels or
modes of configuration. Level 1 does mirroring, and other levels are for faster performance.
When you save a file to a RAID system configured to level 1, it is automatically saved on two
separate drives. If one of the drive mechanisms
in a level 1 RAID fails, you simply replace the
failed mechanism and the system will rebuild a
new mirror image on it. With a Â�mirroring RAID,
the second mechanism is invisible to your computer, and it appears as one drive. These systems
are generally rated based on the total amount of
storage in the drives, so a 1TB RAID system set
to level 1 offers 500 GB of storage.
A number of manufacturers now sell reasonably priced plug and play external RAID
systems that hold one or more pairs of drive
mechanisms in a single housing. The controller inside the enclosure handles the mirroring,
meaning that there is no load on your computer’s processor. Different models can attach via
USB 2.0, Firewire, or eSATA interfaces. There
are also network RAIDS that can be shared 201
over Ethernet, meaning that they can even be
accessed by WiFi. The G-Technology G-Safe
line and the La Cie 2-Big line are examples of
external and network RAID systems.

Mirroring provides insurance against drive
crashes, but it doesn’t protect you from a situation where a file has been inadvertently flattened, re-sampled, or damaged. Some backup
utilities, including Apple’s Time Machine (built
into Mac OS X 1.5, a.k.a. “Leopard”), make
incremental backups. This backup strategy copies only the files that have changed or have been
added since the last backup, capturing snapshots
of your work in process. Incremental backups
allow you to recover in the case where you discover that a file that was fine prior to your last
backup is no good now. The key to success with
such systems is having the discipline to run the
backups in a timely and routine manner.
What’s the ideal arrangement for storing
your working files and backups? Put your working files on a large RAID level 1 drive and do
incremental backups to a second RAID level
1 drive. As a final bit of insurance, periodically
copy all critical files to a freestanding hard drive
that is stored off-site.
Backups are only as reliable as the media they
are stored on. Burnable CDs and DVDs can be
susceptible to degradation, especially from UV
light. Blu-Ray DVDs are reputed to be more
archival than the original burnable DVDs. For
greatest longevity, regardless of the media you
use, your backup discs should be stored in acidfree plastic containers in a cool, dry, dark place.
Avoid marking your discs with solvent-based
marker pens like the Sharpie. The ink’s solvent
can attack the surface of the disc and cause
deterioration. Delkin is one company that is
making solvent-free pens for marking CDs.
There are cases where CDs have degraded in
as little as three years, and most burnable DVDs
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are even more prone to degradation than CDs.
This is because the burnable part of the CD is
an organic dye that can break down and fade,
ultimately making the disc unreadable. CDs
and DVDs also have a reflective metal layer,
and that reflective layer can oxidize, causing the
disc to fail.
Better-quality CDs will tend to last longer, but if you want to be assured that your
media is more reliable, Delkin is one manufacturer that makes a line of CDs and DVDs
that are rated to last 100–200 years or more.
The Â�Delkin Archival Gold CDs and DVDs use
gold metal for the reflective layer (gold doesn’t
oxidize) and use phthalocyanine dye, which is
much more stable than the cyanine dye used
in cheaper CDs. Mitsui Gold archival CDs are
also made with phthalocyanine dyes, and Mitsubishi manufactures CDs that are based on
extremely stable azo dyes. The azo-based discs
are blue, rather than gold.
Research carefully, though—some manufacturers have added coloring agents to their
conventional discs to mimic the appearance
of archival discs; color alone doesn’t tell the
whole story. Archival CDs are now easier to
find in stores. It has been clear all along that
DVDs were less archival than CDs, but the
validity of archival CDs was contested until
recently.
Archiving onto CDs or DVDs, especially
manually, can be tedious and take a lot of time.
As the price of hard drives continues to drop, it
makes increasing sense to simply use an extra
hard drive for backup. You connect it to your
drive chain, copy your files onto it, then disconnect it and put it away for safekeeping.
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Interviews
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T

he interviews in this chapter give a brief glimpse into
how a few artists make their work. Through the course
of this book, we have broken down photographs of the
nude into an array of conceptual and technical elements. It’s
time to look at the different ways that various artists put those
elements together to create strong work with a distinctive
voice. Questions were selected and tailored for each artist
and designed to explore the ideas and process behind their
work, enquiring into background, philosophy, aesthetics, and
how they shoot. Vision and craft come together in very different ways for every artist—this is not a one-approach-fits-all
proposition. Their ways of making their art are as different and
unique as their personalities.

Nine exceptional photographers from around the world—Barney
Cokeliss, Robert Gregory Griffeth, Nina Pak, Saelon Renkes, Pascal
Renoux, Pet Silvia, Tobias Slater-Hunt, Harvey Stein, and Mayumi
Yoshimaru—generously participated in e-mail interviews for this book
but there was not enough room to print all of them. You can read the
remaining interviews and browse additional resource materials on the
companion web site, www.TheNakedAndTheLens.com.
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Interview with Barney
Cokeliss (www.
BarneyCokeliss.com)

Barney Cokeliss grew up in London and was
shooting record covers and book jackets as a
photographer before he left school. He studied
English Literature at Oxford and spent a year
at Princeton in the Film and Creative Writing departments before winning a place on the
prestigious BBC TV training scheme.
His directing career began with “Tea,” a
short commissioned by MTV Europe, which
went on to be the shortest film selected at Sundance. Barney then wrote and directed “Queen’s
Park Story” for BBC 2’s 10 x 10 strand. The
Observer called it “the best British drama on
television this year.” It was in the official selection at the Venice Film Festival and won Best
Director at Toronto.
Barney is represented by Ridley Scott Associates for commercials, and by United Agents for
film and television. He has directed Â�commercials
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for clients such as Volkswagen, Lexus, Typhoo,
Toyota, and BMI Airlines. His films for the
National Health Service have won advertising awards year after year and his Â�safe-sex film
“Spoiled” was voted Scotland’s Favourite Ad.
Last year, Taschen America published
Â�
Barney’s
photographic nudes alongside Jan
Saudek’s and Terry Richardson’s. His portrait
subjects have included Gil Scott-Heron, Ravi
Shankar, John le Carré, Ray Liotta, and Jacques
Derrida among many others. A monograph of
his nudes is in preparation.
Barney is currently finishing a new short
film for Hill Holiday in New York, sponsored
by Liberty Mutual, and has two feature films
in development: one original and one based on
a short story by the celebrated British author
J.G.Â€Ballard.
Q: You have a lot of commercial work
andÂ€ portraiture in your CV. How does your
experience of making that work affect the way
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that you approach shooting nudes, and what
impact do your nudes have on your commercial
work?
I moved through portraiture to nudes—
a lot of my early work was of famous people
and making nudes was a way of getting around
the focus on the individual that’s inherent in
portrait photographs of eminent people. At the
same time, I like my nudes to feel in some way
like portraits—I don’t want the model to seem
anonymous or just there to provide a body or an
abstract form—but portraits of people whose
identity isn’t known. Portraits and nudes are on
the same spectrum for me—essentially the fascination is in taking pictures of people and of
human situations. I still love both.
As for my commercial work, that’s mostly
moving image so it doesn’t relate directly to my
photographs. I’d love a commercial brief that fit
the style of my nudes, but often the commercials have another focus—comedy, storytelling
and so on. Maybe the closest I’ve come in my

commercials to the look of my nudes is a safe
sex ad I shot for the NHS (National Health
Service) in Scotland: there’s a contemplativeness in that one that has something in common
with my pictures.
Q: Your images seem to have a very strong
sense of subtext. Is that a result of the discipline
of filmmaking? Are there specific story lines
driving your images?
I love images that imply a narrative, even if
it’s not clear what exactly the story is. The tension between feeling there’s a story there and
not being able to say for sure what it is can be
a real force in an image. This preference may
beÂ€related to my film work, though in film the
aim is usually to tell a story, not just hint at
one! Painters like Kitaj and photographers like
Â�Lorca-Di Corcia are certainly an influence in the
kind of suspended narratives they conjure. As
for the parallel with film, I find it really exciting
that, say, “The Piano” was apparently inspired
by a photograph. But sometimes “cinematic”
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can be too obvious an effect for a photographer
to aim for—unless you’re Cindy Sherman and
you’re subverting the whole thing. I suppose
my photography keeps my film-making image
conscious, and my film-making keeps my photography aware of narrative. What I don’t do
is work out elaborate plots which I try to represent in the pictures—I’m more interested in
leaving part of the story open to interpretation.
Photo-stories can be wonderful—I’ve loved
Duane Michals’ work since I first saw it as a
kid—but that’s a whole other thing.
Q: How would you say your photographic
consciousness has changed over time?
I think I started out, like a lot of beginner
photographers, very focused on composition
and form. Over time I’ve got more interested
inÂ€atmosphere and implied story and let the compositional elements become more submerged.
IÂ€think a good photograph has to be interestingly
composed, but it doesn’t have to make a big deal
out of it.
Q: Did Duane Michals or some other photographer inspire you to pick up the camera?
Drtkol and Duane Michals were probably
the two photographers that most impressed me
when I was first picking up the camera—they
don’t have much in common! Cartier-Bresson
is unavoidable too—I spent a few of my teenage years taking pseudo-Cartier-Bresson portraits of all my friends.
Q: How much pre-visualization goes into
your nudes? Do you go so far as to sketch or
storyboard what you plan to shoot? How much
do improvisation and “happy accidents” figure
into your work?
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It varies. I always spend some time thinking about what I want to achieve from a shoot,
and I have a bank of references for poses and
situations that I’d like to explore. But I spend
a lot of time trying to work against anything
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that looks posed. Often it’s the position the
model takes between rolls of film that I end up
focusing on. So in that respect I try and find a
little bit of documentary in what is essentially
an artificial situation. One reason I don’t tend
to do sketches in advance is that my film work
is very thoroughly prepared—it has to be given
the number of people involved—and I like my
photography to be opposite to that.
Q: Still shooting all film? What type?
Medium format?
I only use digital as a prep tool—for casting
photos, location recces, etc. All my “real” picturesÂ€
are shot on film, and most are 6 x 7 or 6 x 9 cm.
Q: When and how do you decide that a
storyÂ€should be told as a still, or perhaps a series
of stills, rather than as a film?
Right at the beginning—I think the ideas
come from different parts of my brain. But,
now that you mention it, cross-pollinating them
might be a good idea!
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Q: When you shoot stills, are you thinking
in terms of capturing a single image? When
do you know that you have something that
works?
I certainly feel that I only need one successful image for a shoot to be success—sometimes
having too many from one shoot feels like a
waste as it’s harder to use them all without
seeming repetitive. But I try to leave space to
see what happens spontaneously, rather than
just homing in on one key shot. I can know very
early if I’m getting something that works—if
the model and the location are right then the
odds are very good. I rely a lot on casting and
locations, so when one or both is disappointing then it can be a struggle. The location
hasÂ€toÂ€have a tonality that lets me create some
Â�contrast (so many rooms have pale walls, which
make things much harder for me) and the
model has to have something truthful about
them—my biggest struggle is when the model
is too professional-seeming: I’m not interested
in pictures of models modeling.

Q: Light seems to be an important part of
your shots. Is everything lit, or do you rely on
available light? How much does the lighting
affect the amount of work you can produce in
a session?
I work with as little additional lighting as
possible. I’ve been lucky enough to work with
some of the great cinematographers (people
like Eduardo Serra) and I’ve learned that it’s
often a case of what you don’t add rather than
what you do.
Q: Has working with cinematographers
strengthened your ways of thinking or communicating about visual ideas?
Working with cinematographers can be
a wonderful dialogue—it’s a collaboration
you don’t really experience as a photographer.
There’s always a dual aspect to the dialogue— 211
it’s partly about story-telling and partly about
aesthetics. Good cinematography is when the
aesthetics are a key part of the storytelling, and
not merely decorative.

Q: Many of your photos have a look that
evokes the painted portraits of the likes of van
Dyck, and possibly Sargent. They also remind
me somewhat of Tina Barney’s photographs,
andÂ€ she has said outright that she was influenced by Dutch painting. Is this semblance
in your work the result of a conscious intent?
What would you say are your primary visual
influences?
My primary influences probably aren’t
directly comparable to my own pictures. I’m
certainly not trying to restage the masters.
Tina Barney’s work has a different texture to
mine but the way she presents people is very
interesting and unforced so I’m flattered by the
comparison. Aside from the people I’ve already
mentioned, I’d say Kirchner, Hockney, and
Modigliani are painters that I love. Photographers I’d mention are Drtkol, Goldin, Roversi,
Penn, Brandt. More recent enthusiasms for me
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have been the photographs of Bill Henson,
David Hilliard, and Eleanor Carucci.
Q: If your influences are not visible in the
look of your work, then your connection to
them is not about the surface. Can you say a
little more about some of the ideas that come
from these influences?
I think the biggest influence I get from looking at other people’s work is in expanding my
idea of what can make a photograph. It’s easy
to get caught up in your own spiral of obsessions, and seeing another photographer create
fascinating images from something totally different can free you up a bit.
Q: What do you think is the value of being
aware of your influences?
Being aware of your influences can help you
avoid merely aping them.
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Q: Your images seem to be set in pretty
affluent surroundings. Are you trying to make
a Â�particular statement or portray a particular idea? Is there a central theme uniting your
images?
There’s no statement in the location choice
whatsoever. The affluence of the surroundings is coincidental and the result of upmarket
hotel rooms of a certain sort being one of the
surest sources of mid-tone (or darker) walls,
deep colours, and a bit of window light. A lot
of my shoots are quite opportunistic—I’ll find
myself in a strange city with maybe one day
to spare and there won’t be time to do a big
location recce, so I often end up in a hotel. But
my mental list of locations to explore next is
hotel-free.
Q: So you’re free for a day, and you only
found out the day before—that’s usually how it

goes, right? How do you go about networking
to find models, makeup, etc. and put together a
shoot with such short notice?
I usually know in advance that I’ll have a
day that I can schedule a shoot for, so it’s not
all conjured instantaneously. My models are a
mixture of friends, colleagues, actresses, singers, and professional models. I’m lucky in that
I tend to have more people who want to model
for me than I have time to shoot.
Q: Can you describe the sort of direction
that you give to your nude subjects? Do you
direct your subjects for still shots in the same
way that you direct film actors?
I think the fundamental interaction is similar
in that you’re trying to relax people so that they
can give of themselves unselfconsciously. But
IÂ€don’t put my nude subjects through the kind of
exploratory, improvisational process that IÂ€ find
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works well for actors. Maybe I should. Then
again, I often find inexperienced models produce
the best results and they’ve usually got enough on
their mind doing their first photo shoot without
me throwing drama games at them.
Q: What do you think your sitters need
from you to give a great portrayal in front of
the camera, and how does one learn to be an
effective director?
Actors often tell me that they like working
with me, and hopefully they’re mostly sincere!
But it’s hard to know why or how you’re effective as a director as it’s quite rare to see other
directors or photographers in action. I think
I have good instinctive communication skills
with actors, so I don’t try to impose a system.
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IÂ€think actors need to feel simultaneously that
you know what you want but that you are
also open to what they want to try. With my
Â�photographs there’s an element of trying to
normalize an odd situation—the model is in a
strange place with someone they don’t necessarily know well, possibly taking their clothes
off in front of the camera for the first time. So a
large part of my direction is just maintaining a
normal, relaxed interaction. I’ve had some firsttime models move, in just a few minutes, from
apprehension about being naked to actually
forgetting that they’re naked and wondering
why passers-by look at them strangely if they
stand by the window during a break. I think
this has a lot to do with the atmosphere you
create.
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Interview with Saelon
Renkes (www.saelon.com)

My photos are most often about the kind of
world I want to live in. Photography gives me
a way to connect to this world—a world with
quiet places of beauty, places of wonder, places
that make me want to drink them in deeply—
and to share them with others. I’m in love with
the natural world, with the diversity in all its
forms of life (both plants and animals), and
with all the real people and real shapes within
it. I’m fascinated by the emotional range of the
human temperament, and by finding its reflections in the poses and expressions that people
take on naturally.
After getting a B.A. in Biology, I joined
the Peace Corps and lived in Guatemala for a
while, where I fell in love with travel as well.
I took photos all the time and became fascinated with the variety of human culture, but
then had a very bad accident. It was during
the time of surgeries and learning to live with
pain and physical limitations that I discovered

myÂ€art. Making art is an amazing process, hard
to understand or really describe. There are lots
of techniques to learn, lots of processes to figure out, and lots of studies to be made, but in
the end I find that all that stuff only helps one
to give the art a voice that is recognizable by
others. The art itself comes from somewhere
within and can scarcely be shaped or planned
in a fully conscious manner.
Ruth Bernhard has been one of my strongest
influences, and I’ve been particularly affected
by the theme of one of her books, The Gift of
the Commonplace. In her work this often refers
to commonplace objects, and in the workshop I took with her she challenged us to find
something beautiful to photograph within a
limited number of feet of our meeting room.
IÂ€love working this way, and I love to take this
same approach with photographing the human
body. Like many feminists who came of age in
the 1970’s, I came into photography with my
own biases about nude photography, and from
the beginning I wanted to pursue work that
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affirmed the beauty of ordinary human bodies,
rather than contribute to a process that would
further the insecurities the average woman has
about her own body. Perfect bodies are beautiful, and they are lovely to photograph, but when
IÂ€can find expressions of extraordinary beauty in
a completely real-world body is when I feel that
I am doing my best and most significant work.
I’ve studied photography, painting and printmaking with David Bayles, Ruth Bernhard,
Lucien Clergue, Steve Kiser, Alan May, Ted
Orland, Holly Roberts and Brian Taylor, in private workshops, at UC Santa Cruz Extension,
the Pacific Art League, and at Foothill College.
I’ve taught workshops for UC Santa Cruz
Extension, St. Mary’s Art Center and privately.
I’ve been exhibiting my work since 1994, on the
web and in galleries, and it has been included
in many private collections. I’m currently living
in Los Gatos, California (about 25 miles south
of San Francisco), with my husband, Steve
Fend (a USGS stream ecologist). I’m represented by The Main Gallery in Redwood City,
and I exhibit my work in other places when the
opportunity presents itself.
Q: How do your painting and printmaking
studies relate to or impact the photographic
work you produce?
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In addition to straight photography, I’ve
also studied oil painting (mostly on photographs, but with a little work on regular blank
canvas), printmaking (including monotypes,
linoleum block prints, and various etching
processes) and encaustic painting (beeswax on
various surfaces). These processes very much
enrich one’s vision, opening it up to new possibilities—even when you aren’t actually mixing these techniques with photography it still
opens one’s eyes a little more to colors, color
depth, compositions, and constructions. To date
the influence has been of that kind, as I haven’t
yet produced enough work mixing these additional media with Â�photography to have a body
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of Â�mixed-Â�media work to show—but I expect
that to happen somewhere down the road.
Studying these techniques also left me with
much deepened respect for those who can actually draw well. When combined with photography you can do quite a lot without being able to
draw particularly well as the photograph supplies as many of the lines as you wish, but that
can also be a trap, as it is all too easy to simply
slap something on top of the photo without
integrating the two media. If it means no more
than a bit of lipstick, then I think it detracts
rather than adds to the image.
Q: Your hand-painted and digitally manipulated images are clearly constructed; is there a
kind of construction that goes into your other
images, or are they more “readymade”?
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ever making it to the proof sheets (or folders
full of digital files). So much of good photography comes down to severe and careful editing, and pre-visualization is the first step in that
process. Even in the digital age, with so many
image adjustments possible, the final images are
always better if they’ve been created with the
right Â�values in the first place. OnÂ€the other hand,
I still do a fair amount of post-Â�visualization too,
and refuse to take on any sort of guilt over that.
The creative process doesn’t stop with the click
of the camera shutter. If IÂ€ can create a final
image that works, I don’t care if it is the same
thing IÂ€pre-visualized or not.
Q: How do you create narrative in your
pictures?

I’m afraid the answer here is both—many
are found images, while some are definitely
Â�constructed. I know some photographers feel
that they are bound to show the truth, the whole
truth and nothing but the truth, to make no
real changes in the material they photograph,
but this stricture has never been able to gain
a foothold in my own thinking. The only rules
I’m willing to follow are those that make the
image work and help it to say what I’m trying
to say. That said, I still admit that the majority
of my images tend to be found images. I think
that is the path of least resistance, and really,
there are so many wonderful images out there
just waiting to be discovered. Most of the time
all it takes is a really open mind.
Q: How much do you pre-visualize?
I do a lot of pre-visualization in the field and
in the studio. It is an extremely useful process
that saves time by making it far easier to get
the best print in the darkroom or at the computer, and also prevents a lot of garbage from

I wish I could lay this out better. Creating
narrative is something that I struggle to do
and yet have very little idea how to accomplish
effectively. I am a very intuitive sort of worker,
so even when I have a pretty specific idea to
work with I can only go so far with pre-planning
the layout. I try to plan out several approaches
with a few different layouts and lots of different
props as possibilities, then I bring in my models
and we set things up together, trying out different variations using all the ideas that come
up between us. By including the models in the
process the end result is often different from
what I first had in mind, but it always works
better than trying to force everything to fit my
initial vision. It can work especially well when
the narrative is something that is really part of
the model’s own story—though that is not a
necessity, it is really a great benefit when it does
work out that way and it makes for the simplest
process.
Q: How would you describe the relationship
between you and the sitter; can you say something about how you interact during a shoot?
I especially enjoy working with non-professional models—friends or acquaintances—
because they tend to bring more spontaneity
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to the photo sessions, and they are less likely
to offer me a repertoire of the same old poses.
They also tend to be more nervous about the
sessions at first—they may not be comfortable
with having me really look hard at their body,
or they may be shy about offering up poses or
thoughts. I work hard to establish some level
of comfort; I really don’t like to make people
uncomfortable in the first place, but also the
kinds of images I am trying to make almost
always require relaxation on the part of the
models. This is where the photographer really
needs to know what they are trying to achieve
though, as I have one photographer friend who
is completely the opposite—he is particularly
interested in capturing that very same discomfort that I am trying to banish.
As a general rule, I prefer to have models in
poses that are natural and comfortable to them,
and to be as at ease as possible. Photographs
always have a lot of the photographer in them,
and while I feel that when the model is ill-atease the photograph becomes even more about
the photographer and less about the model, it
isÂ€also possible that my preference has more to
do with my own search for emotional Â�comfort.
At any rate, I do try to help the model feel
comfortable and relaxed, and I like to sort of
experiment slowly until we find the poses that
come most naturally to the model.
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My usual process is to try to have a few
Â�
simple
ideas planned out to start the session
out, where I just tell them what I want them
to do, as a means of breaking the ice and giving
me a chance to see what their bodies are really
like. If I haven’t worked with the model before,
these are almost never the images that work
best, but they do serve an important function
in getting things warmed up.
For those models who stay nervous a little longer and are still somewhat stiff while
being observed with the camera, I find that it
can work wonders to stop to change film (or
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change the memory card or battery). Tension
is fatiguing, so those particularly nervous models often sigh a great sigh of relief when the
camera is finally turned away, and really relax.
A few glances in that direction while fussing
over the camera can sometimes reveal a really
great pose, and I’ve often done an abrupt shout
of “wait, don’t move at all, that’s a fantastic
pose.” Most models are even more relaxed once
they’ve seen that you are really happy with what
you are getting.
Q: How did your self-portrait work inform
the way you interact with models?
I’ve actually done very little in the way of real
self-portraits—only a few as needed for business
uses. I have, however, used myself as a model
occasionally in the past. I don’t think of these
asÂ€self-portraits, but just as myself standing inÂ€for
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a model. I found this to be excellent Â�training
early on. I modeled for other photographers
and for myself, and I learned more about how to
workÂ€with models by being one than from anything else.
Q: How do being a feminist and your training in biology affect your work?
It took me a bit longer to gravitate towards
nudes because of my concern with exploitation
of the female body. I struggled with that one for
a little while, but I was especially interested in
the timelessness that one can get with the nude
figure. My feminism surely has guided some
of my approach in how I work with the models.
For instance, my insistence on providing what
they need for their own comfort, both physical
and emotional. I don’t want to make a photograph that either of us is not comfortable making. It is always a collaborative effort and the
model has as much say as possible. Originally
I put some effort into finding male models as
well, as part of a feminist urge to keep things
equal. I didn’t really keep this up very long
though—since I do prefer working with friends
or friends of friends, and those males very rarely
are willing to model. To my mind it is still a bit
odd, but men are often more shy about being
photographed nude than most women.
I don’t think my training in biology has an
effect on my work with nudes, though it certainly
does influence my work in other genres, particularly my wildflower series. Perhaps IÂ€should
consider ways to bring it into play in my work
with nudes—that could be interesting.
Q: What impact do Uelsmann and Bernhard
have on your work today?
Both are (or were, in the case of Bernhard)
absolute masters of printing, and both have
been incredibly generous to students of photography, sharing freely of their techniques
and insights. Both have provided considerable
inspiration—Uelsmann with working beyond

the normal constraints of reality, and Bernhard
with the art of finding beauty in the commonplace. Bernhard gave especially good workshop
assignments, such as to find a number of good
images within 25 feet of the classroom, or a
number of good images without getting out of
bed, things like that. These are excellent exercises, and ones I repeat frequently on my own.
There are incredible photographs right under
our noses all the time!
Q: How has teaching informed or changed
your practice?
I’m not sure how teaching has changed my
practice. I’ve certainly learned a lot from it.
FirstÂ€ of all, I always feel like I have to study
really HARD before teaching, so I won’t give
the students any wrong technical information (or at least none that I can avoid). Secondly, I’ve discovered that there are a lot of
unexpected reasons for signing up for a photo
workshop, and it is not uncommon to discover
that some of the participants have at least
as much to teach the group as the instructor does. Once I figured this out I started to
lean more towards leading “artist’s retreats”
instead of regular workshops, with a configuration that allowed all of the participants to
teach from their own strengths and everyone
to learn from each other. Third, teaching photo
workshops made me finally get over being shy
about having people watch me make a photograph. IÂ€think there is a great deal to learn
by watching other photographers go through
their process of creating a photograph, and
teachers should always provide an opportunity
for their students to watch them and to watch
other students when possible too.
Q: Do you have advice for beginning nude
photographers?
Yes indeed! I strongly believe that anyone
who wants to do nude photography should
experience being on the other side of the lens
as well. This is the very best way to learn about
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working effectively with a model. I think it’s
most effective as a learning tool if you model
nude for another photographer, but it is also
good to practice by using yourself as a model.
What do these suggestions bring up in your
mind? This in itself is useful to know, as it may
offer a little insight into the things that come
up in a model’s mind. Do you think your body
isn’t attractive enough? Try to find innovative
ways to use only parts of your body—there are
many ways to make a beautiful photograph with
a human body. Are you concerned with being
recognized in ways that might be embarrassing?
Think about ways to make it not recognizable
by using only part of the body, or by manipulating the lighting or the focus, or by cropping
to the point of abstraction. More tips to make
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this exercise more successful: use a tripod for
the camera and place a large mirror behind it to
get a better idea of what your layout is looking
like. A second tripod can be used as a stand-in
for yourself, to give you something to focus on,
while also marking exactly where you need to
place yourself when you get back on the lens
side of the camera. A self-timer can be used to
release the shutter, but it sometimes is difficult
to get everything completely arranged quickly
enough. In that case a very long cable release
cord or a remote control can be a blessing. This
whole process can be a bit complex and sometimes frustrating, but it is really an excellent
way to learn and get some practice without the
pressure of worrying about another person who
might be getting impatient or bored.
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Conclusion
Art is life seen through man’s inner craving for perfection and beauty—
his escape from the sordid realities of life into a world of his imagining.
Art accounts for at least a third of our civilization, and it is one of the
artist’s principal duties to do more than merely record life or nature. To
the artist is given the privilege of pointing the way and inspiring towards
a better life.

newÂ€ ideas. As Barney Cokeliss said in his interview, it’s good to
know your Â�influences so that you don’t ape them. Beyond that, consciously embracing your influences can be a rich vein to mine for
ideas, whether it’s exploring your personal peccadilloes, reacting to
something you can’t stand or referencing the work of someone you
admire.

—Paul Outerbridge

Maybe you’ll get out and see something that inspires your work,
in a museum, a gallery, or even on the street. I hope you’ll remember
that too many photographers only look at photography, and that at
its heart, the camera is a copying machine. By its nature, the camera
invites us to copy—it almost induces us to mimic whatever we see—
thus, it takes something extra to go beyond knee-jerk imitation.

This book is just one by-product of a personal odyssey. That
journey began with plastic cameras bought in drugstores and rolls of
film where one shot in twenty even came out. There were various pictures of naked girlfriends, and one who considered herself a charter
member of the “No Nude Photos” club. I had an early fascination with
“trick” photography, and was blown away the first time I saw a Jerry
Uelsmann photograph. Somewhere in that mix of early influences, of
course, were the images of Playboy and first issues of Club.
As my appreciation for art developed, there were visits to
photo galleries on Newbury Street in Boston in the early 1980s,
and the chance discovery of a Modigliani print in the poster shop of
theÂ€Â�Beaubourg Museum in Paris. During that same trip, I visited the
Musée Rodin, saw Iris, Messagère des Dieux (Iris, Messenger of the
Gods), and a light went on—art wasn’t just about beautiful images
or safe subject matter, it was about mixing things up, challenging
norms, and breaking taboos, too.
My hope is that by reading this book, you have gotten interested in exploring your own influences and curious about trying

Two artists that continue to inspire me today are Egon Schiele
and Helmut Newton, and there are two books by other artists that I
still refer back to because they demonstrate that nudes don’t have
to stick to well-worn norms. The first is Chambre Close by Bettina
Rheims and Serge Bramly, and the second is Lee Friedlander’s book
of nudes. The Friedlander book has an attitude and energy that I still
rarely see in photos of the nude. A third book that inspires me is Flor
Garduño’s Inner Light, because of its poetic treatment of the figure
and its minimalist graphic sensibilities.
In writing this book, I got more in touch with some of my own
interests and influences. Perhaps the phrase “the journey is the
reward” has been overused, but it certainly has the ring of truth.
There is much more to shoot, and even more to delve into and write
about. I wish you luck and creativity on your own journey.
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Projections
layering, 121
as light source, 89
ProPhoto RGB, 164, 191
Proportions
aspect ratio, 31
in composition, 97
Props
implied nude, 41
narrative photography, 59–60
Pro-7 systems (Profoto), 143–144
Public Display of Modesty? (Benjamin), 49

Q

Queen’s Park Story (Cokeliss), 208

R

RAID systems, 201–202
RAM, 201
Randy’s Donuts (Breckheimer), 53
Ranum, Marcus J., 63
Rasner, Richard, 5, 51, 61, 86, 115
RAW, 139, 159
Ray, Man, 25, 57, 74
Ray Flash, 145
Reading images, fine art nudes, 20–23
Recycle time, strobes, 143
Red Wing, 149
Reference, 62–64
Reflectors, 146, 148
Regulations, Section 2257, 132
Re-Imagined Superheroes (Rasner), 61
Releases, models, 131
Rembrandt lighting, 78
Renkes, Saelon, 12, 215–220
Renoux, Pascal, 7, 21, 54, 69
Rental equipment, 149–150
RGB color wheel, 109–110
Richardson, Arri, 141–142
Richardson, Mole, 141–142
Richardson, Terry, 50, 208
Rifa light, 141
Rim light, 75
Ring light, 72, 144–145
Ritts, Herb, 50
Roberts, Holly, 216
Rock N Roll Lifestyle (Rasner), 5
Rololight, 142
Rosen, Aya, 11, 18, 38, 55, 76
Rosen, Ned, 11, 18, 38, 55, 76
Roversi, Paolo, 137, 212
Rule of thirds, 94–95
RYB color wheel, 109–110

S

Safety, 150
Sargent, John Singer, 212
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Saudek, Jan, 208
Schiele, Egon, 47, 64–65
Scrims, 147
Sculptural effects, and light, 76
Sculptural nudes, 45
Selective focus, 116
Self-portraits, 33, 35, 39, 218
Self Portrait (Yoshimaru), 14, 39
Sensors, camera formats, 123
Serrano, Andres, 49
Sexuality depiction, 48–49
Shadows
abstract qualities, 43
fill light, 76–77
Rembrandt lighting, 78
Venetian blinds, 74
Shapes, in composition, 103–104
Sharpness, lenses, 119
Sherman, Cindy, 28, 210
Shinoyama, Kishin, 45
Shoot basics
ambient light and flash, 139–140
camera modes, 138
continuous lights, 141–142
exposure, histogram, manual mode,
138–139
gray card, 140
hot lights, 140–141
hot shoe flash, 144
lighting, 137–138
light modifiers, 145–148
light stands, 148–149
rent vs. own, 149–150
ring lights, 144–145
safety, 150
setup and preparation, 135–137
studios, 137
“Shooting into the shadow,” 80
Shore, Stephen, 122
Shutter preferred mode (camera), 138
Shutter speed, 83
Sienna (Benjamin), 5
Signs, on skin, 46
Sikorskyi, Daniel, 26, 99
Silhouettes, 79–80
Silks, 148
Silvia, Pet, 15
Sinar camera, 122
Single-glass optics, 117
Siskind, Aaron, 39–40
Sister’s Got a Habit (Breckheimer), 64
Sitters, see Models
Skylight filter, 114–115
Slater, Terry, 46, 57
Slater-Hunt, Tobias, 10, 30, 73
Smith-Victor lights, 141
Smoke effect, 115
Snakes, 59
Snapshots, digital workflow, 162–163
Snoots, 78–79, 147
Softboxes, 145–146
Soft focus effect, 114–115
Index

Soft light
characteristics, 70–74
creation, 82
direction, 74–76
reflector, 146
Solarization technique, 57
Spatial dividers, in composition, 104
Speed lights, 144
Spill, 81–82
Split toning, 107–108, 162
Spoiled (Cokeliss), 208
Spot lights, 78–79
sRGB, 164, 191
Stanford, Leland, 34
Statue of Liberty, 22–23
Steichen, Edward, 27
Stein, Harvey, 7, 32, 40, 45
Stewart, Potter, 48
Stieglitz, Alfred, 25
Storaro, Vittorio, 88–89
Storaro gels, 147
Storaro Selection, 89
Strand, Paul, 25
Studio strobes
advantages, 138
makers, 143–144
safety, 150
shoot basics, 142–143
Sturges, Jock, 50
Subject, see Models
Sunpak, ring lights, 145
Surrealism, 25, 56–57, 157
Symbolism, via color, 87–88
Szarkowski, John, 27–29, 157
Szarkowski’s dimensions
“The Detail,” 33
“The Frame,” 29, 31
“The Thing Itself,” 31–32
“Time,” 33–35
“Vantage Point,” 32–33

T

“Tasteful nudes,” 41
Taylor, Brian, 216
Tea (Cokeliss), 208
Telephoto lenses, 119
Television, aspect ratio, 31
Textural effects, and light, 76
Textures (Photoshop)
Clouds filter, 173–175
Fibers filter, 173, 175–177
masks, 176–186, 190
Noise filter, 173–176, 185
TFCD, see Time for CD (TFCD)
TFP, see Time for print (TFP)
“The Thing Itself” (Szarkowski dimensions), 29
Three-dimension form, in composition, 104
Threshold adjustment (Photoshop), 171–173
TIFF, 97, 159
“Time” (Szarkowski dimensions), 33

Index

Time for CD (TFCD), 130
Time for print (TFP), 130
Tones, curve adjustment, 168–169
Toning
in composition, 107–108
digital technique, 157
Trapped space, in composition, 100
Travelites, 144
The Treachery of Images (Magritte), 31
Triptych, 154–155
Trust, models, 129–130
TTL flash, 140
Tungsten light, 139, 141, 150
Tunick, Spencer, 137
TV Woman (Marquez), 14
Two Uses of a Word, 65

U

Uelsmann, Jerry, 157, 219
Ultraviolet (UV) light
CD/DVD degradation, 202
eye damage, 86
halogen bulbs, 141
pictorialist work, 114
Umbrellas
Avedon lighting, 81
light modifiers, 145

V

van Dyck, Anthony, 212
“Vantage Point” (Szarkowski’s dimensions), 32–33
Vaseline, 114–115
Venetian blinds, lighting, 74
Venus of Willendorf, 25
V-flats, 148
Video RAM (VRAM), 201
Viewers, reading images, 23
Vision, fine art nudes, 25
Visual literacy, 22
Visual tension, 29, 31, 95–96
Von Goethe, Johann Wolfgang, 88, 109

W

Wacom tablets, 201
Wall, Jeff, 55
Warm hues, 90
Waterscape Nude series (Foltz), 35
Water Study 5 (Billups), 9
Weber, Bruce, 43, 50
Web sites, models, 127–128
Weider, Joe, 50
Westcott umbrellas, 145
Weston, Charis, 65
Weston, Edward, 25, 65, 104
White balance
color manipulation, 160–161
color strategies, 109
digital workflow, 159
gray card, 140
Wide-angle lens, 118–119
Windows, as light source, 71–72
Winogrand, Garry, 28, 122
Witkin, Joel-Peter, 55
Woodman, Francesca, 34, 35
Working space (Photoshop), 191
Writing, on skin, 46

X

X-Rite, 193
XXX: 30 Porn Star Portraits
(Greenfield-Sanders), 121

Y

Yezierski, J.D., 12, 22, 23, 89, 113, 121
Yo Mama’s Last Supper (Cox), 63–64
Yoshimaru, Mayumi, 14, 39

Z

Zone System, 87
Zoom lenses, 119
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